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Introduction
Thank you for purchasing the YOKOGAWA µR20000 Recorder.
This manual describes the functions (excluding the communication functions), installation 
and wiring procedures, operating procedures, and lists the handling precautions of the 
µR20000 Recorder. To ensure correct use, please read this manual thoroughly before 
beginning operation.
The following manuals are provided for the recorder.
• Paper Manual

Manual Title Manual No. Description
µR20000 Recorder  
Operation Guide

IM 04P02B01-02E Explains concisely the operations of the 
µR20000 Recorder.

• Electronic Manuals 
Manual Title Manual No. Description
µR20000 Recorder  
User’s Manual

IM 04P02B01-01E This manual.

µR10000/µR20000 
Communication Interface 
User’s Manual

IM 04P01B01-17E Explains the communication functions of the 
µR20000 Recorder using Ethernet interface and 
the RS-422A/485 communication interface.

µR10000/µR20000 
SD Memory Card (/EM1 
option) User’s Manual

IM 04P01B01-03E Explains how to use SD memory cards.

Notes
• The contents of this manual are subject to change without prior notice as a result of 

continuing improvements to the instrument’s performance and functions.
•	 Every	effort	has	been	made	in	the	preparation	of	this	manual	to	ensure	the	accuracy	

of	its	contents.	However,	should	you	have	any	questions	or	find	any	errors,	please	
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

• Copying or reproducing all or any part of the contents of this manual without the 
permission of Yokogawa Electric Corporation is strictly prohibited.

• The TCP/IP software of this product and the document concerning the TCP/IP 
software have been developed/created by YOKOGAWA based on the BSD Networking 
Software, Release 1 that has been licensed from the University of California.

QR Code
The product has a QR Code pasted for efficient plant maintenance work and asset 
information management.
It enables confirming the specifications of purchased products and user’s manuals.
For more details, please refer to the following URL.
https://www.yokogawa.com/qr-code

QR Code is a registered trademark of DENSO WAVE INCORPORATED.
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Trademarks
• All the brands or names of Yokogawa Electric’s products used in this manual are 

either trademarks or registered trademarks of Yokogawa Electric Corporation.
• Microsoft and Windows are either registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
• Adobe, Acrobat, and PostScript are trademarks of Adobe Systems incorporated.
• The SD logo is a registered trademark of the SD association.
• For purposes of this manual, the TM and ® symbols do not accompany their 

respective trademark names or registered trademark names.
• Company and product names that appear in this manual are trademarks or registered 

trademarks of their respective holders.

Revisions
1st Edition August 2005 2nd Edition September 2006
3rd Edition April 2011 4th Edition March 2015
5th Edition July 2017 6th Edition February 2020
7th Edition February 2021 8th Edition November 2022
9th Edition September 2023 
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Recorder’s Version and Functions Described in This 
Manual
The contents of this manual corresponds to the recorder with version 1.5x.

µR20000 Versions and Functions
Version Suffix Code Added or Modified Functions Reference
1.11 or earlier – – –
1.2x -2 (Added) Language support (German and French). Section 1.9

/CC1 (Added) Calibration Correction. Section 1.2
/H5x (Added) Portable type. Sections 2.5 and 12.7
/P1 (Added) 24 VDC/AC power supply operation. Section 2.5

1.3x – (Added) Customized menu. Section 1.9
– (Added) Modbus register (40301 to 40348). Communication manual
/BT1 (Added) Header printout. Section 1.4

1.4x /EM1 (Added) SD memory card. IM 04P01B01-03E
1.5x – (Changed) Style (H): 3 (Dot model) and 4 (Pen model)*.

* Style (H) 3 and 4 supports firmware version 1.5x or 
later. 

–

• Checking the Version Number
 You can check the version number on the System display.
 The System display cannot be shown at the factory default condition.
 First, register the System display to the display screen.

• Procedure of registering the System display to the display screen: See section 8.2.
• Procedure of displaying the System display: The screen switches each time the DISP  key is pressed. Press 

the DISP  key repeatedly until System display is shown. The displayed contents on the System display 
switches every 3 seconds. Check the number shown by the “Version:” item.

Software (Sold Separately)
The table below shows the relationship between the RXA10 Configuration Software revisions and the µR20000 
recorder versions.

Recorder version
1.11 or earlier 1.2x 1.3x 1.4x 1.5x

RXA10 Configuration 
Software revision

R2.01 Yes Yes Limited
R3.01 Yes Yes Yes Limited
R3.05 Yes Yes Yes Yes Limited
R3.06 Yes Yes Yes Yes Yes

Yes: Compatible
Limited: The new functions of the recorder cannot be configured from the RXA10.

Note
Set the recorder version in the RXA10 Configuration Software to display the setup items that 
match the recorder’s functions.
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Safety Precautions

The general safety precautions described here must be observed during all phases of operation. 

Safety Standards and EMC Standards
 This recorder conforms to IEC safety class I (provided with terminal for protective grounding), Overvoltage 

Category II or I*1, Pollution Degree 2, Measurement Category II (CAT II)*2, and EN 61326-1 (EMC standard), 
class A (use in a commercial, industrial, or business environment). Influence in the immunity environment (criteria 
A condition) is within ±10% of range. This recorder is designed for indoor use.

 *1 II : Applied to standard power supply (100-240 VAC), I: Applied to /P1 option (24 VDC/AC)
 *2  Measurement Category II (CAT II) applies to measuring circuits connected to low voltage installation, and 

electrical instruments supplied with power from fixed equipment such as electric switchboards.

About This Manual
• This manual should be read by the end user.
• Read this manual thoroughly and have a clear understanding of the product before operation.
• This manual explains the functions of the product. YOKOGAWA does not guarantee that the product will suit a 

particular purpose of the user.
• Under absolutely no circumstances may the contents of this manual be transcribed or copied, in part or in 

whole, without permission.
• The contents of this manual are subject to change without prior notice.
• Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. However, 

should you have any questions or find any errors or omissions, please contact your nearest YOKOGAWA dealer.

Precautions Related to the Protection, Safety, and Alteration of the Product
• The following safety symbols are used on the product and in this manual.

“Handle with care.” To avoid injury and damage to the instrument, the operator must refer to the 
explanation in the manual.

Protective ground terminal

AC

DC

“High temperature.” To avoid injury caused by hot surface, do not touch locations where this symbol 
appears.

• For the protection and safe use of the product and the system controlled by it, be sure to follow the instructions 
and precautions on safety that are stated in this manual whenever you handle the product. Take special 
note that if you handle the product in a manner that violate these instructions, the protection functionality 
of the product may be damaged or impaired. In such cases, YOKOGAWA does not guarantee the quality, 
performance, function, and safety of the product.

• When installing protection and/or safety circuits such as lightning protection devices and equipment for the 
product and control system or designing or installing separate protection and/or safety circuits for fool-proof 
design and fail-safe design of the processes and lines that use the product and the control system, the user 
should implement these using additional devices and equipment.

• If you are replacing parts or consumable items of the product, make sure to use parts specified by YOKOGAWA.
• This product is not designed or manufactured to be used in critical applications that directly affect or threaten 

human lives. Such applications include nuclear power equipment, devices using radioactivity, railway facilities, 
aviation equipment, air navigation facilities, aviation facilities, and medical equipment. If so used, it is the user’s 
responsibility to include in the system additional equipment and devices that ensure personnel safety.

• Do not modify this product.
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 WARNING
• Use the Correct Power Supply

Ensure that the source voltage matches the voltage of the power supply before turning ON the power.
• Connect the Protective Grounding Terminal

Make sure to connect the protective grounding to prevent electric shock before turning ON the power.
• Necessity of Protective Grounding

Never cut off the internal or external protective earth wire or disconnect the wiring of the protective earth 
terminal. Doing so invalidates the protective functions of the instrument and poses a potential shock 
hazard.

• Defect of Protective Grounding
Do not operate the instrument if the protective earth or fuse might be defective. Make sure to check them 
before operation.

• Do Not Operate in an Explosive Atmosphere
Do not operate the instrument in the presence of flammable liquids or vapors. Operation in such 
environments constitutes a safety hazard.

• Do Not Remove Covers
The cover should be removed by YOKOGAWA’s qualified personnel only. Opening the cover is 
dangerous, because some areas inside the instrument have high voltages.

• External Connection
Connect the protective grounding before connecting to the item under measurement or to an external 
control unit.

• Damage to the Protective Structure
Operating the recorder in a manner not described in this manual may damage its protective structure.

Portable Type (/H5x Option)
• Use the Correct Power Supply

Ensure that the power supply is within the maximum rated voltage range of the provided power cord 
before connecting the power cord.

• Use the Correct Power Cord and Plug
To prevent electric shock or fire, be sure to use the power cord supplied by YOKOGAWA. The main 
power plug must be plugged into an outlet with a protective earth terminal. Do not disable this protection 
by using an extension cord without protective earth grounding. The power cord is designed for use with 
this instrument. Do not use the power cord with other instruments.

• Connect the Protective Grounding Terminal
The power cord for the µR20000 is a three-prong type power cord. Connect the power cord to a properly 
grounded three-prong outlet.

CAUTION
This instrument is a Class A product. Operation of this instrument in a residential area may cause radio 
interference, in which case the user is required to take appropriate measures to correct the interference.

Safety Precautions
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Exemption from Responsibility
• YOKOGAWA makes no warranties regarding the product except those stated in the WARRANTY that is 

provided separately.
• YOKOGAWA assumes no liability to any party for any loss or damage, direct or indirect, caused by the user or 

any unpredictable defect of the product.

Handling Precautions of the Software
• YOKOGAWA makes no warranties regarding the software accompanying this product except those stated in the 

WARRANTY that is provided separately.
• Use the software on a single PC.
• You must purchase another copy of the software, if you are to use the software on another PC.
• Copying the software for any purposes other than backup is strictly prohibited.
• Please store the original media containing the software in a safe place.
• Reverse engineering, such as decompiling of the software, is strictly prohibited.
• No portion of the software supplied by YOKOGAWA may be transferred, exchanged, sublet, or leased for use 

by any third party without prior permission by YOKOGAWA.

Safety Precautions
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Checking the Contents of the Package

Unpack the box and check the contents before operating the recorder. If some of the 
contents are not correct or missing or if there is physical damage, contact the dealer from 
which you purchased them.

Checking the Model
A name plate is affixed to the recorder. Check that the model name and suffix code given 
on the name plate on the rear panel match those on your order.

  

TAG NO.
TAG NO.
TAG NO.
TAG NO.

MODEL
SUFFIX

STYLE

FREQUENCY
NO.

SUPPLY
SH

MODEL and SUFFIX Code
Model Suffix Code Optional Code Description

437101 µR20000 1 pen recorder
437102 µR20000 2 pen recorder
437103 µR20000 3 pen recorder
437104 µR20000 4 pen recorder
437106 µR20000 6 dot recorder
437112 µR20000 12 dot recorder
437118 µR20000 18 dot recorder
437124 µR20000 24 dot recorder

-2 English/German/French & deg F/DST
/A1 Alarm output relay 2 points 1

/A2 Alarm output relay 4 points 1

/A3 Alarm output relay 6 points 1

/A4 Alarm output relay 12 points 1

/A5 Alarm output relay 24 points 1

/C3 RS-422A/485 interface 2

/C7 Ethernet (10BASE-T) interface 2

/H2 Clamped input terminal 3

/H3 Non-glare door glass
/H5D Portable type  Power cord UL, CSA st’d 6

/H5F Portable type  Power cord VDE st’d 6

/H5R Portable type  Power cord AS st’d 6

/H5J Portable type  Power cord BS st’d 6

/H5H Portable type  Power cord GB st’d 6

/M1 Mathematical function
/N1 Cu10, Cu25 RTD input
/N2 3 legs isolated RTD 3, 4

/N3 Expansion inputs 5

/P1 24 VDC/AC power supply 6

/R1 Remote control 5 points
/CC1 Calibration Correction
/BT1 Header printout
/EM1 SD memory card 7

/S# Customized Product; for more detail, please 
see IM 4361-S# or IM 4371-S# 8

1 /A1, /A2, /A3, /A4, and /A5 cannot be specified simultaneously. /A5 is valid on the dot models.
2 /C3 and /C7 cannot be specified simultaneously.
3 /H2 and /N2 cannot be specified simultaneously.
4 Valid only on the dot models.
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Checking the Contents of the Package

5 14 types of input including Pt50 RTD, PR40-20, and Platinel TC.
6 /H5x and /P1 cannot be specified simultaneously.
7 /C3 and /EM1 cannot be specified simultaneously.
8 For customized product, the product is identified by the option code of /S# (where ‘#’ is a 

number). Contact your supplier in case your instrument has option /S#, and you are not in 
the possession of IM 4361-S# or IM 4371-S#.

Standard Accessories
The standard accessories below are supplied with the recorder. Check that all contents 
are present and undamaged.

  

Z-fold chart paper Ribbon cassette Disposable 
felt pen

Plotter pen Mounting bracket

µR20000 Recorder Operation Guide
IM 04P02B01-02E

Recording Chart

CHART

Recording

Chart

CHART

KOKUSAIKOKUSAI

One of these power cord types is supplied 
according to the instrument’s suffix code

/H5F/H5D /H5R

/H5H/H5J

SD memory card

Part Number Note

A1006WD Provided when optional code /H5D is specified. 
Maximum rated power voltage: 125 V

A1009WD Provided when optional code /H5F is specified. 
Maximum rated power voltage: 250 V

A1024WD Provided when optional code /H5R is specified. 
Maximum rated power voltage: 250 V

A1023WD Provided when optional code /H5J is specified. 
Maximum rated power voltage: 250 V

A1064WD Provided when optional code /H5H is specified. 
Maximum rated power voltage: 250 V

Item 1-Pen 2-Pen 3-Pen 4-Pen Dot Printing
Z-fold chart paper 1 1 1 1 1
Ribbon cassette - - - - 1

Disposable felt pen

Red 1 1 1 1 -
Green - 1 1 1 -
Blue - - 1 1 -
Violet - - - 1 -

Plotter pen Purple 1 1 1 1 -
Mounting bracket  
(included with models without /H5x) 2 2 2 2 2

Power cord (included with /H5x) 1 1 1 1 1
SD memory card 1 GB (included with /EM1) 1 1 1 1 1
µR20000 Recorder Operation Guide  
IM 04P02B01-02E 1 1 1 1 1
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Optional Accessories (Sold Separately)
The optional accessories below are available for purchase separately. If you make an 
order, make sure that all contents are present and undamaged.
For information about the communication functions, see the μR10000/μR20000 
Communication Interface User’s Manual, IM 04P01B01-17E.

Item Model
(Part Number) Quantity Note

Z-fold chart paper B9573AN 1 10 pcs.
Ribbon cassette B9906JA 1

Disposable felt pen

Red B9902AM 1 3 pcs.
Green B9902AN 1 3 pcs.
Blue B9902AP 1 3 pcs.
Violet B9902AQ 1 3 pcs.

Plotter pen Purple B9902AR 1 3 pcs.
Mounting bracket B9900BX 2

Shunt resistor for the  
screw terminal (standard)

415920 1 250	Ω	±0.1%
415921 1 100	Ω	±0.1%
415922 1 10	Ω	±0.1%

Shunt resistor for the  
clamped input terminal (/H2)

438920 1 250	Ω	±0.1%
438921 1 100	Ω	±0.1%
438922 1 10	Ω	±0.1%

SD memory card 773001 1 1 GB

Software (Sold Separately, Planned)
Item Model Note

Configuration software RXA10-01
RXA10-02 With interface unit*

*  You can use the Configuration Software if you install the interface unit to a recorder does not 
include the communication function. An interface unit cannot be installed in a recorder with 
an SD memory card function (/EM1 option).

Checking the Contents of the Package
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Removing the Packing Materials
Open the door, hold the left and right tabs and pull the display and key panel section 
toward you. The section opens upward.

  

Tab on the display

Open

Open

Display

Remove all packing materials.
• Pen Model • Dot Model

  

Pen model

 

Dot model

Return the display and key panel section to its original position by pressing the section 
downward.

Checking the Contents of the Package
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How to Use This Manual

This user’s manual consists of the following sections.
For details on communication functions, see the µR10000/µR20000 Communication 
Interface User’s Manual (IM 04P01B01-17E).
Chapter Title and Description
1 Functional Explanation and Setup Guide

Describes the functions of the µR20000 Recorder and provides a function setup guide. 
Refer to this chapter when you are unsure of the details of the function that you are 
operating.

2 Before Using the Recorder
Describes the installation and wiring procedures.

3 Names of Parts and Run Operations
Describes the names of each part of the recorder and the daily operations.

4 Common Operations for Setting Functions and Setup Menu
Explains the recorder operation modes and the basic setup operations using keys. It 
also provides menu configuration diagrams and lists of setup items.

5 Frequently Used Setup Operations (Setting Mode)
Describes how to change the input range, alarms, chart speed, etc.

6 Setup Operations for Convenient Functions (Setting Mode)
Describes the setup operations for convenient functions such as how to assign tags to 
channels and how to set message strings that are to be printed.

7 Setup Operations for Changing/Adding Functions (Basic Setting Mode)
Describes the setup operations for changing or adding functions such as setting the 
recorder to detect sensor burnouts and changing the contents that are printed on the 
chart paper.

8 Setup Operations for Changing the Displayed Contents
Describes how to select the display type suitable for the application.

9 Operations Related to the Computation Function (/M1 Option)
Describes all operations related to the computation function.

10 Troubleshooting
Describes error message and troubleshooting measures of the Recorder.

11 Maintenance
Describes periodic inspection, calibration, pen adjustment/printer carriage adjustment, 
and recommended replacement period for worn parts.

12 Specifications
Gives the specifications of the Recorder.

Appendix Describes the printout contents.
Index

Note
• This user’s manual covers information regarding the recorders with English as the display/

printout language (suffix code “2”).
• For the procedure of setting the display/printout language, see section 7.14, “Changing the 

Display/Printout Language.”
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How to Use This Manual

Conventions Used in This Manual
Unit
K ........ Denotes 1024. Example: 768 KB (file size)
k ........ Denotes 1000.

Safety Markings
The following markings are used in this manual.

  WARNING

CAUTION

Improper handling or use can lead to injury to the user or 
damage to the instrument. This symbol appears on the 
instrument to indicate that the user must refer to the user’s 
manual for special instructions. The same symbol appears in 
the corresponding place in the user’s manual to identify those 
instructions. In the manual, the symbol is used in conjunction 
with the word “WARNING” or “CAUTION.”

Calls attention to actions or conditions that could cause serious 
or fatal injury to the user, and precautions that can be taken to 
prevent such occurrences.

Calls attentions to actions or conditions that could cause light 
injury to the user or damage to the instrument or user’s data, 
and precautions that can be taken to prevent such occurrences.

Calls attention to information that is important for proper 
operation of the instrument.

Note

Subheadings
On pages that describe the operating procedures in Chapter 3 through 9, the following 
symbols are used to distinguish the procedures from their explanations.
Bold characters denote keys or character strings that are displayed on the screen.
 Example: Range, Unit

   

Procedure

Explanation

Follow the numbered steps. All procedures are written with 
inexperienced users in mind; depending on the operation, not 
all steps need to be taken.

This subsection describes the setting parameters and the 
limitations on the procedures. It does not give a detailed 
explanation of the function. For details on the function, see 
chapter 1.
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1.1 Overview of the Recorder

The µR20000 Recorder (hereafter referred to as the recorder) can be used to assign DC 
voltage, 1-5V, thermocouple, RTD, and contact or voltage ON/OFF signal to channels 
for measurement. The measured results are recorded with pens or dots on a chart paper 
that is fed at a constant speed. The pen model can record up to 4 channels; the dot 
model can record up to 24 channels.

Alarms
For each channel, various alarms such as high limit alarm and low limit alarm can be 
assigned to monitor the measured values. Alarm output relays can be used to output 
contact signals when alarms occur (/A1, /A2, /A3, /A4, and /A5 options).

Recording
The measured results are recorded with pens or dots on a chart paper (trend recording). 
The chart speed can be selected from 5 to 12000 mm/h on the pen model and 1 to 1500 
mm/h on the dot model.
In addition to trend recording, various types of information can be printed or recorded 
on the chart paper such as numeric measured values, alarm occurrence/release, and 
predefined messages.
Also, the recorder settings can be printed.

Internal Light
A light is provided for easier viewing of the recording area of the chart paper.

Display
Measured values can be displayed numerically or using bar graphs on the large display. 
Also, alarm status and chart speed can be displayed.

Communication Function
Using the Ethernet communication interface (/C7 option) or the RS-422A/485 
communication interface (/C3 option), the measured values on the recorder can be 
output to a PC or a PC can be used to control the recorder.
This manual does not cover the communication functions. For details on communication 
function, see the μR10000/μR20000 Communication Interface User’s Manual, IM 
04P01B01-17E.

Other Main Functions
The computation function (/M1 option) can be used to perform various computations from 
four arithmetic operations to statistical calculations on 8 and 24 computation channels on 
the pen model and dot model, respectively. The computed results can be recorded.
The remote control function (/R1 option) can be used to control the start/stop and other 
operations of the recorder by applying contact signals to the dedicated terminals.
The FAIL/chart end detection and output function (/F1 option) can be used to output 
contact signals when errors are detected on the recorder or when the chart paper runs 
out.
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1.2 Measuring Input Section

Input Section
Number of Measurement Channels and Scan Interval
The recorder samples the input signals on the measurement channels at the scan 
interval to obtain the measured values.
Model Num. of Ch. Scan Interval
1-pen model 1 125 ms
2-pen model 2 125 ms
3-pen model 3 125 ms
4-pen model 4 125 ms
6-dot model 6 1 s (2.5 s when the integration time of the A/D converter is 100 ms.)
12-dot model 12 2.5 s (5 s when the integration time of the A/D converter is 100 ms.)
18-dot model 18 2.5 s (10 s when the integration time of the A/D converter is 100 ms.)
24-dot model 24 2.5 s (10 s when the integration time of the A/D converter is 100 ms.)

Input Type, Measurable Range, and Computation
The recorder can measure the following types of inputs.
Input Type Measurable Range
DC voltage DC voltage in the range of ±20 mV to ± 50 V
1-5V See “1-5V” below.
Thermocouple Temperature range corresponding to each type: R, S, B, K, E, J, T, N, W, L, U, and 

WRe
RTD Temperature	range	corresponding	to	each	type:	Pt100Ω	and	JPt100Ω
ON/OFF input Contact input: Open contact is OFF (0). Closed contact is ON (1).  

Voltage input: Less than 2.4 V is OFF (0). Greater than or equal to 2.4 V is ON (1). 
Within ±6 V.

• 1-5V
 1-5V is scaled to values in the appropriate unit to be used as measured values. Also, 

the	low-cut	function	(input	less	than	0%	is	fixed	to	0%	(scale	left	value))	can	be	used.
• Current Input
 A shunt resistor is attached to the input terminal. The current signal is converted to a 

voltage signal and measured. The measurable range is the range equivalent to the “DC 
voltage” range indicated above after converting the current to the voltage signal.

Note
Three	types	of	shunt	resistors	(250	Ω,	100	Ω,	and	10	Ω)	are	available	for	current	input	(see	
“Optional	Accessories	(Sold	Separately)”	on	page	vii).	For	example,	a	250-Ω	shunt	resistor	is	
used to convert the signal to the range of 1 to 5 V for 4 to 20 mA input.

• Range Type, Measurable Range, and Recording Span
 Various “range	type”	are	available	for	the	different	types	of	inputs	(for	example	

thermocouple type R). Each range type has a preset measurable range (0.0 to 
1760.0°C for thermocouple type R). Measurement can be made by specifying an 
arbitrary range within the measurable range as the input range. The measured values 
in the input range are recorded on the chart paper. The range of measured values that 
are recorded is called the recording span.

   

0.0°C
300.0°C (leftmost value of span)

1760.0°C
1500.0°C (rightmost value of span)

Input range or 
recording span

Measurable range (Thermocouple type R example)

<Related Topics>  Setting the input range: Section 5.1
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• Delta Computation
 The value obtained by subtracting the measured value of another channel (called 

the reference channel) from the input value of the channel set to delta computation is 
used as the measured value of that channel. The reference channel must be assigned 
to a channel whose channel number is less than that of the channel on which delta 
computation	is	specified.	The	channel	on	which	delta	computation	is	specified	is	
automatically set to the same range type as the reference channel.

   
Input 
value

Measured value on the reference channel

Channel set to delta computation

Measured value
–

Note
A channel whose input type is set to DC voltage, TC, or RTD can be designated as a reference 
channel. However, channels set to scaling or square root computation cannot be designated.

• Scaling
 The input values are scaled to values in the appropriate unit to be used as measured 

values.

   

0 V –100.0°C

10 V 300.0°C
Measured valueInput value

• Square Root Computation
 When the input type is DC voltage, the square root of the input value is calculated, the 

result is scaled to a value in the appropriate unit, and used as the measured value of 
the	channel.	Also,	the	low-cut	function	(input	less	than	a	given	measured	value	is	fixed	
to 0% (scale left value)) can be used.

   

Input value

Input value
Low-cut value

Result of square 
root computation

Measured value

Channel set to square root computation

Measured value√ Scaling

Note
The square root computation on the recorder uses the following formula.

    F   = ( F       -  F      ) V   - V
V        -   V  

 + Fx
 x  

max  
 max min

 min min
min

where Vmin (leftmost value of span) < Vmax (rightmost value of span)
            Fmin (leftmost value of scale after scaling) < Fmax (rightmost value of scale after  

scaling) 
Vx is the input voltage and Fx is the scaled value

<Related Topics>  Setting the input range: Section 5.1
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1.2  Measuring Input Section

• Bias
 A given value (bias value) is added to the input value and used as the measured value 

of that channel.

   Input value

Bias value

Biased channel

Measured value
+

<Related Topics>  Setting the bias: Sections 7.15 and 6.12

• Calibration Correction (/CC1 Option)
 Corrects the measured value of each channel using segment linearizer approximation 

and makes the resultant value the measured value of the channel. You can set 
arbitrary correction values for 2 to 16 points of arbitrary measured values. Linear 
approximation is used between two segment points. Correction values can be 
assigned using revise values or absolute values.

   
Correction 
value

Measured value
B5

B4
B3

B2

B1

A1 to A5: Measured value (measured value before correction)
B1 to B5: Correction value (measured value after correction)

Correction using 
revise values
Measured value = A
Correction value = B – A

Scale value

Calibration point

Correction using 
absolute values
Measured value = A
Correction value = B

A1
A2

A3

A4
A5

<Related Topics>   Setting the calibration correction function: Sections 7.15, 7.23, and 
6.13

Burnout Detection of Thermocouples
This function makes the recording go off the scale to the right or left when the 
thermocouple burns out while measuring temperature with a thermocouple. This function 
can also be used on 1-5V. The burnout detection function can be set for each channel.
By default, this function is disabled.

Note
For 1-5V, a burnout occurs when the input value is less than or equal to 0.2 V.

<Related Topics>  Setting the burnout detection function: Section 7.3

Reference Junction Compensation of Thermocouple Input
When measuring the temperature using a thermocouple, the reference junction 
compensation on the recorder can be used. When using external reference junction 
compensation, you can set the reference voltage. The reference junction compensation 
can be set for each channel.
By default, the recorder is configured to use the internal reference junction compensation 
function.
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Note
When using external reference junction compensation, set an appropriate reference junction 
compensation voltage. For example, if the reference junction temperature of the external 
reference compensation is T0 °C, set the reference compensation junction voltage to the 
thermoelectromotive force of the 0°C reference of T0 °C.

   

External reference junction compensation
(Hold the contact point of the thermocouple 
and copper wire at T0°C)

Thermocouple
Copper wire

Recorder

2
4

1
3

<Related Topics>   Setting the reference junction compensation function: Section 7.4

Noise Elimination from Input Signals
Filter and Moving Average
This function used to suppress the effects of noise that is riding on the signal. The pen 
model and dot model are equipped with a filter function and a moving average function, 
respectively. The function can be set for each measurement channel. However, it does 
not operate on channels set to ON/OFF input.
• Filter (Pen Model)
 The filter	is	a	low-pass	filter.	The	time	constant	can	be	set	to	2	s,	5	s,	or	10	s.

   

63.2% of the output value

2, 5, 10 s (time constant, the time it takes 
to reach 63.2% of the output value)

Output response curve 
(when using the filter)

Input

Filter result (output for a step input)

• Moving Average (Dot Model)
 The average value of the m most recent values acquired at the scan interval is used 

as the measured value of the channel. The number of moving-averaged data points 
(m)	can	be	set	in	the	range	2	to	16.	The	figure	below	shows	an	example	indicating	
the	operation	of	the	buffer	for	the	moving average computation when the number of 
moving averaged data points is set to 5.

   

1
2
3
4
5

10.0 mV
5.0 mV
0.0 mV

–5.0 mV
–10.0 mV

0.0 mV

15.0 mV
10.0 mV
5.0 mV
0.0 mV

–5.0 mV

5.0 mV

10.0 mV
15.0 mV
10.0 mV
5.0 mV
0.0 mV

8.0 mV
Deleted Deleted

Moving 
average

Most recent data Most recent data

Buffer data for the 
nth sampling time

Buffer data for the 
n+1th sampling time

Buffer data for the 
n+2th sampling time

<Related Topics>			Setting	the	filter:	Sections	7.12	and	6.2 
Setting the moving average: Sections 7.11 and 6.3
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1.2  Measuring Input Section

Integration Time of the A/D Converter
The recorder uses an A/D converter to convert the sampled analog signal to a digital 
signal. By setting the integration time of the A/D converter to match the time period 
corresponding to one cycle of the power supply or an integer multiple of one cycle, the 
power supply frequency noise can be effectively suppressed.
The integration time of the A/D converter is selected according to the model from the 
table below.
Model Integration Time of the A/D Converter
Pen model Select 16.7 ms (60 Hz), 20 ms (50 Hz), or Auto
Dot model Select 16.7 ms (60 Hz), 20 ms (50 Hz), 100 ms or Auto

• If Auto is selected, the recorder detects the power supply frequency and automatically 
selects 16.7 ms or 20 ms.

•	 If	Auto	is	specified	when	using	the	24-VDC	power	supply	on	a	recorder	with	the	
24-VDC/AC	power	supply	(/P1	option),	the	integration	time	is	fixed	to	20	ms	(50	Hz).

• Because 100 ms is an integer multiple of 16.7 ms and 20 ms, this setting can be used 
to suppress the power frequency noise for either frequency, 50 Hz or 60 Hz.

• The scan interval on the dot model varies depending on the integration time setting  
(see page 1-2).

<Related Topics>  Setting the A/D integration time: Section 7.2



1-7IM 04P02B01-01E 

Functional Explanation and Setup G
uide

For the procedure to set the functions, see section 1.10, “Function Setup Guide.”

11

22

33

44

55

66

77

88

99

1010

1111

1212

AppApp

IndexIndex

1.3 Alarms

This function generates an alarm when the measured data meets a certain condition. 
The alarm occurrence/release can be recorded on the chart paper. The alarm status can 
be displayed on the screen.
Also, alarm output relays can be used to output contact signals when alarms occur (/A1, 
/A2, /A3, /A4, and /A5 options).

Alarm Types
Number of Alarm Point Marks
Up to four alarms can be set for each channel. The 4 alarm settings are called Level 1, 
Level 2, Level 3, and Level 4. The numbers do not indicate a difference in importance.

Alarm Conditions
The eight conditions below are available. The character inside the parentheses is the 
symbol used to denote each alarm on the recorder.
• High Limit Alarm (H)
 An alarm occurs when the input value exceeds the alarm value.
• Low Limit Alarm (L)
 An alarm occurs when the input value falls below the alarm value.

   

Alarm 
value

Alarm release
Measured value

Alarm occurrence
High limit alarm Low limit alarm

Measured 
value

Alarm release

Alarm valueAlarm occurrence

• Difference High Limit Alarm (h)*
	 An	alarm	occurs	when	the	difference	in	the	input	values	of	two	channels	is	greater	

than	or	equal	to	the	specified	value.
• Difference Low Limit Alarm (l)*
	 An	alarm	occurs	when	the	difference	in	the	input	values	of	two	channels	is	less	than	

or	equal	to	the	specified	value.
* Can be specified on channels set to delta computation.

• High Limit on Rate-of-Change Alarm (R)
 The rate-of-change of the measured values is checked over a certain time (interval). 

An alarm occurs if the rate-of-change of the measured value in the rising direction is 
greater	than	or	equal	to	the	specified	value.

• Low Limit on Rate-of-Change Alarm (r)
 The rate-of-change of the measured values is checked over a certain time (interval). 

An alarm occurs if the rate-of-change of the measured value in the falling direction is 
greater	than	or	equal	to	the	specified	value.

Measured 
value

Change in the 
measured value

T1

Time

Interval

T2

t1 t2

Amount of change 
in the setting T2

Time

T1

t1 t2

Measured 
value

Change in the 
measured value

Amount of change 
in the setting
| |

High limit on rate-of-change alarm Low limit on rate-of-change alarm

t2-t1
Interval

t2-t1

T2-T1
| |T2-T1

 The alarm value of the rate-of-change alarm is set using an absolute value. The 
interval is derived using the following equation and set using the number of samples.

 Interval = the scan interval × the number of samples
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1.3  Alarms

• Delay High Limit Alarm (T)
 An alarm occurs when the measured value remains above the alarm value for a 

specified	time	period	(alarm	delay	period).
• Delay Low Limit Alarm (t)
 An alarm occurs when the measured value remains below the alarm value for a 

specified	time	period	(alarm	delay	period).

 Delay High Limit Alarm Example (T denotes the specified delay)

   

Alarm releaseAlarm occurrence

T

X1 X2 X3 X4

T1

Measured value

Alarm value

•	 Alarm	does	not	occur	at	T1,	because	the	time	period	is	shorter	than	the	specified	
alarm delay period (T).

• The measured value exceeds the alarm value at time X2, and the alarm occurs at 
time	X3	at	which	the	specified	alarm	delay	period	elapses	(the	time	when	the	alarm	
occurs is the time at X3).

• The measured value falls below the alarm value at time X4, and the alarm is 
released.

Note
• The alarm detection operation is reset when a power failure occurs. The operation restarts 

after the power recovers.
• If the alarm value is changed while a delay alarm is occurring, the alarm is released if the 

new alarm value does not meet the alarm condition.

Alarm Hysteresis
Hysteresis can be specified to the values for activating and releasing the alarm. The 
hysteresis applies only to high limit alarm (H) and low limit alarm (L). The hysteresis 
width can be set in the range of 0.0% (Off) to 1.0% of the recording span in 0.1 steps. 
The setting applies to all high limit alarms and low limit alarms. By default, the hysteresis 
width is set to 0.5%.

  

Alarm 
value

Alarm release
Measured value

Alarm occurrence

High limit alarm Low limit alarm

Measured 
value

Alarm release

Hysteresis
(1% or less)

Alarm value
Alarm occurrence

<Related Topics>   Setting alarms: Section 5.2 
Setting the alarm delay function: Sections 7.15 and 6.10 
Setting the alarm hysteresis: Section 7.1
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Alarm Indication
The alarm status can be displayed on the screen. For details on the display, see section 
1.5.
Non-Hold/Hold Operation of the Alarm Indication
The alarm indication can be set to operate in the following fashion when the alarm 
condition is no longer met.
• Clear the alarm indication (non-hold).
• Hold the alarm indication until the alarm ACK operation is executed (hold).
The default setting is non-hold.

  
Alarm

Alarm occurrence

Alarm release

Alarm 
indication

Alarm ACK Alarm ACK

or

or

HoldNon-hold

ON ON

OFF

Blinking

OFF

Blinking

OFF

<Related Topics>   Setting the non-hold/hold operation of the alarm indicator: Section 7.1

Alarm Recording
The alarm occurrence/release can be recorded on the chart paper. See section 1.4.

Alarm Output Relay (/A1, /A2, /A3, /A4, and /A5 Options)
Contact signals can be generated from alarm output relays when alarms occur. The 
number of output relays is 2 (/A1), 4 (/A2), 6 (/A3), 12 (/A4), or 24 (/A5). The alarm output 
relays are denoted as I01 to I06, I11 to I16, I21 to I26, and I31 to I36 on the recorder.
The following functions can be assigned to the alarm output relay.

Diagnosis Output
The diagnosis output can be assigned to alarm output relay I01.
The relay is activated when there is an error in the plotter operation on the pen model, 
when a burnout is detected, or when there is an error in the A/D converter. Output relay 
I01 is normally energized and de-energizes when an error is detected (de-energized 
operation and non-hold operation).

  NO C NC

Normal
NO C NC

Malfunction
NO C NC

Power-OFF

NO: Normally Opened, C: Common, NC: Normally Closed

Note
If diagnosis output is enabled, I01 becomes a relay dedicated to diagnosis output.

<Related Topics>  Setting the diagnosis output: Section 7.1



IM 04P02B01-01E 

For the procedure to set the functions, see section 1.10, “Function Setup Guide.”
1-10

1.3  Alarms

Reflash Alarm
When multiple alarms are assigned to one alarm output relay, this function notifies the 
occurrence of subsequent alarms after the relay is activated by the first alarm. When 
subsequent alarms occur, the output relay is released temporarily (approximately 
500 ms).
The reflash alarm function is set to three output relays (I01, I02, and I03 (I01 and I02 for 
the /A1 option)).
By default, the reflash alarm is disabled.

  

Alarm

Alarm output relay
(Reflash alarm ON)

Alarm output relay
(Reflash alarm OFF)

Channel 1

Channel 3

Channel 2

Approx. 500 ms Approx. 500 ms

Note
• If the reflash alarm is enabled, I01 to I03 are set to reflash alarm operation. In this case, I01 

to I03 are set to OR operation and non-hold operation regardless of the settings specified in 
“AND/OR Operation of Alarm Output Relays” and “Non-Hold/Hold Operation of Alarm Output 
Relays” described below.

• If diagnosis output is enabled, I01 is set to diagnosis output.

<Related Topics>		Setting	the	reflash	alarm:	Section	7.1
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AND/OR Operation of Alarm Output Relays
When multiple alarms are assigned to one alarm output relay, the condition for activating 
the alarm output relay can be selected from the following:
• AND: Activated when all assigned alarms are occurring simultaneously.
•	 OR:	 Activated	when	any	of	the	specified	alarms	is	occurring.

  

Alarm

Channel 01

AND

Channel 02

OR

Alarm output relay

The alarm output relays assigned to AND operation are specified as follows: “I01 (first 
relay) to Ixx (where xx is the relay number).”
The default setting is “no AND relay.”

Note
• If the reflash alarm is enabled, I01 to I03 are fixed to OR operation. Specifying AND 

produces no effect.
• If diagnosis output is enabled, I01 is set to diagnosis output. Specifying AND produces no 

effect.

<Related Topics>  Setting the AND operation: Section 7.1

Energized/De-energized Operation of Alarm Output Relays
You can select whether the alarm output relay is energized or de-energized when an 
alarm occurs. If de-energized is selected, the status of the alarm output relay when an 
alarm occurs is the same as the status that results when the recorder is turned OFF 
(including power failures). The setting applies to all alarm output relays.
The default setting is energized.

  

NOEnergize

De-energize

C NC NO C NC NO C NC

NO C NC NO C NCNO C NC

When power is 
turned OFF

NO : Normally Opened, C : Common, NC : Normally Closed

When alarm is 
not occurring

When alarm is 
occurring

Note
If diagnosis output is enabled, I01 is fixed to de-energized operation.

<Related Topics>   Setting the energized/de-energized operation of alarm output relays: 
Section 7.1
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1.3  Alarms

Non-Hold/Hold Operation of Alarm Output Relays
The alarm output relay can be set to operate in the following fashion when the alarm 
condition is no longer met.
•	 Turn	off	the	relay	output	(non-hold).
• Hold the relay output until the alarm ACK operation is executed (hold).
The setting applies to all alarm output relays.
The default setting is non-hold.

  
Alarm

Alarm occurrence

Alarm release

Alarm output 
relay

Alarm 
ACK

Alarm 
ACK

Alarm 
ACK

or

or

HoldNon-hold

Activated

Released

Note
• If the reflash alarm is enabled, I01 to I03 are fixed to non-hold operation. Specifying Hold 

produces no effect.
• If diagnosis output is enabled, I01 is fixed to non-hold operation. Specifying Hold produces 

no effect.

<Related Topics>   Setting the non-hold/hold operation of alarm output relays: Section 7.1

Alarm ACK Operation
The alarm acknowledge (alarm ACK) operation releases all alarm indications and relay 
outputs (/A1, /A2, /A3, /A4, and /A5 options) that are activated when the alarm indication 
or alarm output relay is set to hold operation. This operation can be executed from the 
front panel key.

<Related Topics>  Alarm ACK operation: Section 3.12
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1.4 Recording

The recorder is capable of recording the measured values with pens or dots (trend 
recording) as well as various other types of information.

Recording Example on the Pen Model

 

Recording Example on the Dot Model

The recording examples may appear differently from the actual recording as a result of 
functional improvements made on the recorder after this manual was written. 

<Related Topics>  Starting/Stopping recording: Section 3.5
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1.4  Recording

Trend Recording
The measured values are printed within a width of 180 mm.

Recording Method (Pen Model)
• The measured value is updated every scan interval and continuously recorded.
• The recording colors in order from channel 01 are red, green, blue, and violet.

Recording Method (Dot Model)
• The most recent measured value is recorded with a dot every dot printing interval. The 

dot printing interval is in the range of 10 s to 90 s. There are two recording methods 
from which you can select. One method automatically adjusts the dot printing interval 
according to the chart speed so that the dots do not overlap. The other method 
records at the fastest dot printing interval at all times.

• The recording colors are assigned to each set (channels 01-06, 07-12, 13-18, and 
19-24) of six channels in ascending order as follows: purple, red, green, blue, brown, 
and black. The recording color of each channel can be changed among these six 
colors.

• For each channel, trend recording can be enabled or disabled.

<Related Topics>   Setting the trend recording interval: Section 6.1 
Changing the recording color: Section 7.5 
Enabling/Disabling trend recording for each channel: Section 6.6

Chart Speed
On the pen model, the chart speed can be selected from 82 settings in the range of 5 to 
12000 mm/h.
On the dot model, the chart speed can be set in the range of 1 to 1500 mm/h in 1-mm 
steps.
The default setting is 25 mm/h.

<Related Topics>  Setting the chart speed: Section 5.4

Zone Recording
A recording zone is assigned to each channel. This function is useful such when the 
recording results overlap making them difficult to be viewed.

  

Zone 1 Zone 2 Zone 3 Zone 4

<Related Topics>  Setting the zone recording: Section 6.4
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Partial Expanded Recording
This function expands a section of the recording range. By default, partial expanded 
recording is disabled.

  

Compressed Expanded

<Related Topics>  Setting the partial expanded recording: Sections 7.13 and 6.5

Pen Offset Compensation (Pen Model)
This function compensates for the pen offset (phase difference) along the time axis.
On 2-pen, 3-pen, and 4-pen recorders, there are offsets along the time axis (phase 
difference) between the pens. This offset is corrected when pen offset compensation is 
used.

  
Same time 

Below is an explanation for the 2-pen model.
The recording of these two pens are offset by an amount of phase P. If pen offset 
compensation is enabled, the measured values of pen 1 are stored in the memory, and 
recorded when the chart paper is fed by an amount corresponding to P.

  PChart paper

Reference pen (pen 2)

Pen 1

Chart feeding direction

Recorder front panel

By default, this function is disabled.

<Related Topics>   Setting	the	pen	offset	compensation:	Section	7.6 
Ejection of pen offset compensating data: “Header Printout (/BT1 
Option) in section 1.4
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1.4  Recording

Printout
The figure below is used to explain the printout contents. The actual printout and font 
are different from those illustrated in the figure. The printout positions are also slightly 
different.

Printout Example on the Pen Model

Recording start printout

Alarm printout

Message printout

New chart speed printout

Manual printout

Periodic printout

Time tick
Recording color

Scale

Buffer overflow mark

Time tick cancel mark

Offset compensation mark

Alarm

Delta computation

Nov.09.04 15:00
1    223.5mg/cm3 2    437.2µS/cm
3 H  591.6°C 4   -0.222V

Nov.09.04!
13:50*
1          218.7mg/cm3

2          390.6µS/cm
3       H  598.4°C
4      d  -0.222V
0.0  500.0
1CH mg/cm3

RED 
50mm/h_

08:00*25mm/h

09:52*START#205 ABCDEF

1H3*10:09
1H3 10:05

50mm/h*14:55
Channel number or tag

Time tick
A time tick is a mark that indicate the position of the date/time on the chart paper.
Time tick cancel mark
An exclamation point (!) is printed when the periodic printout time tick was not printed at the 
correct position.
Channel number or tag printout
Channel numbers or tags can be printed.

<Related Topics>
Switching between channel number printout and tag printout: Section 7.7
Setting the periodic printout (interval, reference time, types of measured values, and 

periodic printout ON/OFF): Section 7.8
Turning printout ON/OFF (alarm printout, recording start printout, new chart speed 

printout, scale printout for periodic printout, and recording color printout for 
periodic printout): Section 7.7

Setting the time format (alarm printout, message printout, recording start printout, and 
new chart speed printout): Section 7.16

Turning periodic printout ON/OFF for each channel: Section 6.6
Executing manual print: Section 3.7
Setting the message string and printing messages: Sections 6.8 and 3.10
Clearing the alarm printout buffer: Section 3.9
Printing settings: Section 3.8
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Printout Example on the Dot Model

1

1

1

1
Alarm printout

Message printout

Manual printout

Channel printout

Periodic printout

Scale

Buffer overflow mark

Time tick

Time tick

New chart speed printout

Delta computation

Alarm

Time tick

Recording start printout

Nov.09.04 16:00
01    223.5mg/cm3 02    437.2µS/cm
03 H  591.6°C 04   -0.222V
05   -0.665V 06 L -0.448V

_50mm/h*14:55

_08:00*25mm/h

09:52*START#205 ABCDEF

01H3*10:09
01H3 10:05

Nov.09.04
13:50
01          218.7mg/cm3

02          390.6µS/cm
03       H  598.4°C
04      d  -0.222V
05         -0.995V
06       L -0.448V
0.0  500.0
01CH mg/cm3

50mm/h_

Channel number or tag

Channel Printout (Dot Model Only)
Prints the channel number or tag by the trend recording. The channel number or tag is printed 
every approximately 25 mm on the chart paper. The channel printout can be enabled or 
disabled. By default, the channel printout is enabled.

<Related Topics>
Switching between channel number printout and tag printout: Section 7.7
Setting the periodic printout (interval, reference time, types of measured values, and 

periodic printout ON/OFF): Section 7.8
Turning printout ON/OFF (channel printout, alarm printout, recording start printout, new 

chart speed printout, and scale printout for periodic printout): Section 7.7
Setting the time format (alarm printout, message printout, recording start printout, and 

new chart speed printout): Section 7.16
Turning recording and printout ON/OFF for each channel (trend recording and periodic 

printout): Section 6.6
Executing manual print: Section 3.7
Setting the message string and printing messages: Sections 6.8 and 3.10
Clearing the alarm printout buffer: Section 3.9
Printing settings: Section 3.8
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1.4  Recording

Alarm Printout
Alarm information is printed when an alarm occurs or releases.
Printout is not performed when the chart speed is as follows:
 Pen model: 1600 mm/h or greater. Dot model: 51 mm/h or greater (18-dot and 24-dot 

models) and 101 mm/h or greater (6-dot and 12-dot models).

   

Time of alarm occurrence/release
Indicates that there are alarms that are not 
printed because the alarm printout buffer is full.

Level number
Alarm type

Channel number or tag
      : Alarm occurrence,      : Alarm release

• The print condition can be set to (1) print when alarms occur and release, (2) print 
only when alarms occur, or (3) do not print.

• Alarms that occur while an alarm printout is in progress are temporarily saved to the 
buffer	memory	in	a	printout-wait	condition.	Alarms	are	cleared	from	the	buffer	memory	
when they are printed.

•	 The	number	alarms	that	can	be	stored	in	the	buffer	is	8	and	24	on	the	pen	model	and	
dot	model,	respectively.	Alarms	that	occur	while	the	buffer	is	full	are	not	printed.	A	
buffer	overflow	mark	is	printed	when	there	are	alarms	that	cannot	be	printed	because	
the	buffer	is	full.

• The time printout format can be selected.
Type Printout format
Hour:Minute 10 : 00
Hour:Minute:Second 10 : 00 : 00
Month:Day:Hour:Minute Nov. 09  10 : 00
Month:Day:Hour:Minute:Second Nov. 09  00 : 00 : 00
Year:Month:Day: Hour:Minute:Second Nov. 09. 2004  10 : 00 : 00
* The format of year, month, and day varies depending on the setting (see the next page).

Periodic Printout
Measured values and other items are printed at the preset interval.
Printout is not performed when the chart speed is as follows:
 Pen model:  Less than or equal to 9 mm/h or greater than or equal to 1600 mm/h
 Dot model:   9 mm/h or less, 51 mm/h or greater (18-dot and 24-dot models), and 

101 mm/h or greater (6-dot and 12-dot models)
• Printout Contents (for details, see appendix 1)

• Date/time, time ticks (marks that indicate the positions of the date/time on the chart 
paper); measured values, alarm status, scale (leftmost and rightmost values of 
span) and recording color (pen model) for each channel; and chart speed can be 
printed.	When	pen	offset	is	being	executed	on	the	pen	model,	the	pen	offset	marks	
are printed. On the pen model, if a time tick is not printed at the correct position, a 
time tick cancel mark (!) is printed.

• Printout of measured values and alarm status can be enabled or disabled for each 
channel.

• Printout of the scale and recording colors (pen model) can be enabled or disabled. 
The scale can be printed when the recording zone is greater than or equal to 40 mm.

• The measured values for each channel can be selected from the following data types.
 Instantaneous value (measured value at the time of periodic printout)
 AVE (average of the measured values over an interval)
 MIN (minimum value of the measured values over an interval)
 MAX (maximum value of the measured values over an interval)
 MIX (minimum , maximum , and average value of the measured values over an interval)
 SUM (summed value of the measured values over an interval)

• Interval (for details, see appendix 2)
 The printout interval can be set by specifying the value or set automatically in sync 

with the chart speed.
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• Turning ON/OFF the Periodic Printout
 Periodic printout can be turn ON/OFF. By default, periodic printout is enabled with the 

interval synchronized to the chart speed. Also, the measured values that are printed 
are the instantaneous values.

Manual Printout
The current measured values and alarm status as well as computed results when 
computation mode is on can be printed with keys.
When manual printout is executed, trend recording stops and restarts when manual 
printout is complete.

Message Printout
Printout is not performed when the chart speed is as follows:
 Pen model: 1600 mm/h or greater. Dot model: 51 mm/h or greater (18-dot and 24-dot 

models) and 101 mm/h or greater (6-dot and 12-dot models).
Preset messages can be printed on the chart paper using the keys. Five messages, each 
within 16 characters, can be registered in advance.
• If message printout is executed while another message is being printed, the most 

recent message is temporarily stored to the buffer	memory	in	a	printout-wait	condition.	
Messages	are	cleared	from	the	buffer	memory	when	they	are	printed.

•	 The	number	of	messages	that	can	be	stored	in	the	buffer	is	5.	If	message	printout	is	
executed	when	the	buffer	is	full,	the	message	is	not	printed.	A	buffer	overflow	mark	is	
printed	when	there	are	messages	that	cannot	be	printed	because	the	buffer	is	full.

• The time printout format can be selected.

New Chart Speed Printout
Printout is not performed when the chart speed is as follows:
 Pen model: 1600 mm/h or greater. Dot model: 51 mm/h or greater (18-dot and 24-dot 

models) and 101 mm/h or greater (6-dot and 12-dot models).
• When the chart speed is changed, the time tick (dot model), the date/time of change, 

and the new chart speed are printed. An asterisk (*) shows there are messages that 
cannot be printed.

• The time printout format can be selected.

Recording Start Printout
Printout is not performed when the chart speed is as follows:
 Pen model: 1600 mm/h or greater. Dot model: 51 mm/h or greater (18-dot and 24-dot 

models) and 101 mm/h or greater (6-dot and 12-dot models).
When recording is started, the time tick (dot model), the time, and the chart speed can be 
printed. An asterisk (*) shows there are messages that cannot be printed.
• The recording start printout can be enabled or disabled. By default, the recording start 

printout is disabled.
• The time printout format can be selected.

Printout/Display Format of the Date
The printout/display format of the date can be selected from the list below. The setting 
applies to all dates printed and shown on the display. However, this does not apply to 
the format of the date printout of the message printout that include the measured values 
(/BT1 option).

Type Printout/Display Format
Y/M/D 2005/08/31
M/D/Y 08/31/2005
D/M/Y 31/08/2005
D.M.Y 31.08.2005
M.D.Y Aug.31.2005

<Related Topics>  Setting the printout/display format of the date: Section 7.19



IM 04P02B01-01E 

For the procedure to set the functions, see section 1.10, “Function Setup Guide.”
1-20

1.4  Recording

Setting Printout
List or Setup List can be printed. When setting printout is executed, trend recording stops 
and restarts when the printout is complete.
List printout contains Setting Mode settings such as the input range and alarm for each 
channel.
Setup List contains Basic Setting Mode settings such as the alarm output relay operation 
and printout method.

• Printout Example of List on the Pen Model

The printout examples may appear differently from the actual printout as a result of functional 
improvements made on the recorder after this manual was written.
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• Printout Example of List on the Dot Model

The printout examples may appear differently from the actual printout as a result of functional 
improvements made on the recorder after this manual was written.
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1.4  Recording

Header Printout (/BT1 Option)
When recording is started, the Start printout is performed, and recording starts. During 
trend recording, you can print out messages (up to 5) that include measured values.* 
When recording is stopped, End printout is performed.

  1. Chart paper feed
2. Start printout
3. Recording start
(Record start)

Operation

(Operation 
instruction)

1. Recording stop
2. End printout
3. Chart paper feed
(Recording stop)

Message printout 1 
including measured
values*
(Message printout 1)

Message printout 2 
including measured
values*
(Message printout 2)

• Example Printout (Dot Model)

Message printout 2 including measured 
values*

Message printout 1 including measured 
values*

Start printout
Comment
Batch name (batch number and lot number) 
date/time, and chart speed

End printout
Comment
Batch name (batch number and lot number) 
date/time, and chart speed

 * Computed values can also be included on models with the /M1 option. 
 The printout examples may appear differently from the actual printout as a result of 

functional improvements.

Start Printout and End printout
When recording starts, “Start printout” or “Start printout 2” prints. Also, when recording 
stops, “End printout” or “End printout 2” prints.

Printout/Operation Description Notes 
Comment Prints 64 characters x 5 lines or less. 
Batch name Can be displayed in the main display. 

Batch number Prints up to 26 characters.
Lot number Prints a number from 4-digits or 6-digits. You can automatically increment by 1 

when recording stops.
Date/time The date format prints out according to the date  

printout/display format.
Date and time cannot be turned 
On/Off independently.

Chart speed Prints the current chart paper feed speed.
Chart paper feed Feeds the chart paper 50 mm or less before Start printout. Steps of 1 mm

Feeds the chart paper 50 mm or less after End printout. Steps of 1 mm
Ejection of pen offset 
compensating data

You can record the portion of the data that remains after 
recording stops. Also, when recording the remaining  
portion of the data, you can change the chart speed to 
450 mm/h (fixed). 

When pen offset compensating is On 
(pen model).

You can select whether to print out the batch name, date/time, and chart speed. By 
default, the printout is enabled.
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•  Switching between Start Printout and Start printout 2, and between End 
printout and End printout 2

 With the remote control function (/R1 option), you can change the items that are 
printed out.

 For example, when a process ends successfully, End printout is performed and the 
lot number is updated. If the process fails, you can have End printout 2 be carried out 
and the lot number remain not updated.
 Depending on the status of the “batch comment switching signal,” the following 

switches occur when the “record start/stop signal” switches:

Record Start/Stop Signal Status
Batch Comment Switching Signal Status

Level: 0 (Open) Level: 1 (Closed) 
Upon start Edge (rising) Start printout Start printout 2 
Upon stop Edge (falling) End printout End printout 2 

    

Record start/stop 
signal

Remote Control Signal

Batch comment 
switching signal

Start Stop

Concluded 
successfully

Concluded 
unsuccessfully

Start printout End printout

Start Stop

Start printout End printout 2

Message Printout Including Measured Values*
Following the specified message format, the date/time, message strings of the standard 
function (5 strings of up to 16 characters), and measured instantaneous values* are 
printed out together.
• Up to 5 messages of 69 characters can be entered.
• Messages are printed out in the order in which they are set.
•	 Message	strings	set	with	the	standard	function	are	specified	as	the	first	n	number	

of	characters	from	the	start	of	the	string.	If	a	number	of	characters	is	specified	more	
than	once,	the	first	instance	is	n	number	of	characters	from	the	start	of	the	string,	the	
second	instance	is	n	number	of	characters	immediately	after	the	first	instance,	and	so	
on. And, for example, the character string set for message 1 can only be used once 
for message format 1.

   

06/30  10:10  Process-1  134.8°C
Measured value* on CH1 (no units)
Character string set for message 1 
of the standard function
Date/time

Message Example

* Computed values can also be included on models with the /M1 option.

<Related Topics>   Setting the header printout: Sections 7.24 and 6.14 
Assigning functions to the remote control input terminals: Section 7.18 
Setting the message string: Section 6.8 
Enabling the message format: Section 7.24 
Setting the message format: section 6.15

SD Memory Card (/EM1 option)
Measured data can be saved to an SD memory card, and the data can be replayed 
on a chart paper (dot model only). The saved data can be used in the YOKOGAWA’s 
Universal Viewer. In addition, recorder setup data can be saved to or loaded from an SD 
memory card. The setup data can be edited using the RXA10 Configuration Software.
See the μR10000/μR20000 SD Memory Card (/EM1 option) User’s Manual, IM 04P01B01-03E.
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1.5 Display

Displayed Information
Main Display
The recorder is capable of displaying measured values, alarm information, and so on the 
VFD (Vacuum Fluorescent Display). Using normal fonts, 30 characters × 2 lines can be 
displayed. Using large fonts, 20 characters can be displayed.

  
RECORD  KEYLOCK  MATH  CHARTEND  ALARM 242322212019181716151413121110987654321

Main display

Status display

Various display types are available. Also, different displays can be assigned to the 
top and bottom sections of the main display. These display types can be registered to 
screens 1 to 15 and switched during operation using the keys.

Status Display
A status display is available at the bottom of the main display. The indicators below turn 
ON/OFF.
• RECORD
 This indicator turns ON when recording is started and turns OFF when stopped.
• ALARM 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
 The numbers correspond to measurement channel numbers. The indicator turns ON 

when an alarm occurs and turns OFF when the alarm is released.
 If the alarm indication is set to hold operation, the indicator blinks when an alarm 

occurs. When alarm ACK operation is performed, the indicator turns ON or OFF.
• MATH
 This indicator turns ON when computation on the computation function (/M1 option) is 

started and turns OFF when stopped.
• KEYLOCK
 This indicator turns ON when key lock is enabled and turns OFF when disabled.
• CHART END
 This indicator turns ON when the remaining amount of chart paper falls to approximately 

2 cm on models with the FAIL/chart end function and output (/F1 option).

Display Types
The following display types are available.
• Displays that show measured values
 Measured values can be displayed numerically or using bar graphs. The channels that 

are displayed can be switched automatically at constant intervals.
 The bar graph displays 0 to 100% using 181 points.

   0% 100%181 dots

• Displays that show alarms
• Displays that show the date/time and chart speed
• Displays that show the remote control input and alarm output relay statuses (/R1 and 

/Ax options)
• Displays that show the status
• System display
• Batch name (/BT1 option)
Different display types can be assigned to the top and bottom sections of the main 
display.
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Several display examples are shown below. For details on the display types, see “Display 
Function Specifications” in section 12.4.

1 Channel Digital + 1 Bar Graph Display

  

Channel number

Alarm point mark
ScaleBar graph

UnitMeasured valueAlarm status

01 H -200.0mV

Flag Display

  

Scale

Flag (the number indicates the channel No.)

Alarm Status Display

  

Measurement channel
Symbol indicating an alarm

Computation 
channel

Channel on which an alarm is occurring
Channel on which an alarm is not occurring

Channel on which an alarm is not set

 
 
 :123456 789012 345678 901234
:ABCDEF GJ   P ABCDEF GJKMNP

. . .  . . . . . .  . . . . . .

. . . . . .  . . . . . .

. . . . .

Date/Time and Chart Speed
The date format can be specified (see page 1-19).

  

Date Tme Chart speed

Aug.31.2005 11:26:37 12000mm/h

Status Display

  

Remaining amount of chart paper is less than approx. 2 cm (/F1 option)
Alarm status

  

  
    

 
  

    

  

SD memory card status (/EM1 option)

 
 

  

 

<Related Topics>   Assigning display types to screens: Chapter 8 
Switching displays: Section 3.6 
Setting the bar graph display mode: Section 7.9 
Changing the date format: Section 7.19 
Setting the display brightness: Section 6.11 
Displaying measured values: Section 12.4.
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1.6 Computation Function (/M1 Option)

Computation Function
Computing equations can be set up using measured values and other computed values 
as variables in computation-dedicated channels, and the computation can be executed.
The computed result can be recorded. Computation is performed every scan interval.

Channels Dedicated to Computations
The computation-dedicated channels below can be used.
Model Number of Channels Channel Names
Pen model 8 0A, 0B, 0C, 0D, 0E, 0F, 0G, and 0J
Dot model 24 0A, 0B, 0C, 0D, 0E, 0F, 0G, 0J, 0K, 0M, 0N, 0P, 

1A, 1B, 1C, 1D, 1E, 1F, 1G, 1J, 1K, 1M, 1N, and 1P

Types of Computations
In the table below, y represents the computed result. X and n represent the measured 
value, a constant, etc.
Type Syntax in the 

Equation
Description

Four arithmetic 
operation

+, –, *, / Determines addition, subtraction, multiplication, and 
division.

Power ** Determines the power. y = Xn

Square root SQR() Determines the square root.
Absolute value ABS() Determines the absolute value.
Common logarithm LOG() Determines the common logarithm. y=log10x
Exponent EXP() Determines the exponent. y = ex

Relational 
computation

.LT., .LE., .GT., 

.GE., .EQ., .NE.
Determines	<,	≤,	>,	or	≥	of	two	elements	and	outputs	“0”	
or “1.”

Logical computation AND, OR, XOR, 
NOT

Determines the AND (logical product), OR (logical sum),  
XOR (exclusive logical sum) of two elements,  
NOT (negation) of an element and outputs “0” or “1.”

TLOG computation TLOG.SUM(), 
TLOG.MAX(), 
TLOG.MIN(), 
TLOG.AVE(),  
TLOG.P-P(),

Determines the sum (SUM), the maximum (MAX),  
the minimum (MIN), the average (AVE),  
and the maximum – minimum (P-P) at specified time 
intervals. There are three timers for setting the interval.

Data That Can Be Used in Equations
In TLOG computation, the measured values of measurement channels or computed 
values of computation channels can only be used. For all other computations, all of the 
data types below can be used.
• Measured Values on Measurement Channels
	 Specified	by	the	channel	number.	For	channels	that	have	scaling	enabled,	the	scaled	

values are used in the computation.
• Computed Values on Computation Channels
	 Specified	by	the	channel	number.
• Constants (K01 to K30)
 The values assigned to K01 to K30 can be used as constants.
	 Range	of	values	(maximum	significant	digits	is	5):	
 –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
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•  Communication Input Data (Pen model: C01 to C08, dot model: C01 to 
C24)

 This data type is set using the communication interface (/C7 or /C3 option).
	 Range	of	values	(maximum	significant	digits	is	5):	
  –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
 For the procedure of setting the communication input data, see the µR10000/µR20000 

Communication Interface User’s Manual (IM04P01B01-17E).
• Status of the Remote Control Input Terminal (D01 to D05, /R1 option)
 The status of the remote control input signal (1 or 0) can be used in the computation. 

Use D01 to D05 (the number following the letter D is the remote control input terminal 
number) to specify the status in the equations.

<Related Topics>   Setting the computing equation, constant, and unit: Sections 9.2 to 9.4 
Setting the TLOG timer: Sections 9.6 and 9.12

Handing of the Unit in Computations
In computations, measured/computed values are handled as values without units. For 
example, if the measured value of channel 01 is 20 mV and the measured value of 
channel 02 is 20 V, the computed result of 01 + 02 is 40.

Recording Computation Channels
Trend Recording
Trend recording is possible by setting the recording span for each computation channel.
The recording span of computation channels can be set in the range of –9999999 to 
99999999 excluding the decimal.
Zone recording and partial expanded recording are also possible.

Assignment of Computation Channels to the Pens (Pen Model)
Trend recording is possible by assigning computation channels to arbitrary pens. Only 
display or printout is possible for measurement channels or computation channels that 
are not assigned to a pen. Assignment of pens is possible only on models with the 
computation function.

  

Pen 1 2 3 4

Channel 01 02 03 04 0A 0B 0C 0D 0E 0F  . . . . 1P

Measurement channels Computation channels

<Related Topics>  Changing the channel assignment of recording pens: Section 9.14

Changing the Channel Recording Color (Dot Model)
The recording colors of computation channels can be changed. The default recording 
colors of channels are indicated below.
Recording color Purple Red Green Blue Brown Black
Computation channels 0A 0B 0C 0D 0E 0F

0G 0J 0K 0M 0N 0P
1A 1B 1C 1D 1E 1F 
1G 1J 1K 1M 1N 1P
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1.6  Computation Function (/M1 Option)

•  The Number of Channels Being Trend Recorded and the Fastest 
Recording Interval

 The fastest recording interval varies depending on the number of channels being 
trend recorded. Only display or printout is possible on measurement channels or 
computation channels that are not trend recorded.
Number of Channels Being Trend Recorded Fastest Recording Interval
6 channels or less 10 s
7 to 12 channels 15 s
13 to 18 channels 20 s
19 to 24 channels 30 s
25 to 48 channels 60 s

<Related Topics>   Changing the channel recording color: Section 9.13 
Enabling/Disabling trend recording for each channel: Section 9.9

Printout
Various printouts can be executed in the same fashion as measurement channels.
The computed values of computation channels can be printed at constant intervals by 
using the periodic printout timer or the two TLOG timers. The TLOG timers can be used 
only on the computation channels. For the printout contents when printing using the 
TLOG timer, see appendix 1.

<Related Topics>   Setting the periodic printout: Sections 7.8, 9.6, and 9.15 
Setting the printout using the TLOG timer: Sections 9.6 and 9.12

Alarms
Up to 4 alarms can be assigned to each computation channel.
• The alarm types are high limit alarm (H), low limit alarm (L), delay high limit alarm (T), 

and delay low limit alarm (t).
•	 Hysteresis	can	be	specified	to	the	values	for	activating	and	releasing	the	alarm.	The	

hysteresis applies only to high limit alarm (H) and low limit alarm (L). The hysteresis 
width	can	be	set	in	the	range	of	0.0%	(Off)	to	1.0%	of	the	recording	span	in	0.1	
steps. The setting applies to all high limit alarms and low limit alarms. By default, the 
hysteresis	width	is	set	to	0%	(Off).

<Related Topics>   Setting alarms: Section 9.5 
Setting the alarm delay function: Sections 7.15 and 9.11 
Setting the alarm hysteresis: Section 7.1

Display
Computation channels can be displayed on the VFD as with the measurement channels.

<Related Topics>  Setting the bar graph display mode: Section 9.16

Starting/Stopping Computation
Computation can be started or stopped using keys.

<Related Topics>  Starting/Stopping computation: Section 9.1
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1.7 FAIL/Chart End Detection and Output Function 
(/F1 Option)

FAIL Output
When a failure occurs in the CPU of the recorder, a relay contact signal (1 signal) is 
output. The relay is energized when the CPU is normal and de-energizes when a CPU 
failure occurs. Therefore, relay output is carried out also when the power is turned OFF 
(including a power failure). This relay behavior cannot be changed.
• FAIL Relay Output

   NO C NC

Normal
NO C NC

Failure
NO C NC

Power-OFF

NO: Normally Opened, C: Common, NC: Normally Closed

Chart End Output
When the remaining amount of chart paper falls to approximately 2 cm, recording is 
stopped, and the relay contact signal (1 relay) is output. The relay is energized in this 
case. This relay behavior cannot be changed.

  NO C NC
Normal

NO C NC
Chart end

NO C NC
Power-OFF

NO: Normally Opened, C: Common, NC: Normally Closed
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1.8 Remote Control Function (/R1 Option)

Specified operations can be carried out by applying remote signals (contact or open 
collector signals) to the remote control input terminals.
There are five remote control input terminals. An action can be assigned to each terminal.

  Contact

Open collector

Recorder

2
4

1
3

Assignable Functions
• Recording start/stop

•	 Remote	input	signal:	Rising	edge	signifies	start;	falling	edge	signifies	stop
• Starts/stops recording.
• Applying a rising edge signal when recording is already in progress produces no 

effect.	Applying	a	falling	edge	signal	when	recording	is	stopped	produces	no	effect.

• Chart Speed Switch
• Remote input signal: Level
• The chart paper is fed at the secondary chart speed while a level signal is applied 

to the terminal. The secondary chart speed is set in advance.

• Message 1 Printout to Message 5 Printout
• Remote input signal: Trigger
• Prints message 1 to 5 on the chart paper.

• Manual Printout
• Remote input signal: Trigger
• Executes a manual printout.

• Alarm ACK
• Remote input signal: Trigger
• Alarm ACK is executed on all alarms that are occurring. This is valid only when the 

alarm indication or output relay operation is set to hold.

• Internal Clock Adjustment
• Remote input signal: Trigger
• The internal clock of the recorder is adjusted to the nearest hour depending on the 

time when the remote signal is applied.
Time When Signal Is Input Adjustment
00 min 00 s to 01 min 59 s Truncates the minutes and seconds. 

Example: 10 hours 01 min 50 s becomes 10 hours 00 min 00 s.
02 min 00 s to 57 min 59 s The time is not changed.
58 min 00 s to 59 min 59 s Rounds up the minutes and seconds. 

Example: 10 hours 59 min 50 s becomes 11 hours 00 min 00 s.
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• Computation Start/Stop (/M1 option)
•	 Remote	input	signal:	Rising	edge	signifies	start;	falling	edge	signifies	stop
• Starts/stops the computation.
•	 If	the	computation	is	started,	applying	a	rising	edge	signal	produces	no	effect.	If	the	

computation	is	stopped,	applying	a	falling	edge	signal	produces	no	effect.

• Computation Reset (/M1 option)
• Remote input signal: Trigger
• The computed results of computation channels are reset. This is valid only while 

the computation is stopped. For all other cases, applying the remote signal 
produces	no	effect.

• Priority to Remote Recording (/BT1 Option)
• Remote input signal: Edge (rising/start or falling/stop)
• Starts/stops recording.
• When started with a remote signal (on a remote signal rise), stop per key operation 

or communication is disabled.

• Switching Batch Comment (/BT1 Option)
• Remote input signal: Level
• Switches between Start printout and Start printout 2, and between End printout 

and End printout 2 depending on the status of the batch comment switching signal 
when recording is started/stopped remotely.

• When starting/stopping by key operation, performs Start printout and End printout.

• Starting and Stopping Data Saving (/EM1 Option)
• Remote input signal: Edge (rising/start or falling/stop)
• Starts or stops data saving.
•	 If	data	saving	is	in	progress,	applying	a	rising	edge	signal	produces	no	effect.	If	

data	saving	is	not	in	progress,	applying	a	falling	edge	signal	produces	no	effect.

Remote Signal (Edge, Trigger, and Level)
The above actions are carried out on the rising or falling edge of the remote signal (edge), 
the ON signal lasting at least 250 ms (trigger), or the ON/OFF signal (level).

  

Rising/Falling edge Trigger Level
Rising Falling

250 ms or more

Operates at the 
secondary chart speed

250 ms or more

For contact inputs, the remote signal rises when the contact switches from open to closed 
and falls when the contact switches from closed to open. For open collector signals, the 
remote signal rises when the collector signal (voltage level of the remote control terminal) 
goes from high to low and falls when the collector signal goes low to high.

<Related Topics>   Assigning functions to the remote control input terminals: Section 7.18 
Setting the secondary chart speed: Section 6.9
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1.9 Other Functions

Key Lock
Key lock is a function that prohibits key operations. When key lock is enabled, pressing 
keys produces no effect. To release the key lock, a password is entered.
Key Lock Items
Each of the following keys can be included or excluded from the key lock function.

  
Keys that can be locked

FEEDDISPMENURCD MENUFUNC CH UP

SHIFTESC/?CHARACTER
1

In the case of the FUNC key, each function of the FUNC key can be included or excluded 
from the key lock function.
FUNC key functions: Alarm ACK execution, computation start/stop (/M1 option), manual 
printout and setting printout, message printout, printout buffer clear, resetting of the 
periodic printout report data (the average, etc.), and pen replacement (pen model), ribbon 
cassette replacement (dot model), data saving start/stop (/EM1 option), data replay start/
stop (/EM1 option), SD memory card ejection (/EM1 option)
<Related Topics>   Setting the key lock function: Section 7.10 

Using the key lock function: Section 3.13

Customize Menu
The menu can be customized to display only the menus that you use (version 1.31 or 
later).
• Display only the items that you use on the FUNC key menu.
• Display only the items that you use on the Setting mode menu.
• Lock Basic Setting mode (use a password to enter the mode).
 The pen position adjustment (pen model) and dot printing position adjustment (dot 

model) can be set so that they can be used without the password.

Operation mode Setting mode

Displays only the 
FUNC key menu 
items to be used

Displays only the 
setup menu items 
to be used

Basic Setting mode

Pen and dot 
printing position 
adjustment

Password

Hold down
for 3 s

Hold down +
for 3 s

No password

MENU

<Related Topics>   Selecting the FUNC key menu: Section 7.20 
Selecting the Setting mode menu: Section 7.21 
Enabling/Disabling the customized menu: Section 7.22

Language
The display and recording language can be set to English, Japanese, German, or 
French.
• English:   Alphabet, numbers, and symbols
• Japanese:  Alphabet, numbers, katakana, and symbols
• German:  German alphabet, numbers, and symbols
• French:   French alphabet, numbers, and symbols
* German and French are supported on version 1.21 or later.

<Related Topics>  Changing the language: Section 7.14
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DST
If the recorder is used in a region that has DST, time can be switched automatically 
between DST and standard time by setting the date/time when switching from the 
standard time to DST and the date/time when switching back from DST to standard time.
When switching from standard time to DST, the clock is set ahead by 1 hour. When 
switching back from DST to standard time, the clock is set back by 1 hour.

<Related Topics>  Using the DST: Section 6.16

Temperature Unit
The temperature unit can be set to Celsius or Fahrenheit. The setting applies to all 
channels.

<Related Topics>  Changing the temperature unit: Section 7.25
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1.10 Function Setup Guide

This section explains the settings necessary to use various functions of the recorder. 
Read the section corresponding to the function you wish to use.

Note
This section contains all the settings related to each item. If the desired setting is the same as 
the default value, you do not have to set it.

Item Description Reference 
Section

Date/Time setting Use Clock in Setting mode 5.5
DST Sets the date/time for switching between DST and standard time using Aux > DST in 

Setting mode.
6.16

Setting initialization Use Initialize in Basic Setting mode to initialize the settings of Setting mode and Basic 
Setting mode to their default values.

7.17

Measuring input functions
Item Description Reference 

Section
Range and span of the TC, RTD, or DC voltage 

Use Range in Setting mode. 5.1
1-5V • Range, span, and scale 5.1

 Use Range in Setting mode.
• Unit 5.3
 Use Unit in setting mode to set the unit after scaling.
• Low-cut 7.15
 Use Personalize > Add function > 1-5V low-cut in Basic Setting mode and select 

Use or Not.
5.1

 If Use is selected, turn On/Off Low-cut using Range in Setting mode.
 If Not is selected, the Low-cut item does not appear in the Range setting.

Scaling • Range, span, and scale 5.1
 Use Range in Setting mode.
• Unit 5.3
 Use Unit in setting mode to set the unit after scaling.

Square Root Computation • Range, span, and scale 5.1
 Use Range in Setting mode.
• Unit 5.3
 Use Unit in setting mode to set the unit after scaling.
• Low-cut 7.15
 Use Personalize > Add function > SQRT low-cut in Basic Setting mode and select 

Use or Not.
 If Use is selected, set the Low-cut point using Range in Setting mode. 5.1
 If Not is selected, the Low-cut item does not appear in the Range setting.

Unused channels Use Range > Skip in Setting mode to disable the trend recording (dot model) and 
periodic printout of the target channel. 

5.1

Bias Use Personalize > Add function > Bias in Basic Setting mode and select Use or Not. 7.15
If Use is selected, set the bias value that is added to the input using Bias in Setting 
mode. If Not is selected, the Bias item does not appear.

6.12

Burnout detection function (TC input and 1-5V input) 7.3
Use Burnout in Basic Setting mode to set the burnout detection function for each 
channel.

RJC of TC input Use RJC in Basic Setting mode to select whether to use the internal RJC function or 
an external RJC function.

7.4

Filter (pen model) Use Filter in Basic Setting mode and select Use or Not. 7.12
If Use is selected, set the filter time constant using Aux > Filter in Setting mode. 6.2
If Not is selected, the Aux > Filter item does not appear.
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Item Description Reference 
Section

Moving average (dot model)
Use Moving_AVE in Basic Setting mode and select Use or Not. 7.11
If Use is selected, set the number of samples of moving average using Aux > 
Moving_AVE in Setting mode.

6.3

If Not is selected, the Aux > Moving_AVE item does not appear.
Integration time of the A/D converter 7.2

Use A/D in Basic Setting mode to set the integration time of the A/D converter.
Temperature Unit Select the temperature unit using Temperature in Basic Setting mode. 7.25

Alarm functions
Item Description Reference 

Section
Alarms for each channel Use Alarm in Setting mode. 5.2
Delay high limit alarm/delay low limit alarm

• Alarm type 7.15
 Use Personalize > Add function > Alarm delay in Basic Mode and select Use or 

Not.
 If Use is selected, delay high limit alarm (T) and delay low limit alarm (t) become 

selectable under Alarm > Type in Setting mode.
5.2

 If Not is selected, alarm delay cannot be selected.
• Alarm delay time 6.10
 Use Aux > Alarm delay time in Setting mode to set the alarm delay time.

High limit on rate-of-change alarm/low limit on rate-of-change alarm
Use Alarm in Setting mode and set the channel to rate-of-change alarm. 5.2
Use Alarm > Increase in Basic Setting mode to set the interval of the high limit on 
rate-of-change alarm; use Alarm > Decrease in Basic Setting mode to set the interval 
of the low limit on rate-of-change alarm.

7.1

Use the alarm ACK operation
• Relay operation and display operation 7.1
 Set Alarm > Behavior in Basic Setting mode to Hold and set Alarm > Indicator to 

Hold.
• Executing the alarm ACK operation 3.12
 Use Func > Alarm ACK in Operation mode to execute the release of the alarm 

output.
Set a hysteresis on the alarm occurrence/release value of high limit alarm and low limit alarm

Use Alarm > Hysteresis in Basic Setting mode to set the hysteresis to be applied to 
the high limit alarm and low limit alarm of measurement channels.

7.1

Likewise, use Alarm > Math Hysteresis to set the hysteresis to be applied to the high 
limit alarm and low limit alarm of computation channels (/M1 option).

Change the alarm output relay operation
If Alarm > Act in Basic Setting mode set to De_energize, alarm output relay is 
energized during normal operation and de-energized when an alarm occurs.

7.1

Diagnosis output Use Alarm > Diagnosis in Basic Setting mode to set the function. 7.1

Recording functions
Item Description Reference 

Section
Chart speed Use Chart in Setting mode to set the chart speed. 5.4
Turn trend recording ON/OFF (dot model)

Use Aux > Print out in Setting mode to set whether to trend record on each 
measurement channel.

6.6

Change the recording color of measurement channels (dot model).
Use Color in Basic Setting mode to set the recording color of measurement channels. 7.5

Record by compensating for the pen offset along the time axis (pen model)
Use Aux > POC in Setting mode to turn On/Off offset compensation. 7.6

Record by setting recording zone
Use Aux > Zone in Setting mode to set the recording zone for each channel. 6.4

Partial expanded recording Use Partial in Basic Setting mode and select Use or Not. 7.13
If Use is selected, set the display mode using Aux > Partial in Setting mode. 6.5
If Not is selected, the Aux > Partial item does not appear.
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Item Description Reference 
Section

Periodic printout

Measured value

Scale

Channel number 
or tag

Recording color

Mar.31.2004!
15:50*
1          1.000V
2         -1.000V
0.000  2.000
1     V
RED
50mm/h_

• Type of measured values to be printed/disable periodic printout 7.8
 Use Print1 in Basic Setting mode to set the type of measured values to be printed.
 You can select Inst, Report (statistical calculation value), or Off.
• If Report is selected, use Print2 in Basic Setting mode to select the report  data type. 7.8
• Printout interval 7.8
 Use Print 1 in Basic Setting mode to set the periodic printout interval.
• Turn On/Off periodic printout for each channel 6.6
 Use Aux > Print out in Setting mode to enable/disable the periodic printout on each 

measurement channel.
• Scale printout and recording color printout (pen model) 7.7
 Use Print > Scale in Basic Setting mode to turn scale printout On/Off.
 Use Print > Pen color in Basic Setting mode to turn pen color printout On/Off (pen 

model).
Tag printout • Select channel printout or tag printout 7.7 

 Use Print > CH/Tag in Basic Setting mode to select whether to use channel numbers 
or tags in printouts.

• Set the tag 6.7
 Use Aux > Tag in Setting mode to set the tag name.

Tag display In data display setup mode, select Screen No.	>	(the	screen	number)	>	 
Tag_1CH digital display, Tag_2CH digital display, Tag_1CH digital + 1CH bargraph,  
or Tag_1CH digital + 4CH bargraph display (pen model).

8.2

Alarm occurrence/release printout
• Turn printout On/Off 7.7
 Use Print > Alarm in Basic Setting mode to select whether to print the alarm 

occurrence and release, print only the alarm occurrence, or not print.
• Time printout format 7.16
 Use Personalize > Time print > Alarm in Basic Setting mode to set the time printout 

format when printing alarm occurrence/release.
Recording Start Printout • Turn printout On/Off 7.7

 Use Print > Record On in Basic Setting mode to enable/disable the recording start 
printout.

• Time printout format 7.16
 Use Personalize > Time print > RCD On in Basic Setting mode to set the time 

printout format.
New chart speed printout • Turn printout On/Off 7.7

 Use Print > Chart speed in Basic Setting mode to set whether to print the new chart 
speed when the chart speed is changed.

• Time printout format 7.16
 Use Personalize > Time print > C. Speed in Basic Setting mode to set the time 

printout format.
Message printout • Set the message string 6.8

 Use Aux > Message to set the message string to be printed.
• Time printout format 7.16
 Use Personalize > Time print > Message in Basic Setting mode to set the time 

printout format.
• Execute the message printout 3.10
 Use Func > Message in Operation mode to execute the message printout.

Date format Use Date format > Type in Basic Setting mode to set the printout/display format of the 
date.

7.19

SD memory card
(/EM1 option)

Use Data save in Setting mode to set how to start and stop data saving.
Use Aux	>	Data replay to configure the recorder settings for replaying saved data on 
a chart paper using a dot model.

IM04P
01B01-
03E
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Display functions
Item Description Reference 

Section
Display brightness Use Aux > Brightness > Display in Setting mode to set the display brightness. 6.11
Bar graph display mode Use Bar graph in Basic Setting mode to set the bar graph display mode. 7.9
Display type Assigns the display type on the data display setup Screen number. Chapter 8
Date format Same as the Date format in “Recording functions.” 7.19

Other functions
Item Description Reference 

Section
Key lock • Target keys and password 7.10

 Use Keylock in Basic Setting mode to set the keys to be key-locked and the 
password.

• Enable the key lock 3.13
 Use Func > Keylock in Operation mode and select Use or Not.

Customized menu • Selecting the FUNC key display menu 7.20
 Use Select menu > Function in Basic Setting mode to select the menus to be 

displayed.
• Selecting the displayed menu of Setting mode 7.21
 Use Select menu > Set mode in Basic Setting mode to select the menus to be 

displayed.
• Executing the customize menu 7.22
 Use Cust. menu in Basic Setting mode to set whether to use the customized menu. 

If Use is selected, only the menus set to ON in the menu selection are displayed, and 
Basic Setting mode is locked.

 If Not is selected, all menus are displayed, and the Basic Setting mode lock is 
released.

Language Use Language in Basic Setting mode to set the display and printout language. 7.14
Internal light brightness Use Aux > Brightness > Light in Setting mode to set the internal light brightness. 6.11

Computation function (/M1 option)
Item Description Reference 

Section
Computing equation and recording span

Use Math > Formula in Setting mode to set the computing equation and recording 
span for each channel.

9.2

TLOG computation If TLOG computation is selected, use Math > Timer in Basic Setting mode to set the 
timer operation

9.12

Use Math > TLOG > Timer number in Setting mode to set the timer used on each 
computation channel.

9.6

Unit Use Math > Unit in Setting mode to set the unit for each channel. 9.3
Constants Use Math > Constant in Setting mode to define constants to be used in the computing 

equations.
9.4

Alarms Use Math > Alarm in Setting mode to set the alarm for each channel. 9.5
• Delay high limit alarm/delay low limit alarm

• Alarm type 7.15
 Use Personalize > Add function > Alarm delay in Basic Mode and select Use 

or Not (common with measurement channels).
 If Use is selected, delay high limit alarm and delay low limit alarm become 

selectable under Math > Alarm > Type in Setting mode. If Not is selected, alarm 
delay cannot be selected.

• Alarm delay time 9.11
 Use Math > Aux > Alarm delay time in Setting mode to set the alarm delay 

time.
Record by setting recording zone

Use Math > Aux > Zone in Setting mode to set the recording zone for each channel. 9.7
Partial expanded recording Use Partial in Basic Setting mode and select Use or Not. 7.13

If Use is selected, set the display mode using Math > Aux > Partial in Setting mode. 9.8
If Not is selected, the Math > Aux > Partial item does not appear.
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Item Description Reference 
Section

Change the recording color (dot model)
Use Color in Basic Setting mode to set the recording color of each computation 
channel.

9.13

Recording pen assignment (pen model)
Assigns measurement/computation channels to the recording pens. 9.14

Turn trend recording ON/OFF (dot model)
Use Math > Aux > Print out > Trend in Setting mode to set whether to trend record 
each computation channel.

9.9

Periodic printout

Computed value
Scale

Channel number 
or tag

Recording color

Mar.31.2004!
15:50*
1          1.000V
A         -100.00UNIT
-200.00 200.00
A   UNIT
RED
50mm/h_

• Type of computed values to be printed/disable periodic printout  
Common with measurement channels.

7.8

• If Report is selected, use Math > Print2 in Basic Setting mode to select the report 
data type.

9.15

• Printout interval 7.8
 Set Math > TLOG > Timer number in Setting mode to Periodic.
 The interval is common with measurement channels.
• Turn On/Off periodic printout for each channel 9.9
 Use Math > Aux > Print out > Periodic in Setting mode to enable/disable the 

periodic printout for each computation channel.
• Scale printout and recording color printout (pen model)  

Common with measurement channels.
7.7

Periodic printout using TLOG timer (dedicated to computation channels)

Computed value

Scale

Channel number 
or tag

Recording color
Timer number

Mar.31.2004!
15:50*
TAG-00A      100.00UNITA
B               1.0 
-200.00   200.00
TAG-00A    UNITA
RED
TLOG1

• Use Math > Timer (TLOG) in Basic Setting mode to set the printout interval. 9.12
• Use Math > Timer (TLOG) > Print in Basic Setting mode to turn the printout On. 9.12
• Use Math > Aux > Print out > Periodic in Setting mode to enable/disable the 

periodic printout for each computation channel.
9.9

• Set Math > TLOG > Timer number in Setting mode to set the timer used on each 
computation channel.

9.6

• Scale printout and recording color (pen model)  
Common with periodic printout.

7.7

Alarm occurrence/release printout
Common with measurement channels. 7.7

Tag • Channel/tag selection 7.7
 Common with measurement channels.
• Tag name 9.10
 Use Math > Aux > Tag in Setting mode to set the tag name.

Bar graph display mode Use Math > Bar graph in Basic Setting mode to set the bar graph display mode. 9.16
Procedure when computed results are in error

Use Math > Error data in Basic Setting mode to set the procedure taken when the 
computed results are in error.

9.17
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Remote control function (/R1 option)
Item Description Reference 

Section
Remote control function (/R1 option)

• Assign functions to the remote control input terminals 7.18
 Use Remote in Basic Setting mode to set the function to be assigned to the remote 

control input terminal.
• Secondary chart speed 6.9
 If “chart speed switching” is assigned, use Aux > Chart 2 in Setting mode to set the 

secondary chart speed.
• Switching between start printout and start printout 2 and between end printout and 

end printout 2 (/BT1 option)
 If BatchCMT switch is assigned
 Use Batch > Dual comment in Basic Setting mode to enable or disable start 

printout 2 and end printout 2.
7.24

 If Use is selected, set Batch > Detail > Start2 and End2 in Setting mode. 6.14
 If Not is selected, the Batch > Detail > Start2 and End2 items in Setting mode do 

not appear.

Calibration Correction (/CC1 option)
Item Description Reference 

Section
Calibration correction function

Use Personalize > Add function > Calibration in Basic Setting mode and select 7.15
Use or Not.
If Use is selected,
• Use Calibration in Basic Setting mode to set the correction mode and the number of 

calibration points.
7.23

• Use Calibration in Setting mode to set the measured value and correction value for 
each channel.

6.13

If Not is selected, the Calibration item does not appear.

Header Printout (/BT1 option)
Item Description Reference 

Section
Setting start printout and end printout

Use Batch in Basic Setting mode to set whether to use the start printout and end 
printout. If Use is selected, select a Lot No. from 4 digits, 6 digits, or OFF.

7.24

If Use is selected,
Use Batch > Batch No. in Setting mode to set the batch number. 6.14
Use Batch > Lot No. in Setting mode to set the lot number.
Use Batch > Detail > Start, End in Setting mode.

If Not is selected, the Batch > Lot No. item in Basic Setting mode and the Batch item 
in Setting mode do not appear.

Switch between start printout and start printout 2 and between end printout and end printout 2 (/R1 option)
• Switch settings
 Assign “BatchCMT switch” to the remote control input terminal. 7.18
 Use Batch > Dual comment in Basic Setting mode to set whether to use start 

printout 2 and end printout 2.
7.24

 If Use is selected, set Batch > Detail > Start2 and End2 in Setting mode. 6.14
.  If Not is selected, the Batch > Detail > Start2 and End2 items in Setting mode do 

not appear.
• Executing the switch 1.4
 The switch occurs according to the status of the “BatchCMT switch” signal when 

“Record On/Off” or “Priority R_RCD” signal assigned to the remote control input 
terminal rises or falls.

Printout of messages including measured/computed values
• Setting message strings 6.8
 Use Aux > Message in Setting mode to enter the message to print out.
• Setting the message format
 Use Batch > MSG format in Basic Setting mode and select whether to use the 

message format.
7.24

 If Use is selected, use Batch > MSG format > Message No. in Setting mode to set 
the message format.

6.15

 If Not is selected, the Batch > MSG format item does not appear.
• Executing message printout 3.10
 Use Func > Message in Operation mode to execute the message printout.
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2.1 Handling Precautions

This section describes the precautions to be taken when using the recorder. Read this 
section before use.

Handling Precautions
• Use care when cleaning the recorder, especially any plastic parts. When cleaning, 

wipe using a dry soft cloth. Do not use chemicals such as benzene or thinner, since 
these may cause discoloring and deformation.

• Keep electrically charged objects away from the recorder as this may cause 
malfunction.

• Do not apply volatile chemicals to the door glass, display, panel keys, etc. Do not 
allow rubber and vinyl products to remain in contact with the recorder for long periods 
of time. This may damage the recorder.

• When not in use, make sure to turn OFF the power switch.
• If there are any symptoms of trouble such as strange odors or smoke coming from the 

recorder, immediately turn OFF the power switch and the power supply source. Then, 
contact your nearest YOKOGAWA dealer.

Chapter 2 Before Using the Recorder
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2.2 Installation

Installation Location
Install the recorder indoors in a location that meets the following conditions. See also the 
normal operating conditions described in section 12.6, “General Specifications.”
• Instrument Panel
 The recorder is designed for panel mounting. The portable type (/H5x option) is 

designed to be used on the desktop.
• Well-Ventilated Location
 To prevent overheating, install the recorder in a well-ventilated location.
 For the panel cut dimensions when arranging multiple recorders, see section 12.7. 

Follow the panel cut dimensions providing adequate space between instruments when 
other instruments are arranged on the panel. We recommend that you secure at least 
50 mm of space from the left, right, top, and rear panels on the portable type (/H5x 
option).

• Minimum Mechanical Vibrations
 Choose an installation location with the minimum mechanical vibration.
 Installing the recorder in a location with large mechanical vibration not only causes 

adverse	effects	on	the	mechanism	but	also	may	hinder	normal	recording.
• Horizontal
 Install the recorder horizontally (However, the recorder can be inclined up to 30 

degrees backwards for panel mounting).
• Ambient temperature range between 0 to 50°C
• Ambient humidity between 20 to 80%RH (at 5 to 40°C) or 30 to 50%RH (at 

0 to 5, 40 to 50°C), No condensation should be present.
• Altitude 2000 m or less

Note
• Condensation may occur if the recorder is moved to another place where both the ambient 

temperature and humidity are higher, or if the temperature changes rapidly. In addition, 
measurement errors will result when using thermocouples. In this case, let the recorder 
adjust to the new environment for at least one hour before using it.

• The chart paper may be adversely affected by a rapid change in the ambient temperature 
and humidity.

Do not install the instrument in the following places.
• Outdoors
• In direct sunlight or near heat sources
	 Install	the	recorder	in	a	place	with	small	temperature	fluctuations	near	room	

temperature (23°C). Placing the recorder in direct sunlight or near heat appliances 
can	cause	adverse	effects	on	the	internal	circuitry.

• Where an excessive amount of soot, steam, moisture, dust, or corrosive 
gases are present

	 Soot,	steam,	moisture,	dust,	and	corrosive	gases	will	adversely	affect	the	recorder.	
Avoid such locations.

• Near Strong Magnetic Field Sources
	 Do	not	bring	magnets	or	instruments	that	produce	electromagnetic	fields	close	to	the	

recorder.	Operating	the	recorder	in	strong	magnetic	fields	can	cause	errors	in	the	
measurements.
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Installation Procedure
The recorder should be mounted on a steel panel of thickness 2 mm to 26 mm.

1. Insert the recorder from the front side of the panel.

2. As shown in the figure below, mount the recorder to the panel using the mounting 
brackets that come with the package.
• Use two brackets to support the top and bottom or the left and right sides of the 

case. (Remove the seal that is covering the holes for the mounting brackets 
beforehand.)

• The proper torque for tightening the mounting screws is 0.7 to 0.9 N•m.
• Mount the recorder to the panel according to the procedure below.
• First, attach the two mounting brackets and temporarily fasten the attachment 

screws.
•	 Next,	fix	the	recorder	in	place	by	tightening	the	attachment	screws	with	the	

appropriate torque. When the recorder is approximately perpendicular to the 
panel as you fasten the screws, press the mounting bracket against the case 
so that they are in contact with each other.

(The figure shows the case when the mounting brackets are used on the top and bottom of the case.)

Screw temporarily Fix in place

Front

Panel

Panel

Mounting bracketMounting bracket

Torque driver
(flat blade)

Attachment screw

Case

In contact 
with each other

Attachment screw

CAUTION
Tightening the screws too much can deform the case or damage the bracket.

For the dimensional drawings and panel cut dimensions, see section 12.7.

2.2  Installation
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2.3 Input Signal Wiring

General Precautions to Be Taken While Wiring

 WARNING
To prevent the possibility of electric shock when wiring, make sure that the power 
supply source is turned OFF.

 CAUTION
• The input terminals of this instrument are specific to this instrument. Do 

not connect the input terminals of the µR1000, µR1800 or other models, as 
malfunction may result.

• If a strong tension is applied to the cable wired to the recorder, the terminals of 
the recorder and/or the cable can be damaged. In order to prevent tension from 
being applied directly on the terminals, fasten all wiring cables to the rear of the 
mounting panel.

• Do not apply a voltage exceeding the following value to the input terminals as 
this may damage the recorder.
• Maximum input voltage
 Voltage range less than or equal to 200 mVDC, TC, RTD, and DI: ±10 VDC
 Ranges other than those listed above: ±60 VDC
• Maximum common-mode voltage
 ±60 VDC (under measurement category II conditions)

Precautions to Be Taken While Wiring
Take the following precautions when wring the input signal cables.
It is recommended that crimp-on lug with insulation sleeves (designed for 
4-mm screws) be used when connecting the input/output signal wires to 
the terminals. However, this does not apply clamped terminals (/H2).

  

Crimp-on lug with insulation 
sleeves (for 4-mm screws)

For clamped terminals (/H2), the following wire is recommended.
• Conductive cross-sectional area for single wire: 0.14 mm2 to 1.5 mm2, stranded wire: 

0.14 mm2 to 1.0 mm2

• Length of the stripped section of the wire: Approx. 5 mm
Take measures to prevent noise from entering the measurement circuit.
• Move the measurement circuit away from the power cable (power circuit) and ground 

circuit.
• It is desirable that the object being measured does not generate noise. However, if 

this is unavoidable, isolate the measurement circuit from the object. Also, ground the 
object being measured.

• Shielded wires should be used to minimize noise caused by electrostatic induction. 
Connect the shield to the ground terminal of the recorder as necessary (make sure 
you are not grounding at two points).
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• To minimize noise caused by electromagnetic induction, twist the measurement circuit 
wires at short, equal intervals.

• Make sure to earth ground the protective ground terminal through minimum resistance.

Do not allow static electricity to be applied to the terminals.
• When wiring the terminals, remove static electricity so that static electricity is not applied.
• If static electricity or similar high-voltage transient noise is applied to the signal line, 

the system may break.

When using internal reference junction compensation on the thermocouple 
input, take measures to stabilize the temperature at the input terminal.
• Always use the terminal cover.
• Do not use thick wires which may cause large heat dissipation (cross sectional area of 

0.5 mm2 or less recommended).
• Make sure that the ambient temperature remains reasonably stable. Large 

temperature	fluctuations	can	occur	if	a	nearby	fan	turns	ON	or	OFF.

Connecting the input wires in parallel with other devices can cause signal 
degradation, affecting all connected devices.
If you need to make a parallel connection, then
• Turn the burnout detection function OFF.
• Ground the instruments to the same point.
• Do not turn ON or OFF another instrument during operation. This can have adverse 

effects	on	the	other	instruments.
• RTDs cannot be wired in parallel.

Arrangement of the Measuring Input Terminals
A terminal cover is screwed in place on the measuring input terminal block on the rear 
panel. A label indicating the terminal arrangement is affixed to the cover.

  

Measuring input 
terminal block

Terminal cover 
attachment screws

Pen Model

  
+/A
–/B
b

+/A
–/B

b

Channel 1
Channel 2
Channel 3
Channel 4

Channel 1

Channel 3

Channel 2

Channel 4

+/A
–/B

b

Screw input terminal Clamped input terminal
(/H2 option)

2.3  Input Signal Wiring
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Dot Model

+/A
–/B
b

+/A
–/B

b

Channel 1
Channel 2
Channel 3
Channel 4
Channel 5
Channel 6

Channel 1

Channel 3

Channel 5

Channel 2

Channel 4

Channel 6

+A
–/B

b

Screw input terminal Clamped input terminal
(/H2 option)

Channel location on the input terminals

Channel
1 to 6 Channel

7 to 12

Channel
13 to 18 Channel

19 to 24

1. Turn OFF the recorder and remove the terminal cover.

2. Connect the signal wires to the terminals.

     

Clamped input terminalScrew input terminal

Philips 
screwdriver

Flat-blade 
screwdriver

Crimp-on lug with 
insulation sleeves

Signal wire

Signal wire

Note
Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for 
clamped terminals (/H2). Fold over the conducting section of the wire, for example, to make 
sure that the wire is securely connected to the clamped terminal.

3. Replace the terminal cover and fasten it with screws.
The proper torque for tightening the screws is 0.6 N•m.

2.3  Input Signal Wiring
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Measuring Input Wiring

  

– –
DC voltage

1-5V
ON/OFF

Extension leadwire

DC current

Shunt resistor

–/Bb +/A –/Bb +/A

–/Bb +/A –/Bb +/A

+ +

Thermocouple input Resistance temperature detector input

DC voltage input, 1-5V input, 
and ON/OFF input

DC current input

Leadwire resistance: 
10 Ω max./wire. The resistance 
of the three wires should be 
equal.

Example: For a 4 to 20 mA 
input, a shunt resistor of 
250 Ω  ± 0.1% can be used to 
convert to 1-5V input.

A

B
b

Note
RTD input terminals A and B on the dot model are isolated on each channel. Terminal b is 
shorted internally across all channels. However, for 3 legs isolated RTDs (/N2 option), input b is 
also isolated for each channel.

2.3  Input Signal Wiring
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2.4 Optional Terminal Wiring

General Precautions to be Taken While Wiring the Input/Output Signal Wires

 WARNING
• To prevent electric shock while wiring, ensure that the power supply source is 

turned OFF.
• If a voltage of more than 30 VAC or 60 VDC is to be applied to the output 

terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals 
to prevent the wires from slipping out when the screws become loose. 
Furthermore, use double-insulated wires (dielectric strength of 3000 VAC or 
more) for the signal wires on which a voltage of more than 30 VAC or 60 VDC is 
to be applied. For all other wires, use basic insulated wires (dielectric strength of 
1500 VAC). To prevent electric shock, attach the terminal cover after wiring and 
make sure not to touch the terminals.

    Crimp-on lug with insulation sleeves (for 4-mm screws)

 CAUTION
• The optional terminals of this instrument are specific to this instrument. Do 

not connect the optional terminals of the µR1000, µR1800 or other models, as 
malfunction may result.

• To prevent fire, use signal wires for recorder having a temperature rating of 70°C or more.
• If a strong tension is applied to the cable wired to the recorder, the terminals of 

the recorder and/or the cable can be damaged. In order to prevent tension from 
being applied directly on the terminals, fasten all wiring cables to the rear of the 
mounting panel.

• Use the following circuit voltage for the connection to the alarm/FAIL/status 
output terminal.
• When the connection is to Mains Circuits (primary AC power source circuits): 

150 V or less
• When the connection is to circuits derived from Mains Circuits (secondary 

circuits): 250 V or less
 (Mains Circuits voltage is less than 300 V, and connection must be used by 

isolation transformer.)

Arrangement of the Optional Terminals
As shown in the figure below, the optional terminal block is located on the rear panel.
The optional terminal block is provided on the recorder when an option that requires 
input/output is installed such as the alarm output relay (/A1, /A2, /A3, /A4 or /A5 option), 
FAIL/chart end output (/F1 option), remote control function (/R1 option), RS-422A/485 
interface (/C3 option)*, and Ethernet (10BASE-T) interface (/C7 option)*. A terminal cover 
is screwed in place on the measuring input terminal block. A label indicating the terminal 
arrangement is affixed to the terminal block.

* For details on terminal and connector arrangement and wiring, see the µR10000 /µR20000 
Communication Interface User’s Manual (IM 04P01B01-17E).

  

Optional terminal block

Terminal cover 
attachment screws
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NO C NC
NO C NC

/A1
NO C NC

NO C NC
NO C NC

NO C NC

/A1/F1 /A1/R1

I01
I02

I01
I02

I01
I02

CE
FAIL

NO C NC
NO C NC

1 2 3
4 5 C

/A1/F1/R1
NO C NC

NO C NC
NO C NC

NO C NC
I01
I02

CE
FAIL

1 2 3
4 5 C

(/F1)

(/R1) (/R1)

(/F1)

NO C NC
NO C NC
NO C NC
NO C NC

/A2

NO C NC

NO C NC
NO C NC

NO C NC
NO C NC
NO C NC

/A2/F1 /A2/R1

I01
I02
I03
I04

I01
I02
I03
I04

I01
I02
I03
I04
CE
FAIL

NO C NC
NO C NC
NO C NC
NO C NC

1 2 3
4 5 C

/A2/F1/R1

NO C NC

NO C NC
NO C NC

NO C NC
NO C NC
NO C NC

I01
I02
I03
I04
CE
FAIL

1 2 3
4 5 C

(/F1)

(/R1) (/R1)

(/F1)

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

/A3
NO C NC

NO C NC
NO C NC

NO C NC
NO C NC
NO C NC

/A3/R1

/F1

I01
I02
I03
I04
I05
I06

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I01
I02
I03
I04
I05
I06

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

/A3/F1

I01
I02
I03
I04
I05
I06

I01
I02
I03
I04
I05
I06

NO C NC
NO C NC

/R1

CE
FAIL

1 2 3
4 5 C

1 2 3
4 5 C

(/R1)

NO C NC

NO C NC
NO C NC

NO C NC
NO C NC
NO C NC

/A4/R1

I01
I02
I03
I04
I05
I06

1 2 3
4 5 C

(/R1)

(/R1)

(/F1)

NO C NC
NO C NC

CE
FAIL

(/F1)

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

/A4

I01
I02
I03
I04
I05
I06

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I11
I12
I13
I14
I15
I16

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I01
I02
I03
I04
I05
I06

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I11
I12
I13
I14
I15
I16

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I11
I12
I13
I14
I15
I16

/F1/R1

NO C NC
NO C NC

CE
FAIL

1 2 3
4 5 C

(/R1)

(/F1)

/A3/F1/R1

NO C NC
NO C NC

CE
FAIL

1 2 3
4 5 C

(/R1)

(/F1)

/A4/F1/R1

NO C NC
NO C NC

CE
FAIL

1 2 3
4 5 C

(/R1)

(/F1)

CE: Chart end
Shaded: Arrangement of the communication interface (/C3 

or  /C7 option) terminals or connectors. For details 
on wiring, see the μR10000 /μR20000 
Communication Interface User’s Manual 
(IM 04P01B01-17E).

2.4  Optional Terminal Wiring
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NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

/A5

I01
I02
I03
I04
I05
I06

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I11
I12
I13
I14
I15
I16

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I21
I22
I23
I24
I25
I26

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I31
I32
I33
I34
I35
I36

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I11
I12
I13
I14
I15
I16

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I21
I22
I23
I24
I25
I26

NO C NC
NO C NC
NO C NC
NO C NC
NO C NC
NO C NC

I31
I32
I33
I34
I35
I36

NO C NC

NO C NC
NO C NC

NO C NC
NO C NC
NO C NC

/A5/R1

I01
I02
I03
I04
I05
I06

1 2 3
4 5 C

(/R1)

Shaded: Arrangement of the communication interface (/C3 or  /C7 option) terminals 
or connectors. For details on wiring, see the μR10000 /μR20000 
Communication Interface User’s Manual (IM 04P01B01-17E).

Alarm Output Relay Terminals and FAIL/Chart End Output Relay Terminals
NC (Normally Closed), C (Common), NO (Normally Opened)
Remote Control Input Terminals
1 to 5 (remote control input terminals), C (Common)

Alarm output terminals correspond to I01 to I06, I11 to I16, I21 to I26, and I31 to I36 in 
the alarm output relay settings.
Remote control input terminals 1 to 5 correspond to numbers 1 to 5 in the remote control 
input settings.

2.4  Optional Terminal Wiring
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Wiring Procedure
1. Turn OFF the recorder and remove the terminal cover.

2. Connect the input/output signal wires to the terminals.

     

Philips 
screwdriver

Crimp-on lug with 
insulation sleeves

  

3. Replace the terminal cover and fasten it with screws.
The proper torque for tightening the screws is 0.6 N•m.

Alarm Output Relay Terminals and FAIL/Chart End Output Relay Terminals

  

CNO NC
NO (Normally Opened), C (Common), NC (Normally Closed)

• Relay Contact Output Specifications
 Output type:   Relay
 Contact rating:  250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (resistive load)
 Dielectric strength:  1500 VAC at 50/60 Hz for one minute (between output 

terminals and the ground terminal)

Remote Control Input Terminals

  

1 2 3

4 5 C

1 2 3

4 5 C C
1 to 5

Internal circuit

Input type:
   Photocoupler isolation
   Shared common (C)
 
Allowable input voltage:
5 VDC

5V

1 to 5 (Remote control input terminals), C (Common)

Transistor input 
(open collector)

Relay contact input
(voltage-free contact)

C: Negative side of the power supply

• Relay Contact Input/Transistor Input Specifications
	 Input	signal:	 •	 Voltage-free	contact:	Contact	closed	at	200	Ω	or	less	and	

contact	open	at	100	kΩ	or	greater
  • Open collector: 0.5 V or less (30 mADC) when turned ON, 

leakage current of 0.25 mA or less when turned OFF
 Dielectric strength:  500 VDC for one minute between input terminals and the 

ground terminal
Note

To reduce noise, use a shielded cable for the wiring of the remote control input terminals. 
Connect the shield to the ground terminal of the recorder.

2.4  Optional Terminal Wiring
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2.5 Power Supply Wiring

Precautions to Be Taken While Wiring the Power Supply
Make sure to follow the warnings below when wiring the power supply. To prevent electric 
shock and damage to the recorder, observe the following warnings.

 WARNING
Panel Mount Type
• To prevent electric shock when wiring, ensure the main power supply is turned 

OFF.
• To prevent the possibility of fire, use 600 V PVC insulated wire (AWG 20 to 16) 

or an equivalent wire for power wiring.
• Make sure to earth ground the protective earth terminal through minimum 

resistance before you turn on the power.
• Use crimp-on lugs (designed for 4 mm screws) for power and ground wiring 

termination.
• To prevent electric shock, make sure to close the transparent cover for the 

power supply wires.
• For safety, provide a double-pole switch in an easily operable location near 

the recorder to disconnect the recorder from the main power supply. Put an 
indication on this switch as the breaker on the power supply line for the recorder 
and indications of ON and OFF.

 Switch specifications
  Rated power current: 1 A or more (other than /P1), 3 A or more (/P1 option)
  Rated rush current: 60 A or more (other than /P1), 70 A or more (/P1 option)
  Use a switch complied with IEC 60947-1, 3.
• Connect a fuse in the power supply line. Use a fuse approved by CSA (for the 

use in North America) or VDE (for the use in Europe).
  2 A to 15 A (other than /P1), 4 A to 15 A (/P1 option)
• Do not add a switch or fuse to the ground line.

Portable Type (/H5x Option)
• Ensure that the source voltage matches the rated power supply voltage of the 

instrument before connecting the power cord.
• Connect the power cord after checking that the power switch of the portable type 

is turned OFF.
• To prevent electric shock or fire, be sure to use the power cord for the portable 

type supplied by YOKOGAWA.
• Make sure to connect protective earth grounding to prevent electric shock. 

Connect the power cord of the portable type to a three-prong power outlet 
equipped with a protective earth terminal.

• Do not use an extension cord that does not have a protective grounding wire. 
The protective features of the instrument will be rendered ineffective.

Use a power supply that meets the following conditions:
Item Power Supply Specifications

(Options Other Than /P1) (/P1 Option)
Rated supply voltage 100 to 240 VAC 24 VDC/AC
Allowable power supply voltage range 90 to 264 VAC 21.6 V to 26.4 VDC/AC
Rated supply voltage frequency 50/60 Hz 50/60 Hz (for AC)
Allowable power supply frequency range 50/60 Hz ± 2% 50/60 Hz ± 2% (for AC)
Maximum power consumption 55 VA 35 VA (for DC) or 45 VA (for AC)

Note
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on 
the measurement accuracy.
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Wiring Procedure
Panel Mount Type
The power supply terminals and a protective ground terminal are located on the rear 
panel.

1. Turn OFF the power switch on the recorder and open the power terminal cover.

     

Screw for fixing 
the power terminal 
cover in place

Power 
terminal block

Power terminal
cover Open

2. Wire the power cord and the protective ground cord to the power supply terminals.
Use ring-tongue crimp-on lugs (designed for 4 mm screws).

  
L

N

L

N

DC/AC24V

+

-

Philips 
screwdriver

Crimp-on lug 
with insulation 
sleeves

Power cord

Protective ground 
cord

• Other than /P1 • /P1
  (24 VDC/AC power supply)

3. Close the power supply terminal cover and secure it with the screw. The proper 
torque for tightening the screws is 0.6 N•m.

Portable Type (/H5x Option)
1. Check that the power switch to the recorder is turned OFF.

2. Connect the plug on the accessory power cord to the power supply connector on 
the rear panel.

     

3. Ensure that the power outlet to be used meets the conditions on the previous 
page and that the voltage of the power supply is within the maximum voltage 
rating of the power cord, then connect the other end of the power cord to the 
power supply outlet.
The AC outlet must be of a three-prong type with a protective earth ground  
terminal.

2.5  Power Supply Wiring
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2.6 Turning ON/OFF the Power Switch

 CAUTION
Check the following points before turning ON the power switch.
• The power cord/wires are connected correctly to the recorder.
• The recorder is connected to the correct power supply (see section 2.5).

The power switch is located inside the door at the lower right.
The power switch is a push button. Press once to turn it ON and press again to turn it 
OFF.

  

When the power switch is turned ON, a self-diagnosis program runs for a few seconds, 
and the recorder is ready for operation.

Note
• If the input wires are connected in parallel with other devices, do not turn ON/OFF the power 

switch of the recorder or another device during operation. This can have adverse effects on 
the measured values.

• If nothing is displayed when the power switch is turned ON, turn OFF the power switch 
and check the points listed above one more time. After checking the points, turn ON the 
power switch again. If the unit still does not work, it is probably malfunctioning. Contact your 
nearest YOKOGAWA dealer for repairs.

• If an error message is displayed on the screen, take measures according to the description 
in chapter 10, “Troubleshooting.”

• Turn ON the power switch, let the recorder warm up for at least 30 minutes, and then start 
the measurements.

• The instrument’s power switch may stop working after long periods of use in high-
temperature low-humidity environments. 

Checking the Date/Time
The date/time is shown on the display when the DISP  key is pressed several times. To 
correct the date/time, see the reference indicated below.

<Related Topics>  Setting the date/time: See section 5.5
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3.1 Names of Parts

Front
Door

Power switch
Turns ON/OFF the power each 
time the switch is pressed.

Chart cassette
Holds the chart paper.

Tag plate
Used to write channel names.

Display and key panel
Hold the left and right tabs and pull to open.

Mounting hole
There is one hole on each of the top, 
bottom, left, and right panels.  
The hole is covered with a seal.

Plotter pen
Prints various types of 
information.

Pen model Dot model

Display and key panel (see the next page)
There are internal lights on the bottom section 
of the display and key panel.  They lights up the 
recording area of the chart paper.

Recording pen
Records the measured value.

Printer carriage
Records measured values 
and prints various types of 
information.

Ribbon cassette
Six-color ink.

Chapter 3 Names of Parts and Run Operations
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Display and Key Panel

  

Main display
Displays the measured values.  Also, displays the setup screen when 
setting functions.

Seven keys are available.
For all keys except RCD, functions marked above the keys are enabled when 
setting functions or when the FUNC key or the DISP MENU key is pressed.

RCD key
Starts/stops recording.

MENU key
Hold this key down for 3 seconds to enter Setting mode. Hold this key down for 
3 seconds also to exit from Setting mode.

DISP key
Switches the screen in the main display.

FUNC key
Used when executing manual printout, message printout, etc.

DISP MENU key
Hold this key down for 3 seconds to switch to the data display
setup screen. Hold this key down for 3 seconds also to exit 
from the data display setup screen.

FEED key
Feeds the chart paper.

CHARACTER Key: Changes the character type when entering a character. Press 
this key while holding down the SHIFT key to switch the character type in reverse 
order.

UP/DOWN Key: Switches the setup item or the value.
Press this key while holding down the SHIFT key to switch the setup item 
or the value in reverse order.

LEFT/RIGHT Key: Moves the cursor to the right when entering a value 
or character. Press this key while holding down the SHIFT key to move 
the cursor to the left..

SHIFT Key: Used with the       key,        key, or the 
CHARACTER key.

ENTER Key: Confirms the setup item or value.

CH UP key
Switches the displayed channel.
(when manual switching is specified)

<During normal operation>

Status display
Displays the following information.
RECORD............ Illuminates while recording measured values.
KEY LOCK......... Illuminates when key lock is enabled.
MATH................. Illuminates when computation on the computation function (/M1 option) 
 is in progress.
CHART END...... Illuminates when the chart paper is out (/F1 option).
ALARM 1 to 24.. Illuminates when an alarm is occurring on channels 1 to 24.

ESC Key: Cancels the operation.
When pressed with the SHIFT key, the display of the comment 
on the setting turns ON/OFF.

<While setting functions, when the FUNC key/DISP MENU key is pressed>

RECORD  KEYLOCK  MATH  CHARTEND  ALARM 242322212019181716151413121110987654321

FEEDDISPMENURCD MENUFUNC CH UP

SHIFTESC/?CHARACTER
1

FEEDDISPMENURCD MENUFUNC CH UP

SHIFTESC/?CHARACTER
1

Note
This manual denotes the operation of pressing a key while holding down the SHIFT key as 
SHIFT + the other key (for example: SHIFT  +  key).

3.1  Names of Parts
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Rear Panel

  

Measuring input terminal block
Measuring input terminals

Heatsink
Dissipates the internal heat.

Optional terminal block
This is where terminals or ports 
used by options such as alarm 
output relays and communication 
interface are installed.

Ethernet port (/C7 option)
Power terminal block
The power terminal and protective 
ground terminal.

Portable Type (/H5x Option)

  

Carrying handle

Rear Panel

Protective ground terminal (spare)
Power terminal
With protective ground terminal
(attach the specified power cord)

Feet (4 pleces)

3.1  Names of Parts
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3.2 Installing or Replacing the Chart Paper

CAUTION
• Do not install or remove the chart cassette with the chart paper guide open. This 

may damage the stopper.
• Continuing to record or print without the chart paper on the dot model can cause 

damage to the chart cassette platen (the cylindrical section that holds the paper 
during the recording operation). Be sure to replace the chart paper ahead of 
time.

• When attaching the chart cassette, push it in until you hear the stopper click into 
place. Recordings will be inaccurate if the chart cassette is not fixed in place 
with the stopper.

Loading the Chart Paper
1. Open the door.

If recording is in progress, press the RCD  key to stop the recording.

     

Open

2. Remove the chart cassette.
Gently press the center stopper inward. The bottom section of the chart cassette 
comes out. Gently lift the chart cassette and pull it out from the recorder case.

 

Stopper
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3. Open the front cover, the chart holder (transparent plastic) of the sprocket section, 
and the chart holder (black plastic). Open the chart holder (black plastic) while 
gently pressing the stopper on either side.

     

Chart holder
(Black)

Stopper

Front cover

Chart holder
(Transparent)

Stopper

Chart holder
(Transparent)

1

2

3
2

4. Load the chart paper.
Riffle	the	chart	thoroughly	before	loading.
Make sure that the sprocket teeth of the chart drives are properly engaged in the 
chart paper perforations. Make sure not to load the chart paper backwards.

     

Z-fold chart paper

Sprocket teeth

3.2  Installing or Replacing the Chart Paper
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5. Close the chart holder and close the front cover.

  

Front cover

Chart holder
(Transparent)

Chart holder
(Transparent)

Chart holder
(Black)

The side with the long circular 
holes is the right side.

1

2

2

3

6. Replace the chart cassette back into the recorder case.
Align the left and right projections with the guide grooves of the recorder and 
press the entire chart cassette into the recorder case. Push in the chart cassette 
until	it	is	fixed	in	place	with	the	stopper.

 

Stopper

Feeding the Chart Paper
7. Press the FEED  key to assure that the chart moves two or more folds smoothly 

into the chart receiver. 
If it moves unsteadily, do the installing procedure again.

3.2  Installing or Replacing the Chart Paper
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3.3 Installing/Replacing Felt Pens or Plotter Pen 
(Pen Model)

CAUTION
• Remove the chart cassette before replacing the pens. Pressing the pen tip 

against the chart cassette will cause the tip to deform.
• Do not press or pinch the felt tip to prevent deformation.
• Do not move the penholder left or right by force to protect the driving 

mechanism.
• Make sure to remove the pen cap before installation.
• Use pen caps of the same ink color. If a pen cap of a different ink color is used 

on the pen, the remaining ink in the cap may be absorbed through the pen tip, 
and the ink may change its color.

• When installing or replacing a pen, be careful not to let the ink come in contact 
with the eyes, mouth, or skin. If the ink enters the eyes or mouth, immediately 
wash with water. If the ink makes contact with your skin, immediately wash with 
soap and water. If you notice any abnormal symptoms, immediately consult a 
doctor.

Replacing Felt Pens
1. Open the door.

If recording is in progress, press the RCD  key to stop the recording.

2. Open the display and key panel section.
Hold the left and right tabs and pull the display and key panel section toward you. 
The section opens upward.

3. Hold the felt pen cartridge and pull it out from the pen holder.
If the pen (pen holder) is at a position that is not easily accessible, see “When the 
Pen (Pen Holder) Is at a Position That Is Not Easily Accessible” on the next page.

4. Remove the cap from the new felt pen and insert the pen firmly into the pen 
holder.

     
From the top: pen 1 (red),
pen 2 (green), pen 3 (blue),
and pen 4 (violet).

5. Return the display and key panel section to its original position.
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When the Pen (Pen Holder) Is at a Position That Is Not Easily Accessible
If the pen (pen holder) is at a position that is not easily accessible, carry out the 
procedure below to move it near the center position.

1. Turn ON the power switch and press the FUNC  key.

2. Press the  ( DISP ) key several times to display the Pen exchange screen.

     Func=Pen exchange

3. Press the  ( CH UP ) key.
The pen (pen holder) moves near the center position, and the Pen exchange = End 
appears.

Note
When the pen moves, a line is drawn on the chart paper.

4. Replace the pen.

5. Press the  ( CH UP ) key.
The screen returns to the data display screen.

Replacing the Plotter Pen
1. Open the door.

If recording is in progress, press the RCD  key to stop the recording.

2. Open the display and key panel section.

3. Hold the plotter pen cartridge and pull it out from the pen holder.

4. Remove the cap from the new plotter pen and insert the pen firmly into the pen 
holder.

     

5. Return the display and key panel section to its original position.

3.3  Installing/Replacing Felt Pens or Plotter Pen (Pen Model)
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3.4 Installing/Replacing the Ribbon Cassette (Dot 
Model)

CAUTION
• Improper cassette insertion may cause the color to change or damage the 

ribbon.
• Do not apply upward force to the printer carriage. If you do, the carriage position 

may be offset, and the recorder may not print correctly.
• When installing or replacing a ribbon cassette, be careful not to let the ink 

come in contact with the eyes, mouth, or skin. If the ink enters the eyes or 
mouth, immediately wash with water. If the ink makes contact with your skin, 
immediately wash with soap and water. If you notice any abnormal symptoms, 
immediately consult a doctor.

1. Open the door.
If recording is in progress, press the RCD  key to stop the recording.

2. Press the FUNC  key.

3. Press the  ( DISP ) key several times to display Ribbon exchange.

     Func=Ribbon exchange

4. Press the  ( CH UP ) key.
The printer carriage moves near the center position, and Ribbon exchange = End is 
displayed.

5. Open the display and key panel section.
Hold the left and right tabs and pull the display and key panel section toward you. 
The section opens upward.

Note
If the recorder is OFF, pinch the printer carriage and move it near the center position.

6. Remove the ribbon cassette.
Press the stopper of the ribbon cassette to the right and pull the ribbon cassette 
out.

Stopper

Press
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7. Install a new ribbon cassette.
First, insert the right-hand part and then the left-hand part into the cassette holder.
Check that the cassette is properly engaged with the cassette holder tab.If insert-
ing the ribbon	cassette	is	difficult,	turn	the	ribbon feeding knob in the direction of 
the arrow to align the ribbon feeding shaft of the cassette with the ribbon feeding 
shaft hole of the holder.

     

Groove for the ribbon cassette stopper
Ribbon feed shaft

Ribbon feeding knob

8. Turn the ribbon feeding knob in the direction of the arrow a half turn or more to 
check that the ribbon is feeding properly. If the ribbon is loose, turn the knob in the 
direction of the arrow to tighten it.

9. Return the display and key panel section to its original position, and press the  
 ( CH UP ) key.

The screen returns to the data display screen.

3.4  Installing/Replacing the Ribbon Cassette (Dot Model)
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3.5 Starting/Stopping the Recording

This section describes the procedures for starting/stopping the chart feed and checking 
the recorded result.

Procedure
Starting the Recording
Press the RCD  key to start the chart feed.
The status display shows the word “RECORD.”

Note
For models with the FAIL/chart end detection and output function (/F1 option), the chart feed 
will not start even when pressing the RCD key if the chart paper is empty or almost out. Insert 
new chart paper before pressing the RCD key.

Stopping the Recording
While recording is in progress, press the RCD  key to stop the chart feed.
The word “RECORD” on the status display clears.

Feeding the Chart Paper Manually
The chart paper is fed while the FEED  key is held down.

Viewing the Recorded Results
Pull the front cover tab of the chart cassette to open the front cover. The recorded chart 
paper can be pulled out for viewing.

  

Front cover tab (left and right)

Recorded chart paper can be pulled out.

<Related Topics>  Changing the chart speed: Section 5.4
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3.6 Switching the Display Screen

This section describes the procedure for switching the display screen.
To change the displayed content, see chapter 8.

Procedure
Switching the Display Screen
The display screen switches each time the DISP  key is pressed.
Screen 01 through 15 are switched in order. Screens that are set to “Skip” are skipped.

Channel Auto Switching
On screens that show the measured values and computed values, the displayed channel 
is automatically switched in ascending order. The switching interval can be set to 1 s, 2 s, 
3 s, 4 s, or 5 s.
Measurement channels set to Skip and computation channels set to OFF are not 
displayed.

Switching the Displayed Channel Using Keys
If Manual switching is specified, the channel switches each time the CH UP  key is pressed 
in ascending order. All channels are displayed in order.

Note
The operation is different between auto channel switching and manual switching using keys on 
the 2-channel digital display.

   

03
04

05
06

01
02

02
03

03
04

01
02

During auto switching

When switching using keys



3-13IM 04P02B01-01E 

N
am

es of Parts and R
un O

perations

11

22

33

44

55

66

77

88

99

1010

1111

1212

AppApp

IndexIndex

3.7 Printing Measured Values (Manual Printout)

Prints the measured values of all channels and the computed results when computation 
mode is on.

Procedure
Starting the Manual Printout

1. Press the FUNC  key.

2. Press the  key to select Print out and then press the  key.

     Func=Print out

3. Press the  key with ManualStart shown on the screen.
Manual printout starts. The screen returns to the data display screen.

     Print=Manual Start

For a printout example, see “Printout” on page 1-16.

Note
• When manual printout is executed, trend recording is suspended. However, the recorder 

continues the measurement and alarm detection (in the background).
• When manual printout is complete, trend recording resumes.
• If an alarm occurs during the manual printout, the alarm is printed after the trend recording 

resumes.

Aborting the Manual Printout
The following procedure is for aborting the manual printout that is in progress.

1. Press the FUNC  key.

2. Press the  key to select Print out and then press the  key.

3. Press the  key with Manual Stop shown on the screen.
Manual printout stops. The screen returns to the data display screen.

     Print=Manual Stop

* When the            key or            key is pressed while holding down the SHIFT key, the operation is reversed as 
 when the respective key is pressed by itself.
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3.8 Printing the Recorder Settings

This section explains the procedure for printing the recorder settings. There are two sets 
of settings that can be printed: List and Setup.
List: Prints the settings of Setting mode (input range for each channel, etc.)
Setup: Prints the settings of Basic Setting mode

Note
• The printout takes several minutes to tens of minutes to complete.
• When this printout is executed, trend recording is suspended. However, the recorder 

continues the measurement and alarm detection (in the background).
• When the printout is complete, trend recording resumes.
• If an alarm occurs during the printout, the alarm is printed after the trend recording resumes.

Procedure
Starting the List Printout

1. Press the FUNC  key.

2. Press the  key to select Print out and then press the  key.

3. Press the  key to display List Start and then press the  key.
The List printout starts. The screen returns to the data display screen.

     Print=List Start

Aborting the List Printout
1. Press the FUNC  key.

2. Press the  key to select Print out and then press the  key.

3. Press the  key to display List Stop and then press the  key.
The List printout stops. The screen returns to the data display screen.

     Print=List Stop

Starting the Setup Printout
1. Press the FUNC  key.

2. Press the  key to select Print out and then press the  key.

3. Press the  key to display Setup Start and then press the  key.
The Setup printout starts. The screen returns to the data display screen.

     Print=Setup Start

Aborting the Setup Printout
1. Press the FUNC  key.

2. Press the  key to select Print out and then press the  key.

3. Press the  key to display Setup Stop and then press the  key.
The Setup printout stops. The screen returns to the data display screen.

     Print=Setup Stop

* When the            key or            key is pressed while holding down the SHIFT key, the operation is reversed as 
 when the respective key is pressed by itself.
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3.9 Clearing the Alarm Printout Buffer

Alarm information waiting to be printed is temporarily stored in the buffer memory. This 
operation clears all of the alarm information in the buffer. This function can be used to 
prevent unneeded alarm printouts from being executed.

Procedure
1. Press the FUNC  key.

2. Press the  key to select Buffer clear and then press the  key.

     Func=Buffer clear

3. Press the  key to select Alarm and then press the  key.
The data in the alarm printout buffer is cleared. The screen returns to the data display 
screen.

     Buffer clear=Alarm

* When the            key or            key is pressed while holding down the SHIFT key, the operation is reversed as 
 when the respective key is pressed by itself.
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3.10 Printing Messages

This section explains the procedure for printing the preset character strings. For the 
procedure of setting the character strings, see section 6.8.

Note
• Messages can be printed only during trend recording. However, regardless of whether trend 

recording is ON or OFF, messages waiting to be printed are temporarily stored in the buffer 
memory.

• Message printouts are not performed when the chart speed is greater than or equal to 1600 
mm/h on the pen model, greater than or equal to 101 mm/h on the 6-dot or 12-dot model, 
and greater than or equal to 51 mm/h on the 18-dot or 24-dot model.

Procedure
Printing a Message

1. Press the FUNC  key.

2. Press the  key to select Message and then press the  key.

     Func=Message

3. Press the  key to select message number and then press the  key.
The message printout starts. The screen returns to the data display screen.

     Displays the preset message.
Message=Message1

Clearing the Message Printout Buffer
Messages waiting to be printed are temporarily stored in the buffer memory. This 
operation clears the messages in the buffer.

1. Press the FUNC  key.

2. Press the  key to select Buffer clear and then press the  key.

3. Press the  key to select Message and then press the  key.
The messages in the printout buffer are cleared. The screen returns to the data display 
screen.

     Buffer clear=Message

* When the            key or            key is pressed while holding down the SHIFT key, the operation is reversed as 
 when the respective key is pressed by itself.
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3.11 Resetting the Report Data of the Periodic 
Printout

This operation resets the past report data when the recorder is configured to print the 
report data (the average, the minimum, the maximum, or the sum) of the measured 
values in periodic printout.

Procedure
Resetting the Report Data

1. Press the FUNC  key.

2. Press the  key to select Periodic and then press the  key.

     Func=Periodic

3. Press the  key to select Reset and then press the  key.
The report data is reset, and the calculation of the report data starts again from that point. 
The screen returns to the data display screen.

     Log data=Reset

* When the            key or            key is pressed while holding down the SHIFT key, the operation is reversed as 
 when the respective key is pressed by itself.
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3.12 Releasing the Alarm Output (Alarm ACK 
Operation)

This operation releases the alarm indication or relay output (/A1, /A2, /A3, /A4, or /A5 
option) when the alarm indication or output relay is set to hold operation.

Procedure
Releasing the Alarm Output

1. Press the FUNC  key.

2. Press the  key with Alarm ACK shown on the screen.
The alarm indication or relay output is released. The screen returns to the data display 
screen.

     Func=Alarm ACK

Explanation
Alarm Output Relay Operation
• When the alarm is released
 The alarm output is released when the alarm ACK operation is carried out.
• When an alarm is occurring
 The alarm output is held even after the alarm ACK operation. If the alarm ACK 

operation is carried out again after the alarm is released, the alarm output is released.

Indication (Status Display)
Blinks when an alarm occurs.
• When the alarm is released
 The alarm indication turns OFF when the alarm ACK operation is carried out.
• When an alarm is occurring
 The alarm indication turns ON after the alarm ACK operation. The alarm indication 

turns OFF when the alarm is released.

  

Alarm

Alarm output
relay

Alarm ACK Alarm ACKAlarm ACK

or

or

Alarm indication or

ON
Blinking

OFF

Blinking

OFF
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3.13 Activating/Releasing the Key Lock

When the recorder is configured to use the key lock function, this operation activates or 
releases the key lock.

Note
Key lock does not apply to the DISP  and CH UP  keys.

Procedure
Activating the Key Lock

1. Press the FUNC  key.

2. Press the  key to select Keylock and then press the  key.
The key lock is activated. The screen returns to the data display screen.

     Func=Keylock

Releasing the Key Lock

Note
A password is required to release the key lock.

1. Press the FUNC  key.

2. Press the  key to select Keylock and then press the  key.

3. Enter the password for releasing the key lock. The password values are shown 
with asterisks.
Press the  key to increment the value.
Press the SHIFT +  key to decrement the value.
Press the  key to move the cursor to the right.
Press SHIFT +  key to move the cursor to the left.

     Password=

4. Press the  key.
The key lock is released. The screen returns to the data display screen.

<Related Topics>  Changing the password: Section 7.10

* When the            key or            key is pressed while holding down the SHIFT key, the operation is reversed as 
 when the respective key is pressed by itself.



Blank
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4.1 Run Modes

The recorder has three run modes.

Operation Mode
This mode is used for normal recording operation. The recorder enters this mode 
when the power is turned ON. The operations that can be carried out in this mode are 
described in chapter 3. The details on the data display setup screen are explained in 
chapter 8.

Setting Mode
This mode is used to set the input range, alarms, chart speed, and other parameters. 
These settings can be changed while recording is in progress. However, the input 
range of measurement channels and the computing equation, unit, constant, and TLOG 
setting of computation channels cannot be changed while computation (/M1 option) is in 
progress. The operations that can be carried out in this mode are described in chapter 5 
and 6.

Basic Setting Mode
This mode is used to set the basic specifications of the recorder such as the 
thermocouple burnout detection function and the alarm output relay operation. This mode 
cannot be entered while the recorder is recording or while computation is in progress 
on the computation function (/M1 option). Measurement, recording, and alarm detection 
cannot be carried out in this mode. The operations that can be carried out in this mode 
are described in chapter 7.

  

Operation mode

Power ON

Setting mode

Data display setup screen

Basic Setting mode

MENU1

Display “End=Store” and press

MENU
Hold down 
          for 3 s

Hold down

Hold down
+ for 3 s

for 3 s

Data display screen
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4.2 Key Operations

This section describes basic operations on the panel keys to change various settings. 
Functions are set in Setting mode or Basic Setting mode.

Entering Setting Mode
Hold down the MENU  key for 3 seconds.
The Setting mode display appears. The top and bottom lines are the setup item and 
comment, respectively.
The section that is blinking in the setup item that you change. In this manual, the section 
that you change appears shaded.

  
The item to be controlled blinks.Setup item

Comment
Set=Range
Input range and record

The panel keys are set to the functions marked above the keys.

  
FEEDDISPMENURCD MENUFUNC CH UP

SHIFTESC/?CHARACTER
1

Exiting from Setting Mode (Returning to Operation Mode)
Hold down the MENU  key for 3 seconds.
The screen returns to operation mode.

Entering Basic Setting Mode
Basic Setting mode is entered from Setting mode.
Hold down the MENU  key for 3 seconds to enter Setting mode. Next, hold down both the 

 ( DISP ) key and the  ( FUNC ) key for 3 seconds.
The Basic Setting mode display appears. The top and bottom lines are the setup item 
and comment, respectively.
The section that is blinking in the setup item that you change. In this manual, the section 
that you change appears shaded.

  
The item to be controlled blinks.Setup item

Comment
Basic=Alarm
Auxiliary alarm functi

Exiting from Basic Setting Mode (Returning to Operation Mode)
This operation is used to return to Operation mode after changing the settings in Basic 
Setting mode.
Press the ESC key several times to return to the Basic= screen.
Press the  key or SHIFT +  key to select End and then press the  key. The 
setup save screen appears.

  
Basic=End
Save Settings

Press the  key to select Store and then press the  key. The setting is applied, 
and the screen returns to Operation mode. If you select Abort and press the  key, the 
setting is discarded, and the screen returns to Operation mode.

  
End=Store
Save settings and rest
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Changing the Settings
Note

The comment line shows useful information such as a description of the setup item and the 
range of selectable values. Read the comment and change the items as necessary.

The selected item change each time you press the  key. The selected item changes 
in reverse order if you press the  key while holding down the SHIFT key.

  

SHIFT key + key

key

Mode=TC

Skip
Volt

RTD
1-5V

This manual denotes the operation of pressing a key while holding down the SHIFT key 
as SHIFT + the other key (for example: SHIFT +  key).

After you make a selection, press the  key. The next screen appears.
When the Setting complete screen appears, the changed item is applied.

  
01-01 Channel
Setting complete

Using the ESC Key
If you press the ESC ( MENU) key, the operation is cancelled, and the display returns to a 
higher level menu. In other words, if you do not show the Setting Complete screen, the 
changes you made up to that point are discarded.
Press the ESC ( MENU) key while holding down the SHIFT ( FEED ) key to show or hide the 
comment that is displayed at the bottom half of the screen.

Entering Values
Use the  key or SHIFT +  key to move the cursor. Use the  key or SHIFT + 

 key to change a digit value. You repeat these steps to enter the value.

  

SHIFT key +             key
 key

Cursor

Span left= -2.000
-2.000/ 2.000V

  

SHIFT key + key

key

Span left= -1.500
-2.000/ 2.000

8
7
6

4
3
2

When you press the  key, the change is applied and the next screen is displayed.
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4.2  Key Operations

Entering Characters
Use the  key or SHIFT +  key to move the cursor.

  

SHIFT key +             key
 key

Cursor

Unit=ppm
CHR:a-z

Use the CHARACTER key or SHIFT + CHARACTER key to select the character type. 
Use the  key or SHIFT +  key to select a character. You repeat these steps to set 
the character string.

  
Character type

Unit=ppm
CHR:a-z

The character type changes in the following order: uppercase alphabet (A-Z), lowercase 
alphabet (a-z), numbers (0-9), and symbols (%-.).

A-Z A to Z, and space
a-z a to z, and space
0-9 0 to 9, and space
%-. %,	#,	°,	@,	+,	–,	*,	/,	(,	),	µ,	Ω,	2, 3, ., and space

  

SHIFT key + key 

key

Unit=ppm
CHR:a-z

p
o
n

l
k
j

When you press the  key, the change is applied and the next screen is displayed.

Inserting Characters
Press the  key or SHIFT +  key to move the cursor to the position where the 
character is to be inserted.
Press the CHARACTER key or SHIFT + CHARACTER key to show Ins DISP and then 
press the  key. A space for one character is inserted. Enter the character.

  
Position to insert the character

Display Ins DISP
Unit=ppm
CHR:Ins  DISP

Deleting a Character
Use the  key or SHIFT +  key to move the cursor to the character to be deleted.
Press the CHARACTER key or SHIFT + CHARACTER key to show Del DISP and then 
press the  key. The character is deleted.

Deleting an Entire Character String
Press the CHARACTER key or SHIFT + CHARACTER key to show Clear DISP and 
then press the  key. The entire character string is deleted.

Copying & Pasting a Character String
Show the copy source character string.
Press the CHARACTER key or SHIFT + CHARACTER key to show Copy DISP and 
then press the  key. The character string is saved to the memory.
Show the copy destination.
Press the CHARACTER key or SHIFT + CHARACTER key to show Paste DISP and 
then press the  key. The character string is pasted.
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4.3 Menu Structure, Settings, and List of Default 
Values

Operation Menus Using the FUNC Key (Operation Mode)
Below are the items that are operated using the FUNC  key. Information indicated inside 
the parentheses is references.

 

: Use the key.
key.

Message 1

Message 2

Message 3

Message 4

Message 5

Alarm

Password

Message

Start/Stop

Reset

Reset

Pen exchange = End

Ribbon exchange = End

List Start/List Stop

Setup Start/Setup Stop

Manual Start/Manual Stop

: Use the Alarm ACK

Message

Buffer clear

Keylock

Periodic

Print out

Pen exchange

Ribbon exchange

(section 3.12)

(section 9.1)

(section 3.10)

(sections 3.7, 3.8)

(sections 3.9, 
3.10)

(section 3.13)

(section 3.11)

(section 3.3)
(Pen model)

(Dot model)
(section 3.4)

Math

keyFUNC

With the SD memory card (/EM1 option), “Data save,” “Data replay,” “SD card” (Eject) menu items are added.

Alarm ACK
Alarm output release operation. This operation is valid only when the alarm indication or 
relay output is set to hold operation.
Math (Models with the Computation Function (/M1 Option))
Starts/stops the computation.
Print out
Starts/Stops the manual printout or setting printout (List or Setup).
Message
Prints messages.
Buffer clear
Clears the data waiting to be printed in the alarm printout buffer or the message printout 
buffer.
Keylock
Activates or releases the key lock. This operation is possible only when the use of the 
key lock function is enabled.
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4.3  Menu Structure, Settings, and List of Default Values

Periodic
Resets the computed value when printing of the report data (average, etc.) is specified in 
periodic printout.

Pen exchange (Pen Model)
Moves the recording pen to a position that is easily accessible for replacement on the 
pen model.

Ribbon exchange (Dot Model)
Moves the printer carriage near the center position when replacing the ribbon cassette 
on the dot model.
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Menu Structure of Setting Mode
Below are the setup items in Setting mode. Information indicated inside the parentheses 
is references.

Clock

Aux

Zone

Partial

Chart

Unit

Alarm

Bias

Range CH

CH Bias Bias

CH Level

CH

CH Left Right

CH Partial Expand Boundary

mm/h

(Date/Time)

Unit

Mode

TypeAlarm Relay_No.RelayValue

Range Span_L Span_R

Range Span_L Span_R

Range Span_L Span_R

Range Span_L Span_R

Range Span_L Span_R

Ref.CH Span_L Span_R

Span_L Span_R Scale_R Low-cutScale_L

Type Range Span_L Span_R Scale_L Scale_R

Scale_L Scale_R Low-cut Low-cut point

Volt

TC

RTD

Scale

Delta

SQRT

1-5V

DI

Skip

Trend

Print out

Tag

Message

Chart 2

Moving_AVE

Filter

Alm delay T

Brightness

Formula

Unit

Constant

Alarm

TLOG

Aux

Math

CH Trend

Message No. (Message)

CH

CH

CH

CH

CH

CH

Mode

Unit

f. Span_L Span_R

K##No.

CH

CH

CH Left Right

CH

CH Trend

CH

CH

Periodic

Tag

Duration

Level

Timer No.

Alarm

SUM scale

Type Value Relay Relay_No.

Zone

Partial Partial Expand Bound

Print out

Tag

Alm delay T

Display

No.of samples

Resp.Time

Duration

Light

DST DST Start month Start day Start time End month End day End time

mm/h

Tag

Periodic

are not displayed in the default 
condition. To display these items, 
settings must be changed in Basic 
Setting mode.

(section 5.1)

(section 6.12)

(section 6.13)

(section 5.2)

(section 5.3)

(section 5.4)

(section 5.5)

(section 6.1)

(section 6.4)

(section 6.5)

(section 6.6)

(section 6.7)

(section 6.8)

(section 6.9)

(section 6.3)

(section 6.2)

(section 6.10)

(section 6.11)

(section 6.16)

(section 9.2)

(section 9.3)

(section 9.4)

(section 9.5)

(section 9.6)

(section 9.7)

(section 9.8)

(section 9.9)

(section 9.10)

(section 9.11)

Key operation
Hold down the MENU key for 3 seconds
in Operation mode to enter Setting mode.

Hold down the MENU key for 3 seconds
in Setting mode to return to Operation mode.

Hold down both the           and            keys
for 3 seconds in Setting mode to enter
Basic Setting mode.

:

:

Use the 

Use the 

key.

key.

Calibration Calibration 1 datums 1 revise 2 datums 2 revise DecisionCH

Batch No.

MSG format

Lot No.

Detail Start

Message No.

Comment (Comment)Line No.

(Comment)Line No.

Same as Start.Start2

Same as End.End2

Print Batch Name Chart Speed Clock
Date/Time

Action Feed

End Comment

Print Batch Name Chart Speed Clock
Date/Time

Action

(Message format)

Feed

Batch

Auto inc. POC output POC speed

(section 6.14)

(section 6.14)

(section 6.14)

(section 6.15)

SD memory card (/EM1)
(IM 04P01B01-03E)

Data replay

Data save

Save param

Load param
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Menu Structure of Basic Setting Mode
Below are the setup items in Basic Setting mode. Information indicated inside the 
parentheses is references.

Add function

Time print

Alarm

A/D

Burnout CH

RJC CH

Color

POC

Print

Print 1

Print 2

Bar graph

Keylock

Moving_AVE Moving_AVE

Filter

Partial

Language

Personalize

Initialize

Remote

Channel

CH

CH

Filter

Language

Temperature Temp

Partial

Alarm Message RCD On C.Speed

Bias SQRT low-cut 1-5V low-cut Alarm delay Calibration

Burnout

RJC Volt

Color

Diagnosis Reflash AND Act Behavior

POC

Integrate

CH/Tag

Periodic

Chart speedChannel Alarm Scale Pen color

Ref.Time

SUM scale

Interval

Keylock Password

Mode Are you sure?

Remote number (Number)

(Free/Lock)

Mode

Mode

Graph

Record On

Timer (TLOG)

Print 2

Address

Math

RS422/485

Ethernet

P_Adj

Channel

CH

CH

Mode

Graph

SUM scale

Color

Baud rate Data length Parity Protocol

Timer number

Pen    CH

Error Over

Mode Interval Ref.Time Reset Print

Color

Output pen

Bar graph

Error data

Host

Local IP

DNS

Login

Login set

Timeout

K.Alive

A M G

DNS P S

Domain

Suffix_P

Login

Register User Password

Suffix_S

P_Adj Pen number (Value)

End End

Timeout Duration

Keep alive

Host

Level

Suffix primary

IP address Subnet mask

Primary server Secondary server

Gateway

Suffix secondary

Indicator Increase Decrease

Hysteresis Math hysteresis
(section 7.1)

(section 7.2)

(section 7.3)

(section 7.4)

(section 7.5)

(section 7.6)

(section 7.7)

(section 7.8)

(section 7.8)

(section 7.9)

(section 7.10)

(section 7.11)

(section 7.12)

(section 7.13)

(section 7.14)
Date format Type

(section 7.19)

(section 7.25)

(section 7.14)

(section 7.17)

(section 7.18)

(Communication)

(Communication)

(section 7.23)

(sections 11.5, 11.6)

(section 4.2)

(section 9.12)

(section 7.15)

(section 7.16)

(section 9.13)

(section 9.14)

(section 9.15)

(section 9.16)

(section 9.17)

Hold down both the           and            keys for 3 seconds in
Setting mode to enter this mode.

Key operation

:

:

Use the 

Use the 

key.

key.

PasswordCust. menu
(section 7.22)

(section 7.24)

(section 7.21)

(section 7.20)

Set mode Bias Unit

Math Batch detail

Message

Select menu

Function Buffer clear

P_Adj

Range Alarm Chart spped

Calibration

Aux

Batch name

Manual print Setup list Periodic

Cust. menu

Revise ValueCH PointCalibration
Number of set points
Point
Number of set pointsAbsolute value

Dual commentBatch Lot No. MSG formatBatch

Abs. Value

SD memory card (/EM1)
(IM 04P01B01-03E)

Format

Load param
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Setup Items in Setting Mode and Their Default Values
Items with an asterisk on the left are not displayed in the default condition. To display 
these items, settings must be changed in Basic Setting mode.

Setup Item Pen/Dot Selectable Range or Selections Default Value
Range	>	CH - 01 to 24 01
Range	>	Mode - Volt/TC/RTD/1-5V/Scale/Delta/DI/SQRT/Skip Volt
Range	>	Mode	>	Range - 20mV/60mV/200mV/2V/6V/20V/50V/1-5V/ 

R/S/B/K/E/J/T/N/W/L/U/WRe/Pt/JPt/Level/Cont/ 
(Slections for /N1 and /N3 options)

2V

*Bias	>	CH - 01 to 24 01
*Bias	>	Bias - On/Off Off
*Bias	>	Bias - ±10 % of the span of the measurable range or the 

scaling span
-

Calibration (/CC1 option)
Calibration	>	CH - 01 to 24 01
Calibration	>	Calibration - On/Off Off
Calibration	>	datums - Within the range -
Calibration	>	revise - Within the range  

(correction point + correction value for revise value)
-

Calibration	>	Decision - Yes/No Yes
Alarm	>	CH - 01 to 24 01
Alarm	>	Level - 1/2/3/4 1
Alarm	>	Alarm - On/Off Off
Alarm	>	Type - H/L/h/l/R/r (*/T/t) H
Alarm	>	Value - Depends on the alarm type. -
Alarm	>	Relay - On/Off Off
Alarm	>	Relay	number - I01 to I06, I11 to I16, I21 to I26, I31 to I36 I01
Unit	>	CH - 01 to 24 01
Unit	>	Unit - 6 characters or less Blank
Chart Pen Model 82 types (pen model) 25mm/h

Dot Model 1 to 1500 mm/h (dot model) 25 mm/h
Clock - Date/Time -
Aux	>	Trend Dot Model Auto/Fix Auto
Aux	>	Zone	>	CH - 01 to 24 01
Aux	>	Zone	>	Left,	Right - Within the recording span range (mm) Left: 0, Right: 180
*Aux	>	Partial	>	CH - 01 to 24 01
*Aux	>	Partial	>	Partial - On/Off Off
*Aux	>	Partial	>	Expand - 1 to 99% 50
*Aux	>	Partial	>	Boundary - Within the recording span range -
Aux	>	Print	out	>	CH - 01 to 24 01
Aux	>	Print	out	>	Trend Dot Model On/Off On
Aux	>	Print	out	>	Periodic - On/Off On
Aux	>	Tag	>	CH - 01 to 24 01
Aux	>	Tag	>	Tag - 7 characters or less 01 to 24
Aux	>	Message	>	Message	number - 1 to 5 1
Aux	>	Message	>	(Message) - 16 characters or less Blank
Aux	>	Chart2 Pen Model 82 types (pen model) 25 mm/h

Dot Model 1 to 1500 mm/h (dot model) 25 mm/h
*Aux	>	Moving_AVE	>	CH Dot Model 01 to 24 01
*Aux	>	Moving_AVE	>	Number	of	samples Dot Model Off, 2 to 16 Off
*Aux	>	Filter	>	CH Pen Model 01 to 24 01
*Aux	>	Filter	>	Response	time Pen Model 2s/5s/10s Off
*Aux	>	Alarm	delay	time	>	CH - 01 to 24 01
*Aux	>	Alarm	delay	time	>	Duration - 0 to 3600s 10s
Aux	>	Brightness	>	Display - 1/2/3/4/5/6/7/8 4
Aux	>	Brightness	>	Light - 1/2/3/4 2
SD memory card (/EM1 option)
Aux	>	Data	save	>	Start,	Stop - Func	menu	>	Record	>	Batch FUNC menu
							>	Data	replay	>	Mode Dot Model Original/Current Original
							>	Save	param	>	File - Up to 17 characters -
							>	Load	param	>	File - Search text -
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Setup Item Pen/Dot Selectable Range or Selections Default Value
Aux	>	DST - Not/Use Not
Aux	>	DST	>	Start	month - Apr/May/Jun/Jul/Aug/Sep/Oct/Nov/Dec/Jan/Feb/Mar Apr
Aux	>	DST	>	Strt	day - 1st-Sun/.../Last-Mon 1st-Sun
Aux	>	DST	>	Start	time - 0:00 to 23:00 0:00
Aux	>	DST	>	End	month - Apr/May/Jun/Jul/Aug/Sep/Oct/Nov/Dec/Jan/Feb/Mar Apr
Aux	>	DST	>	End	day - 1st-Sun/.../Last-Mon Last-Mon
Aux	>	DST	>	End	time - 0:00 to 23:00 0:00
Math (/M1 option)
Math	>	Formula	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	Formula	>	Mode - On/Off Off
Math	>	Formula	>	formula - 120 characters or less 01
Math	>	Unit	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	Unit	>	Unit - 6 characters or less Blank
Math	>	Constant	>	No. - K01 to K30 K01
Math	>	Alarm	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	Alarm	>	Level - 1/2/3/4 1
Math	>	Alarm	>	Alarm - On/Off Off
Math	>	Alarm	>	Type - H/L (*/T/t) -
Math	>	Alarm	>	Value - –9999999 to 99999999 excluding the decimal -
Math	>	Alarm	>	Relay - On/Off Off
Math	>	Alarm	>	Relay	No. - I01 to I06, I11 to I16, I21 to I26, I31 to I36 I01
Math	>	TLOG	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	TLOG	>	Timer	number - Periodic/1/2 Periodic
Math	>	TLOG	>	SUM	scale - Off, /s, /min, /h, /day Off
Math	>	Aux	>	Zone	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	Aux		>	Zone	>	Left,	Right - Within the recording span range (mm) Left: 0, Right: 180
*Math	>	Aux		>	Partial	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

*Math	>	Aux		>	Partial	>	Partial - On/Off Off
*Math	>	Aux		>	Partial	>	Expand - 1 to 99% 50
*Math	>	Aux		>	Partial	>	Bound - Within the recording span range -
Math	>	Aux		>	Print	out	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	Aux		>	Print	out	>	Trend Dot Model On/Off On
Math	>	Aux		>	Print	out	>	Periodic - On/Off On
Math	>	Aux		>	Tag	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	Aux		>	Tag	>	Tag - 7 characters or less 0A to 1P
*Math	>	Aux		>	Alarm	delay	time	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

*Math	>	Aux		>	Alarm	delay	time	>	Duration - 0 to 3600s 10s
Batch  (/BT1 option)
*Batch	>	Batch	No - 26 characters or less Blank
*Batch	>	Lot	No. - 0000-9999 or 000000-999999 0000 or 000000
*Batch	>	Detail	>	Start	>	Comment	>	Line	No. - 1/2/3/4/5 1
*Batch	>	Detail	>	Start	>	Comment	>	(Comment) - 64 characters or less Blank
*Batch	>	Detail	>	Start	>	Print	>	Batch	Name - On/Off On
*Batch	>	Detail	>	Start	>	Print	>	Chart	Speed - On/Off On
*Batch	>	Detail	>	Start	>	Print	>	Clock - On/Off On
*Batch	>	Detail	>	Start	>	Action	>	Feed - 0 to 50 mm 0 mm
*Batch	>	Detail	>	End	>	Comment	>	Line	No. - 1/2/3/4/5 1
*Batch	>	Detail	>	End	>	Comment	>	(Comment) - 64 characters or less Blank
*Batch	>	Detail	>	End	>	Print	>	Batch	Name - On/Off On
*Batch	>	Detail	>	End	>	Print	>	Chart	Speed - On/Off On
*Batch	>	Detail	>	End	>	Print	>	Clock - On/Off On
*Batch	>	Detail	>	End	>	Action	>	Feed - 0 to 50 mm 0 mm
*Batch	>	Detail	>	End	>	Action	>	Auto	inc. - On/Off On
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Setup Item Pen/Dot Selectable Range or Selections Default Value
*Batch	>	Detail	>	End	>	Action	>	POC	output Pen Model On/Off Off
*Batch	>	Detail	>	End	>	Action	>	POC	speed Pen Model C.Speed/450 mm h C.Speed
*Batch	>	Detail	>	Start2	...	Same	as	Start
*Batch	>	Detail	>	End2	...	Same	as	End
*Batch	>	MSG	format	>	Message	No. - 1/2/3/4/5 1
*Batch	>	MSG	format	>	Message	No.	>	(MSG	format) - 69 characters or less H:M L16



IM 04P02B01-01E 4-12

4.3  Menu Structure, Settings, and List of Default Values

Setup Items in Basic Setting Mode and Their Default Values
Setup Item Pen/Dot Selectable Range or Selections Default Value
Alarm	>	Diagnosis - On/Off Off
Alarm	>	Reflash - On/Off Off
Alarm	>	AND - None/I01/I01-I02/I01-I03/I01-I04/I01-I05/I01-I06/

I01-I11/I01-I12/I01-I13/I01-I14/I01-I15/I01-I16/
I01-I21/I01-I22/I01-I23/I01-I24/I01-I25/I01-I26/
I01-I31/I01-I32/I01-I33/I01-I34/I01-I35/I01-I36

None

Alarm	>	Act - Energize/De_energize Energize
Alarm	>	Behavior - Nonhold/Hold Nonhold
Alarm	>	Indicator - Nonhold/Hold Nonhold
Alarm	>	Increase - 01 to 15 01
Alarm	>	Decrease - 01 to 15 01
Alarm	>	Hysteresis - Off/0.1% to 1.0% 0.5%
Alarm	>	Math	hysteresis - Off/0.1% to 1.0% Off
A/D	>	Integrate Dot Model Auto/50Hz/60Hz/100ms Auto

Pen Model Auto/50Hz/60Hz Auto
Burnout	>	CH - 01 to 24 01
Burnout	>	Burnout - Off/Up/Down Off
RJC	>	CH - 01 to 24 01
RJC	>	RJC - Internal/External Internal
RJC	>	RJC	>	Volt - –20000 to 20000 µV 0 µV
Color	>	Channel Dot Model 01 to 24 01
Color	>	Color Dot Model Purple/Red/Green/Blue/Brown/Black 01, 07, 13, 19: Purple 

02, 08, 14, 20: Red 
03, 09, 15, 21: Green 
04, 10, 16, 22: Blue 
05, 11, 17, 23: Brown 
06, 12, 18, 24: Black

POC	>	POC Pen Model On/Off Off
Print	>	CH/Tag - CH/Tag CH
Print	>	Channel Dot Model On/Off On
Print	>	Alarm - On1/On2/Off On1
Print	>	Record	On - On/Off Off
Print	>	Chart	speed - On/Off On
Print	>	Scale - On/Off On
Print	>	Pen	color Pen Model On/Off On
Print1	>	Periodic - Auto/Manual Auto
Print1	>	Ref.	Time - Hour 0 to 23 (1 hour steps) 00:00
Print1	>	Interval - 10min/15min/20min/30min/1h/2h/3h/4h/6h/8h/

12h/24h
1h

Print1	>	Mode - Inst/Report/Off Inst
Print2	>	CH - 01 to 24 01
Print2	>	Mode - AVE/MIX/SUM/MIN/MAX/INST AVE
Print2	>	SUM	scale - Off, /s, /min, /h, /day Off
Bar	graph	>	CH - 01 to 24 01
Bar	graph	>	Graph - Normal/Center Normal
Keylock	>	Keylock - Not/Use Not
Keylock	>	Password - Numbers and spaces within 4 digits Blank
Keylock	>	RCD - Free/Lock Free
Keylock	>	Feed - Free/Lock Free
Keylock	>	Menu - Free/Lock Free
Keylock	>	Disp	Menu - Free/Lock Free
Keylock	>	Alarm	ACK - Free/Lock Free
Keylock	>	Math - Free/Lock Free
Keylock	>	Print	out - Free/Lock Free
Keylock	>	Message - Free/Lock Free
Keylock	>	Buffer	clear - Free/Lock Free
Keylock	>	Periodic - Free/Lock Free
Keylock	>	Pen	exchange Pen Model Free/Lock Free
Keylock	>	Ribbon	exchange Dot Model Free/Lock Free
Keylock	>	Data	save - Free/Lock Free
Keylock	>	Data	replay Dot Model Free/Lock Free
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Setup Item Pen/Dot Selectable Range or Selections Default Value
Keylock	>	SD	eject - Free/Lock Free
Moving_AVE	>	Moving_AVE Dot Model Not/Use Not
Filter	>	Filter Pen Model Not/Use Not
Partial	>	Partial - Not/Use Not
Language	>	Lang - English/Japanese/German/French English
Date	format	>	Type - Y/M/D  M/D/Y  D/M/Y  D.M.Y  M.D.Y M.D.Y
Temperature	>	Temp - °C/°F °C
Personalize	>	Add	function	>	Bias - Not/Use Not
Personalize	>	Add	function	>	SQRT	low-cut - Not/Use Use
Personalize	>	Add	function	>	1-5V	low-cut - Not/Use Not
Personalize	>	Add	function	>	Alarm	delay - Not/Use Not
Personalize	>	Add	function	>	Calibration - Not/Use Use
Personalize	>	Time	print	>	Alarm - HH:MM, HH:MM:SS, M/D H:M, M/D H:M:S, 

YMD H:M:S
HH:MM

Personalize	>	Time	print	>	Message - HH:MM, HH:MM:SS, M/D H:M, M/D H:M:S,  
YMD H:M:S, None

HH:MM

Personalize	>	Time	print	>	RCD	On - HH:MM, HH:MM:SS, M/D H:M, M/D H:M:S,  
YMD H:M:S

HH:MM

Personalize	>	Time	print	>	C.Speed - HH:MM, HH:MM:SS, M/D H:M, M/D H:M:S,  
YMD H:M:S

HH:MM

Setting initialization
Initialize	>	Mode - Setup+Set/Set Setup+Set
Initialize	>	Mode	>	Are	you	sure? - No/Yes No
Remote (/R1 option)
Remote	>	Remote	number - 1/2/3/4/5 1
Remote	>	No. - Record On Off /Chart speed/Time adjust/ 

Math start stop (/M1)/Math reset (/M1)/ 
Manual print/Alarm ACK/Message1/Message2/
Message3/Message4/Message5/ 
Priority R_RCD (/BT1)/BatchCMT switch (/BT1)/
Data save On/Off (/EM1)/ None  
(/M1, /BT1, /EM1: option)

Record On/Off

Math (/M1 option)
Math	>	Timer	(TLOG)	>	Timer	number - 1/2 1
Math	>	Timer	(TLOG)	>	Mode - Off/Relative/Absolute Absolute
Math	>	Timer	(TLOG)	>	Interval	(Relative) - 10 min to 24 h (1 min steps) 01:00
Math	>	Timer	(TLOG)	>	Interval	(Absolute) - 10min/12min/15min/20min/30min/1h/2h/3h/4h/6h/

8h/12h/24h
1h

Math	>	Timer	(TLOG)	>	Ref.	Time - Hour 0 to 23 (1 hour steps) 00:00
Math	>	Timer	(TLOG)	>	Reset - On/Off On
Math	>	Timer	(TLOG)	>	Print - On/Off On
Math	>	Color	>	Channel Dot Model 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	Color	>	Color Dot Model Purple/Red/Green/Blue/Brown/Black Purple: 0A/0G/1A/1G 
Red: 0B/0J/1B/1J 
Green: 0C/0K/1C/1K 
Blue: 0D/0M/1D/1M 
Brown: 0E/0N/1E/1N 
Black: 0F/0P/1F/1P

Math	>	Output	pen	>	Pen	←	CH Pen Model Pen: 1 to 4, Channel: 01 to 04/0A to 0J 1pen: 01, 2pen: 02, 
3pen: 03, 4pen: 04 

Math	>	Print2	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 
1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P

0A

Math	>	Print2	>	Mode - AVE/MIX/SUM/MIN/MAX/INST AVE
Math	>	Print2	>	SUM	scale - Off, /s, /min, /h, /day Off
Math	>	Bar	graph	>	CH - 0A/0B/0C/0D/0E/0F/0G/0J/0K/0M/0N/0P/ 

1A/1B/1C/1D/1E/1F/1G/1J/1K/1M/1N/1P
0A

Math	>	Bar	graph	>	Graph - Normal/Center Normal
Math	>	Error	data	>	Error - +Over/–Over +Over
Math	>	Error	data	>	Over - Skip/Limit Skip
RS-422/485 (/C3 option)
RS-422/485	>	Address - 1 to 32 1
RS-422/485	>	Baud	rate - 1200/2400/4800/9600/19200/38400 9600
RS-422/485	>	Data	length - 7/8 8
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Setup Item Pen/Dot Selectable Range or Selections Default Value
RS-422/485	>	parity - Odd/Even/None Even
RS-422/485	>	Protocol - NORMAL/MODBUS NORMAL
Ethernet (/C7 option)
Ethernet	>	Host	>	Host - 64 characters or less Blank
Ethernet	>	Host	>	Domain - 64 characters or less Blank
Ethernet	>	Local	IP	>	A - IP address 0.0.0.0
Ethernet	>	Local	IP	>	M - IP address (Subnet mask) 0.0.0.0
Ethernet	>	Local	IP	>	G - IP address (Default gateway) 0.0.0.0
Ethernet	>	DNS	>	DNS - On/Off Off
Ethernet	>	DNS	>	P - IP address (Primary DNS sever) 0.0.0.0
Ethernet	>	DNS	>	S - IP address (Secondary DNS sever) 0.0.0.0
Ethernet	>	DNS	>	Suffix_P - Primary domain suffix Blank
Ethernet	>	DNS	>	Suffix_S - Secondary domain suffix Blank
Ethernet	>	Login	>	Login - Use/Not Not
Ethernet	>	LoginSet	>	Level - Admin/User1 to User6 Admin
Ethernet	>	LoginSet	>	Register - On/Off Admin and User1 

are On
Ethernet	>	LoginSet	>	User - 16 characters or less Admin: admin 

User1 to 6: user1 
to user6

Ethernet	>	LoginSet	>	Password - 4 characters or less Administrator: 0 
User1 to 6: 1 to 6

Ethernet	>	Timeout	>	Timeout - On/Off Off
Ethernet	>	Timeout		>	Duration - 1 to 120 min 1 min
Ethernet	>	K.	Alive	>	Keep	alive - On/Off On
Calibration (/CC1 option)
Calibration	>	CH - 01 to 24 01
Calibration	>	Mode - Revise Value, Abs. Value Revise Value
Calibration	>	Point - 2 to 16 2
Cust.	menu	>	Cust.	menu - Not/Use Not
Cust.	menu	>	Password - Numbers and spaces within 4 digits Blank
Cust.	menu	>	P_Adj - On/Off Off
Select	menu	>	Set	mode	>	Range - On/Off On
Select	menu	>	Set	mode	>	Bias - On/Off On
Select	menu	>	Set	mode	>	Alarm - On/Off On
Select	menu	>	Set	mode	>	Unit - On/Off On
Select	menu	>	Set	mode	>	Chart	speed - On/Off On
Select	menu	>	Set	mode	>	Aux - On/Off On
Select	menu	>	Set	mode	>	Calibration - On/Off On
Select	menu	>	Set	mode	>	Math - On/Off On
Select	menu	>	Set	mode	>	Batch	name - On/Off On
Select	menu	>	Set	mode	>	Batch	detail - On/Off On
Select	menu	>	Function	>	Manual	print - On/Off On
Select	menu	>	Function	>	Setup	list - On/Off On
Select	menu	>	Function	>	Message - On/Off On
Select	menu	>	Function	>	Buffer	clear - On/Off On
Select	menu	>	Function	>	Periodic - On/Off On
Select	menu	>	Function	>	Data	save - On/Off On
Select	menu	>	Function	>	Data	replay Dot Model On/Off On
Select	menu	>	Function	>	SD	eject - On/Off On
Batch (/BT1 option)
Batch	>	Batch - Not/Use Not
Batch	>	Lot	No. - 4/6/Not 4
Batch	>	Dual		comment - Not/Use Not
Batch	>	MSG	format - Not/Use Not
SD memory card (/EM1 option)
Load	param	>	File - Search text -
Load	param	>	Mode - Setup+Set/Setup Setup+Set
Format	>	Label - Up to 11 characters -
Format	>	Execute - Execute Execute

4.3  Menu Structure, Settings, and List of Default Values
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Setup Item Pen/Dot Selectable Range or Selections Default Value
Adjustment
P_Adj	>	P_Adj Dot Model Hysteresis/Zero/Full Hysteresis

Pen Model Zero/Full Zero
P_Adj	>	Pen	No. Pen Model 1/2/3/4 1
Store
End	>	End - Store/Abort Store



Blank
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5.1 Setting the Input Range

Input range is set for each measurement channel. Set unused channels to Skip.
• The input range cannot be changed on models with the computation function (/M1 

option) when computation is in progress.
• If you change the input range, set the bias, alarm, partial expanded recording, and 

calibration correction again.

Procedure
TC, RTD, and DC Voltage

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key with Range shown on the screen.

3. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

4. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

5. Hold down the MENU  key for 3 seconds to return to Operation mode.

  

Select TC, RTD, or Volt.

Set the channel range.

Select the range type.

Select the left span value.

Select the right span value.

The new setting takes effect.
ESC/?

Set=Range

First channel
Last channel

CH=01-01

Mode=TC

Range=R

Span left= 0.0

Span right= 1760.0

01-01 Channel
Setting complete

Chapter 5 Frequently Used Setup Operations (Setting Mode)
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Description
• Selectable Range of Input Range, Span Left, and Span Right
 The input range, span left, and span right can be set in the range shown below. Span 

left and span right cannot be set to the same value.

 DC voltage (Volt)
Range Type Selectable Span Range
20 mV –20.00 to 20.00 mV
60 mV –60.00 to 60.00 mV
200 mV –200.0 to 200.0 mV
2 V –2.000 to 2.000 V
6 V –6.000 to 6.000 V
20 V –20.00 to 20.00 V
50 V –50.00 to 50.00 V

 Thermocouple (TC)
Range Type Selectable Span Range (°C) Selectable Span Range (°F)
R 0.0 to 1760.0°C 32 to 3200°F
S 0.0 to 1760.0°C 32 to 3200°F
B 0.0 to 1820.0°C 32 to 3308°F
K –200.0 to 1370.0°C –328 to 2498°F
E –200.0 to 800.0°C –328.0 to 1472.0°F
J –200.0 to 1100.0°C –328.0 to 2012.0°F
T –200.0 to 400.0°C –328.0 to 752.0°F
N 0.0 to 1300.0°C 32 to 2372°F
W 0.0 to 2315.0°C 32 to 4199°F
L –200.0 to 900.0°C –328.0 to 1652.0°F
U –200.0 to 400.0°C –328.0 to 752.0°F
WRe 0.0 to 2400.0°C 32 to 4352°F

 RTD
Range Type Selectable Span Range (°C) Selectable Span Range (°F)
PT (Pt100) –200.0 to 600.0°C –328.0 to 1112.0°F
JPT (JPt100) –200.0 to 550.0°C –328.0 to 1022.0°F

/N1 Option /N3 Option
Selections Input Type Selections Input Type Note
Cu1 Cu10 (GE) PR PR40-20 Thermo 

coupleCu2 Cu10 (L&N) PLATI PLATINEL
Cu3 Cu10 (WEED) NiMo NiNiMo
Cu4 Cu10 (BAILEY) W/WRe W/WRe26
Cu5 Cu10: a = 0.00392 at 20°C N2 Type N (AWG14)
Cu6 Cu10: a = 0.00393 at 20°C Kp Kp vs Au7Fe
Cu25 Cu25*: a = 0.00425 at 0°C Pt4 Pt25 RTD

Pt3 Pt50
Ni1 Ni100 (SAMA)
Ni2 Ni100 (DIN)
Ni3 Ni120
J263 J263*B
Cu8 Cu53
Cu9 Cu100: a = 0.00425 at 0°C

5.1  Setting the Input Range
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Linear Scaling

  

Select Scale.

Set the channel range.

Select Volt, TC, RTD, or DI.

Select the range type.

Set the left span value.

Set the right span value.

Set the decimal place and left scale 
value.

Set the right scale value.

The new setting takes effect.
ESC/?

Set=Range

CH=01-01

Mode=Scale

Type=Volt

Range=2V

Span left= -2.000

Span right=  2.000

Scale left=   0.00

Scale right= 200.00

01-01 Channel
Setting complete

First channel
Last channel

Description
• Scale Left, Scale Right, and Decimal Place
 Selectable range (mantissa): –20000 to 30000
	 Example:	 	The	value	in	the	range	of	–100.00	to	350.00	cannot	be	specified.	The	

mantissa of scale right is 35000, which exceeds the upper limit of 30000. 
Set in the range of –100.0 to 350.0.

 Decimal place: XXXXX, XXXX.X, XXX.XX, XX.XXX, X.XXXX
	 The	decimal	place	is	the	position	specified	by	scale	left.
 Example: Change 0.00 to 0.0.
     Press the  key to move the cursor to the last digit of 0.00.

         Space
Press the         key to change the value to 0.0  .

Note
The displayable/printable range of scale values is –19999 to 30000 excluding the decimal.

<Related Topics>  Setting the unit: Section 5.3

5.1  Setting the Input Range
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Delta Computation

  

Select Delta.

Set the channel range.

Set the reference channel.

Set the left span value.

Set the right span value.

The new setting takes effect.
ESC/?

Set=Range

CH=02-02

Mode=Delta

Ref.CH=01

Span left= -2.000

Span right=  2.000

02-02 Channel
Setting complete

First channel
Last channel

Description
• Reference Channel
 The reference channel must be a channel that is smaller in channel number than the 

channel being set.
• Span Left and Span Right
 The range type is set to the same type as the reference channel. The span left and 

span right can be set in the range shown below. Span left and span right cannot be 
set to the same value.

Input Type Range Type Selectable Span Range
DC voltage 20 mV –20.00 to 20.00 mV
(Volt) 60 mV –60.00 to 60.00 mV

200 mV –200.0 to 200.0 mV
2 V –2.000 to 2.000 V
6 V –6.000 to 6.000 V
20 V –20.00 to 20.00 V
50 V –50.00 to 50.00 V

Thermocouple R –1760.0 to 1760.0°C –3168 to 3168°F
(TC) S –1760.0 to 1760.0°C –3168 to 3168°F

B –1820.0 to 1820.0°C –3276 to 3276°F
K –1570.0 to 1570.0°C –2826 to 2826°F
E –1000.0 to 1000.0°C –1800 to 1800°F
J –1300.0 to 1300.0°C –1999.9 to 2340.0°F
T –600.0 to 600.0°C –1080.0 to 1080.0°F
N –1300.0 to 1300.0°C –2340 to 2340°F
W –1999.9 to 2315.0°C –4167 to 4167°F
L –1100.0 to 1100.0°C –1980 to 1980°F
U –600.0 to 600.0°C –1080.0 to 1080.0°F
WRe –1999.9 to 2400.0°C –4320 to 4320°F

RTD PT (Pt100) –800.0 to 800.0°C –1440.0 to 1440.0°F
JPT (JPt100) –750.0 to 750.0°C –1350.0 to 1350.0°F

5.1  Setting the Input Range
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ON/OFF Input

  

Select DI.

Set the channel range.

Select Cont or Level.

Set the left span value.

Set the right span value.

The new setting takes effect.

First channel
Last channel

ESC/?

Set=Range

CH=01-01

MOde=DI

Range=Level

Span left=0

Span right=1

01-01 Channel
Setting complete

Description
• Selectable Range Type, Span Left, and Span Right
 The range type, span left, and span right can be set in the range shown below. Span 

left and span right cannot be set to the same value.

Range Type Selectable Span Values
Level 0: Less than 2.4 V, 1: 2.4 V or higher, within ±6 V
Contact 0: Open, 1: Closed

5.1  Setting the Input Range
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1-5V Input

  

Select 1-5V.

Set the channel range.

Set the left span value.

Set the right span value.

Set the decimal place and left scale 
value.

Set the right scale value.

Turn On or Off the low-cut function.

The new setting takes effect.

(Select the right scale value.)

ESC/?

Set=Range

CH=01-01

Mode=1-5V

Span left=  1,000

Span right=  5,000

Scale left=   0.00

Scale right= 200.00

Low-cut=Off

01-01 Channel
Setting complete

First channel
Last channel

Description
• Span Left and Span Right
 Selectable span left range: 0.8 to 1.2 V
 Selectable span right range: 4.8 to 5.2 V

• Scale Left, Scale Right, and Decimal Place
 Selectable range (mantissa): –20000 to 30000
	 Example:	 	The	value	in	the	range	of	–100.00	to	350.00	cannot	be	specified.	The	

mantissa of scale right is 35000, which exceeds the upper limit of 30000. 
Set in the range of –100.0 to 350.0.

 Decimal place: XXXXX, XXXX.X, XXX.XX, XX.XXX, X.XXXX
	 The	decimal	place	is	the	position	specified	by	scale	left.
 Example: Change 0.00 to 0.0.
     Press the  key to move the cursor to the last digit of 0.00.

         Space
Press the         key to change the value to 0.0  .

 Make sure that scale left is less than scale right.

• Low-cut
 On: Cuts values below 0% of the recording span (set to 0% (scale left value)).
	 Off:	Does	not	apply	the	low-cut	function.

<Related Topics>   Setting the unit: Section 5.3 
Enabling the low-cut function: Section 7.15

5.1  Setting the Input Range
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Note
• The displayable/printable range of scale values is –19999 to 30000 excluding the decimal.
• If the leftmost value of the scale is set to –20000 (excluding the decimal), the value when 

the low-cut function is applied is displayed as “–Over.”

Square Root Computation

  

Select SQRT.

Set the channel range.

Select the range type of DC voltage.
20 mV, 60 mV, 200 mV, 2 V, 6 V, 20 V, or 50 V

Set the left span value.

Set the right span value.

Set the decimal place and 
left scale value.

Set the right scale value.

Turn On or Off the low-cut function.
(When low-cut is set to Use)

(When low-cut is On)
Set the low-cut point.
0.0 to 5.0% of the recording span, 0.1 steps.

The new setting takes effect.
ESC/?

Set=Range

CH=01-01

Mode=SQRT

Range=2V

Span left= -2.000

Span right=  2.000

Scale left=   0.00

Scale right= 200.00

Low-cut=Off

Low-cut point=0.0

01-01 Channel
Setting complete

First channel
Last channel

Description
• Input Type in Which Square Root Computation Can Be Performed
 Square root computation can be performed when set to DC voltage input.

• Span Left and Span Right
 Same as the selectable span range of the DC voltage input.
 Make sure that span left is less than span right.

5.1  Setting the Input Range
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• Scale Left, Scale Right, and Decimal Place
 Selectable range (mantissa): –20000 to 30000
	 Example:	 	The	value	in	the	range	of	–100.00	to	350.00	cannot	be	specified.	The	

mantissa of scale right is 35000, which exceeds the upper limit of 30000. 
Set in the range of –100.0 to 350.0.

 Decimal place: XXXXX, XXXX.X, XXX.XX, XX.XXX, X.XXXX
	 The	decimal	place	is	the	position	specified	by	scale	left.
 Example: Change 0.00 to 0.0.
     Press the  key to move the cursor to the last digit of 0.00.

         Space
Press the         key to change the value to 0.0  .

 Make sure that scale left is less than scale right.

• Low-cut and Low-cut Point
 If low-cut is set to On, set the low-cut point.
 Selectable range of the low-cut point: 0.0 to 5.0% of the recording span
 Values below the low-cut point is set to 0% (scale left value) of the recording span.

Note
• The displayable/printable range of scale values is –19999 to 30000 excluding the decimal.
• If the leftmost value of the scale is set to –20000 (excluding the decimal) and the low-cut 

value is set to –20000, the value when the low-cut function is applied is displayed as 
“–Over.”

<Related Topics>   Setting the unit: Section 5.3 
Enabling the low-cut function: Section 7.15

Skip (Unused Channels)

  
Select Skip.

Set the channel range.

The new setting takes effect.

First channel
Last channel

ESC/?

Set=Range

CH=01-01

Mode=Skip

01-01 Channel
Setting complete

Note
Do not use channels set to skip as a reference channel of delta computations or in computing 
equations of the computation function (/M1 option).

5.1  Setting the Input Range
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5.2 Setting the Alarm

The alarm is set for each channel.
If you change the input range, set the alarm again.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Alarm and then press the  
key.

3. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

4. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

5. Hold down the MENU  key for 3 seconds to return to Operation mode.

  

Select the level number between 1 and 4.

Select On to set the alarm.
When set to On, the settings below can be 
entered.

Set the channel range.

Select the alarm type.

Select the value used to turn On the alarm.

Turn relay On when outputting alarms on 
the relay. This setting is valid only on 
models with the /A1, /A2, /A3, /A4, or /A5 
option.
Specify the alarm relay No. 

The new setting takes effect.
ESC/?

Set=Alarm

CH=01-01

Alarm=Off

Type=H

Value=  1.000

Relay=Off

01-01 CH/level 1
Setting complete

First channel
Last channel

Relay number=I01

Level=1
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Explanation
Channel Range
The only case when an alarm can be set on multiple channels simultaneously is when 
the channels are set to the same range type (for example channel 01 and 02 are set to 
2 V range). For channels on which scaling is set, the channels must be set to the same 
range type, same span values, and same scaling values.

Alarm Type
Symbol Name Note
H High limit alarm
L Low limit alarm
h Difference high limit alarm Can be specified on channels set to delta 

computation.
l Difference low limit alarm Can be specified on channels set to delta 

computation.
R High limit on rate-of-change alarm
r Low limit on rate-of-change alarm
T Delay high limit alarm*
t Delay low limit alarm*

* Selectable only when the alarm delay function is enabled. See section 7.15.

Note
On channels set to delta computation, alarms can be detected on the values illustrated in the 
figure below.

   
Input value

Measured value on the reference channel

Alarm on a channel set to delta computation
Alarm
H, L, R, r, T, and t

Alarm
h and l

Measured value
–

If high limit on rate-of-change alarm or low limit on rate-of-change alarm is specified, set 
the interval over which the rate-of-change is calculated.
If delay high limit alarm or delay low limit alarm is specified, set the delay time.

<Related Topics>   Setting the interval of the high limit on rate-of-change alarm or low 
limit on rate-of-change alarm: Section 7.1 
Setting the delay time of delay high limit alarm or delay low limit 
alarm: Section 6.10 
Enabling the alarm delay function: Section 7.15 
Setting the alarm hysteresis: Section 7.1

5.2  Setting the Alarm
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Alarm Value
•  High Limit Alarm/Low Limit Alarm and Delay High Limit Alarm/Delay 

Low Limit Alarm
	 The	following	values	can	be	specified.

• For DC voltage, TC, and RTD input: Values within the measurable range in the 
specified	range	(example:	–2.000	to	2.000	V	for	the	2	V	range).

• For ON/OFF input (DI): 0 or 1.
• For linear scaling (1-5V, scaling, and square root): A value within –5 to 105% of the 

scaling span except within the range of –20000 to 30000 (excluding the decimal 
point).

Note
For channels whose the leftmost value of the scale is set to –20000 (excluding the decimal), 
the alarm value of –20000 is invalid. Set a value that is greater than or equal –19999.

• Difference High Limit Alarm/Difference Low Limit Alarm
	 Values	in	the	measurable	range	can	be	specified.	Measurable	range	refers	to	

“Selectable Span Range” in the table on page 5-4.

• High Limit on Rate-of-Change Alarm/Low Limit on Rate-of-Change Alarm
	 A	value	greater	than	or	equal	to	1	digit	can	be	specified.	For	example,	1	digit	

corresponds 0.001 for the 2 V range (measurable range: –2.000 to 2.000 V). The 
maximum	value	that	can	be	specified	is	the	width	of	the	measurable	range	(4.000	V	
for 2 V range).

	 For	ON/OFF	input,	only	“1”	can	be	specified.

Relay No.
The selectable relay numbers are listed below.
 I01 and I02 on the /A1 option
 I01 to I04 on the /A2 option
 I01 to I06 on the /A3 option
 I01 to I06 and I11 to I16 on the /A4 option
 I01 to I06, I11 to I16, I21 to I26, I31 to I36 on the /A5 option

5.2  Setting the Alarm
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5.3 Setting the Unit on Scaled Channels

Units are set on channels whose input range is set to Scaling, 1-5V, or SQRT.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Unit and then press the  key.

3. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

4. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

5. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the unit.

Set the channel range.

The new setting takes effect.

First channel
Last channel

ESC/?

Set=Unit

CH=01-01

Unit=

01-01 Channel
Setting complete

Explanation
Characters That Can Be Used for Units
A unit is set using up to six characters.
The available characters are as follows:
	 Alphabet,	numbers,	symbols	(%,	#,	°,	@,	+,	–,	*,	/,	(,	),	µ,	Ω,	2, 3, .), and space

<Related Topics>   Entering	the	unit	string:	Page	25	in	the	μR20000	Recorder	Operation	
Guide
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5.4 Changing the Chart Speed

This section explains the details of changing the chart speed.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Chart and then press the  
key.

3. Set the chart speed and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

4. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

5. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the chart speed.

The new setting takes effect.
ESC/?

Set=Chart

mm/h=  25

Chart speed
Setting complete

Explanation

Chart Speed
• Pen Model
 The chart speed can be selected from 82 settings shown below.

Chart speed on the pen model (unit: mm/h)
5 6 8 9 10 12 15 16 18 20

24 25 30 32 36 40 45 48 50 54
60 64 72 75 80 90 96 100 120 125

135 150 160 180 200 225 240 250 270 300
320 360 375 400 450 480 500 540 600 675
720 750 800 900 960 1000 1080 1200 1350 1440

1500 1600 1800 2000 2160 2250 2400 2700 2880 3000
3600 4000 4320 4500 4800 5400 6000 7200 8000 9000

10800 12000

• Dot Model
 The chart speed can be set in the range of 1 to 1500 mm/h in 1 mm steps.
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5.5 Setting the Date/Time

This section explains the details of setting the date/time.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Clock and then press the  
key.

3. Set the date and time and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

4. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

5. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the time.

day
month

year

The new setting takes effect.
ESC/?

Set=Clock

04/02/17 10:39:47

Clock
Setting complete

Explanation
Date/Time
The year is set with the lower two digits.
Values in the range 80 and 99 correspond to 1980 to 1999.
The values that can be entered are as follows. Entering a value outside this range or an 
invalid date results in an error, and the date and time do not change.
Month: 01 to 12, Day: 01 to 31, Hour: 00 to 23, Minute: 00 to 59, Second: 00 to 59

<Related Topics>  Changing the printout/display format of the date: Section 7.19
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6.1 Setting the Trend Recording Interval (Dot 
Model)

This section explains the details of setting the trend recording interval (dot printing 
interval) on the dot model.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Trend and then press the  key.

4. Set the dot printing interval and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Select the trend recording interval 
mode.

The new setting takes effect.
ESC/?

Set=Aux

Aux=Trend

Mode=Auto

Trend Interval
Setting complete

Explanation
Mode
Auto: The trend recording interval is set according to the chart speed in the range of 

10 s to 90 s so that the dots do not overlap many times.. The interval is displayed 
on the System display (see page 12-9).

Fix: The trend recording interval varies depending on the number of channels 
being recorded (see the table below). On models with the computation function 
(/M1 option), the trend recording interval varies depending on the number of 
measurement and computation channels to be trend recorded.

Number of channels to be recorded Trend recording interval
6 or less 10 s
7 to 12 15 s
13 to 18 20 s
19 to 24 30 s
25 to 48 60 s

  

When set to Auto When set to Fix
Dot

The distance between dots printed on the chart 
paper varies depending on the chart speed. 

Chapter 6 Setup Operations for Convenient Functions (Setting Mode)
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Example of calculating the dot printing interval when the trend recording 
interval is set to auto

μR20000		24-dot	model
A/D integrate: Auto
Chart speed: 23 mm/h
Number of recording channels: 24 channels

Scan interval = 2.5 s
A value that is less than or equal to 900 ÷ chart speed and that is the largest integer 
multiple of the scan interval = 37.5 s
Because this 37.5 s is within the range of the fastest (= 30 s) to 90 s, recording interval = 
37.5 s

6.1  Setting the Trend Recording Interval (Dot Model)
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6.2 Setting the Filter (Pen Model)

This section explains the details of setting a filter on the measurement channels on the 
pen model.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Filter and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the channel range.

Set the filter time constant.

The new setting takes effect.
ESC/?

First channel
Last channel

Set=Aux

Aux=Filter

CH=01-01

Response Time=Off

01-01 Channel
Setting complete

Explanation
Filter Time Constant
The time constant is selectable from 2 s, 5 s, and 10 s. Select Off when not using the 
filter.

<Related Topics>		Enabling	the	filter	function:	Section	7.12
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6.3 Setting the Moving Average (Dot Model)

This section explains the details of setting the moving average function on measurement 
channels on the dot model.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Moving_AVE and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the channel range.

Set the number of samples of the moving 
average. Moving average is not 
performed when Off is selected.

The new setting takes effect.
ESC/?

First channel
Last channel

Set=Aux

Aux=Moving_AVE

CH=01-01

Number of samples=Off

01-01 Channel
Setting complete

Explanation
The Number of Samples of Moving Average
The number of samples can be set to a integer between 2 and 16. Select Off when not 
using the moving average function.

<Related Topics>  Enabling the moving average function: Section 7.11
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6.4 Setting Recording Zones for Each Channel 
(Zone Recording)

This section explains the details of setting the recording zone for each measurement 
channel.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Zone and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  

Set the channel range.

Set the leftmost value of the recording 
zone.

Set the rightmost value of the recording 
zone.

The new setting takes effect.

First channel
Last channel

ESC/?

Set=Aux

Aux=Zone

CH=01-01

Left= 0

Right=180

01-01 Channel
Setting complete

Explanation
Zone
The recording zone can be set in the following range.
Leftmost position: 0 mm to 175 mm
Rightmost position: 5 mm to 180 mm
Set a larger value for the rightmost position than the leftmost position.
Set at least 5 mm for the zone width.

Note
If the zone is set to a value less than 40 mm, scale printout of periodic printout cannot be 
executed.
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6.5 Setting the Partial Expanded Recording

This section explains the details of expanding a section of the recording range.
If you change the input range, set the partial expanded recording again.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Partial and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  

Set the channel range.

Select On to use the partial expanded 
recording function.

Set the boundary position as a 
percentage where the recording span is 
assumed to be 100%.

Set the boundary value within the 
recording span.

The new setting takes effect.
ESC/?

First channel
Last channel

Set=Aux

Aux=Partial

CH=01-01

Partial=Off

Expand=50

Boundary=  0.000

01-01 Channel
Setting complete

Explanation
Expand
Set a value between 1 and 99%. One percent corresponds to 1.8 mm, because the 
record width is 180 mm.
Example: To record 0 to 8 V in the 0 to 50% position and 8 to 10 V in the 50 to 100% 

position with a span of 0 to 10 V, set the boundary position to 50% and the 
boundary value to 8.00 V.

<Related Topics>   Enabling the partial expanded recording function: Section 7.13
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6.6 Turning Trend Recording (Dot Model) and 
Periodic Printout ON/OFF for Each Channel

This section explains the details of setting the trend recording and periodic printout for 
each measurement channel.
The following settings can be entered for each channel.
• Turn trend recording ON/OFF (dot model only).
• Turn the printing of measured values ON/OFF during periodic printout.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Print out and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  

Set the channel range.

Turn trend recording On/Off.

Select whether to print the measured 
values during periodic printout (On/Off).

The new setting takes effect.
ESC/?

Last channelFirst channel
(Dot model)

Set=Aux

Aux=Print out

CH=01-01

Trend=On

Periodic=On

01-01 Channel
Setting complete

Explanation
Trend Recording (Dot Model)
On: Turns On the trend recording of the specified channel.

Periodic Printout
On: Prints the measured values (instantaneous values or report data) of the specified 

channel during periodic printout.
Off: Does not print the channels and measured values during periodic printout.
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6.7 Setting Tags on Channels

This section explains the details of setting tags to measurement channels.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Tag and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the channel range.

Set the tag.

The new setting takes effect.
ESC/?

First channel
Last channel

Set=Aux

Aux=Tag

CH=01-01

Tag=

01-01 Channel
Setting complete

Explanation
Characters That Can Be Used for Tags
Set the tag using up to 7 characters.
The available characters are as follows:
	 Alphabet,	numbers,	symbols	(%,	#,	°,	@,	+,	–,	*,	/,	(,	),	µ,	Ω,	2, 3, .), and space

<Related Topics>   Printing tags in place of channel numbers: Section 7.7 
Displaying tags in place of channel numbers: Section 8.2
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6.8 Setting the Message String

This section explains the details of setting the message strings to be printed on the chart 
paper. Up to five message strings can be registered.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Message and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Select the message No.

Set message string.

The new setting takes effect.
ESC/?

Set=Aux

Aux=Message

Message number=1

CHR:A-Z

Message 1
Setting complete

Explanation
Characters That Can Be Used for Messages
Set the message using up to 16 characters.
The available characters are as follows:
	 Alphabet,	numbers,	symbols	(%,	#,	°,	@,	+,	–,	*,	/,	(,	),	µ,	Ω,	2, 3, .), and space

<Related Topics>  Printing messages: Section 3.10
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6.9 Setting the Secondary Chart Speed (Remote 
Control Function, /R1)

This section explains the details of setting the secondary chart speed when the chart 
speed is to be switched using the remote control function (/R1 option).

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Chart2 and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the chart speed.

The new setting takes effect.
ESC/?

Set=Aux

Aux=Chart2

mm/h=  25

Chart speed2
Setting complete

Explanation
Chart Speed
See section 5.4.

<Related Topics>  Setting the remote control function: Section 7.18
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6.10 Setting the Alarm Delay Duration

This section explains the details of setting the duration of the delay alarm.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Alarm delay time and then 
press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the channel range.

Set the alarm delay time.

The new setting takes effect.
ESC/?

First channel
Last channel

Set=Aux

Aux=Alarm delay time

CH=01-01

Duration=  10

01-01 Channel
Setting complete

Explanation
Duration
The duration can be set to a value in the range of 1 to 3600 s.
However, the alarm delay time is an integer multiple of the scan interval. For example,  if 
the scan interval on the dot model is 2.5 s, the actual duration is an integer multiple of 2.5 s. 
If the set value is not equal to an integer multiple of 2.5 s, the duration is the smallest 
integer multiple of 2.5 s greater than the set value.
Example: The actual duration for 1 s and 2 s is 2.5 s.

<Related Topics>  Enabling the alarm delay function: Section 7.15
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6.11 Setting the Brightness of the Display and 
Internal Light

This section explains the details of setting the brightness of the display and the internal 
light.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select Brightness and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Select the brightness of the display.

Select the brightness of the internal light.

The new setting takes effect.
ESC/?

Set=Aux

Aux=Brightness

Display=4

Light=Off

Brightness
Setting complete

Explanation
Display Brightness
The brightness can be set to an integer between 1 and 8. The darkest setting is 1; the 
brightest setting is 8.

Internal Light Brightness
The brightness of the internal light can be set to an integer between 1 and 4. The darkest 
setting is 1; the brightest setting is 4. Select Off to turn Off the internal light.
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6.12 Applying a Bias on the Measuring Input Signal

This section explains the details of setting a bias on the measuring input signal.
If you change the input range, set the bias again.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Bias and then press the  key.

3. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

4. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

5. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Select whether to use the bias.

Set the bias value.

Set the channel range.

The new setting takes effect.

First channel
Last channel

ESC/?

(When bias is On)

Set=Bias

CH=01-01

Bias=Off

Bias=  0.000

01-01 Channel
Setting complete

Explanation
Channel Range
The only case when a bias can be set on multiple channels simultaneously is when the 
channels are set to the same range type (for example channel 01 and 02 are set to 2 V 
range). For channels on which scaling is set, the channels must be set to the same range 
type, same span values, and same scaling values.

Bias
The range of bias that can be specified is ±10% of the span of the measurable range at 
the specified range type. For example, the range is –0.4 V to 0.4 V for the range type 2 V.
For channels on which scaling is set, the range is ±10% of the scaling span.

Note
A bias cannot be set on channels set to ON/OFF input (DI).

<Related Topics>  Enabling the bias function: Section 7.15
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6.13 Performing Calibration Correction (/CC1 
Option)

The values of the measuring input signal are corrected using specified segments, and 
the results are used as measured values.
If you change the input range, set the correction point (measured value) and correction 
values again.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Calibration and then press the 
 key.

3. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

4. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

5. Hold down the MENU  key for 3 seconds to return to Operation mode.

  

Set=Calibration

CH=01

01CH Calibration
Setting complete

Turn On or Off the calibration correction.

Set the first correction point 
(input value).

Select the channel.

(Displays the following when
 Calibration is On)

The new setting takes effect.

Yes: The setting is fixed.
No: The setting becomes invalid.

ESC/?

Calibration=On

1 datums=  0.000

Decision=Yes

Set the first correction value.

Likewise, set the second correction point 
and correction value.

·
·
·

1 revise=  0.000
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Explanation
Setting Correction Points (Measured Values) and Correction Values
• Using revise values

   

Calibration point

B4

A3

A2A1

A4

B3
B2

B1

Scale value
Correction 
value

Measured 
value Correction using revise values

Correction point (measured value) = A
Correction value = B – A

• Using absolute values

   

Calibration point

B4

A3

A2A1

A4

B3
B2

B1

Scale value
Correction 
value

Measured 
value Correction using absolute values

Correction point (measured value) = A
Correction value = B

 Example of a two-point correction

Calibration 
Point

Corrected 
Value

Measured 
value (A)

Correction Value
Revise Value 

(B – A)
Absolute 
Value (B)

1 10.0°C 9.8°C 0.2°C 10.0°C
2 90.0°C 90.5°C – 0.5°C 90.0°C

Setup Conditions of Measured and Correction Values
• Setting range of measured and correction values when using revise values
	 A1	<	A2	≤	A3	≤	...	≤	A16
 (A1 + B1) < (A2 + B2) < (A3 + B3) < ... < (A16 + B16)
 A and B are within the measurable range or scaling range of the range type*

* Within the scaling range:  –5% to 105% of the scale value or –20000 to 30000 (the decimal 
place is the same as the setting for the scale value)

• Setting range of measured and correction values when using absolute values
	 A1	<	A2	≤	A3	≤	...	≤	A16
 B1 < B2 < B3 < ... < B16
 A and B are within the measurable range or scaling range of the range type*

* Within the scaling range:  –5% to 105% of the scale value or –20000 to 30000 (the decimal 
place is the same as the setting for the scale value)

Note
• Make sure that the leftmost value is less than the rightmost value for span and scale.
• Calibration correction cannot be set on ON/OFF input (DI), delta computation, and square 

root computation channels. In addition, calibration correction cannot be used on all channels 
if the bias function is enabled.

<Related Topics>   Enabling the calibration correction function: Section 7.15 
Setting the calibration correction function: Section 7.23

6.13  Performing Calibration Correction (/CC1 Option)
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6.14 Setting Up Start Printout and End printout 
(/BT1 Option)

Enter settings for Start printout/Start printout 2 when starting recording, and for End 
printout/End printout 2 when stopping recording.
You cannot enter Basic Setting mode during the time between start printout to end 
printout.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Batch and then press the  
key.

3. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

4. When the Setting complete screen appears, do either of the following:
To correct the setting the  key.
If you are done, press the ESC key.

5. Hold down the MENU  key for 3 seconds to return to Operation mode.

Setting the Batch Number

  

Set=Batch

No.=

Batch No.
Setting complete

Set the batch number. 

Select Batch No.

The new setting takes effect.

Batch=Batch No.

ESC/?

Setting the Lot Number

  

Set=Batch

Lot No.=     0

Batch Lot No.
Setting complete

Set the lot number. 

The new setting takes effect.

Batch=Lot No.

ESC/?

(When the Lot No. in Basic Setting 
mode is 4 or 6)

Select Lot No.
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Setting Comments

  

Set=Batch

Mode=Start

Detail=Comment

Line No.=1

Comment=

Line 1
Setting complete

Select Start, End, Start2, or End2.

Select Comment.

Select Line No.

Set comment string.

The new setting takes effect.

Batch=Detail

ESC/?

Select Detail.

Selecting Printout On/Off for the Batch Name, Chart Speed, and Date/Time.

  

Set=Batch

Mode=Start

Detail=Print

Batch Name=On

Chart Speed=On

Batch Print
Setting complete

Select Start, End, Start2, or End2.

Select Print.

Select whether to printout batch 
number and lot number. Select On or 
Off

Select whether to printout chart speed. 
Select On or Off.

The new setting takes effect.

Batch=Detail

Clock=On Select whether to printout date/time. 
Select On or Off.

ESC/?

Select Detail.

6.14  Setting Up Start Printout and End printout (/BT1 Option)
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Setting the Feed Amount, Lot Number Update, and Ejection of Pen Offset 
Compensating Data

  

Set=Batch

Mode=Start

Detail=Action

Feed= 0

Auto inc.=On

(Only when the Mode is End or End 2 
and the lot number is 4 or 6 digits)

(Only when the Mode is End or End 2 
and pen model offset compensation is On)

(Only when POC output is On)

Batch action
Setting complete

Select Start, End, Start2, or End2.

Select Action.

Set the chart paper feed amount before 
Start printout and after End printout.

Select whether to update (+1) lot number 
when recording stops. Select On or Off.

The new setting takes effect.

Batch=Detail

POC output=On Select whether to eject the pen offset 
compensating data when recording 
stops. Select On or Off.

POC speed=C.Speed Select the chart speed when ejecting the 
pen offset compensating data.

ESC/?

Select Detail.

Explanation
Batch No.
You can enter up to 26 characters.
The following are the characters that can be used.
	 Alphabet,	numbers,	symbols	(%,	#,	°,	@,	+,	–,	*,	/,	(,	),	µ,	Ω,	2, 3, .), and space

Lot No.
Enter using a 4 or 6 digit number. Select which number of digits to use (4 or 6) under  
“Lot No.” in Basic Setting mode.

Mode
Select Start, End, Start 2, or End 2. Start 2 and End 2 become available when you 
enable “Dual comment” in Basic Setting mode.

Line No.
1 to 5 lines can be printed out.

Comment
You can enter up to 64 characters. 
The following are the characters that can be used. 
	 Alphabet,	numbers,	symbols	(%,	#,	°,	@,	+,	–,	*,	/,	(,	),	µ,	Ω,	2, 3, .), and space

6.14  Setting Up Start Printout and End printout (/BT1 Option)
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Feed
The available setting range is 0 to 50 mm.

POC output
You can eject the portion that is not recorded when recording stops with the pen offset 
compensating recording function. 

POC speed
Select the chart speed when ejecting the portion that was not recorded. 
Chart speed: Feeds at the specified chart speed.
450mm/h: Fixed to feed at 450 mm/h. 

Note 
The following operations are performed when using the header printout function (/BT1 option).
• When the power is interrupted and is reintroduced, recording always stops. End 

printout/End printout 2 is not performed.
• When recording stop detection is performed (option /F1), recording and printout stop.
 When chart paper is inserted, the instrument operates as follows.

• When detected during Start printout and recording: Recording starts after Start printout.
• When detected during End printout: When stopped, End printout/End printout 2 is not 

performed.
• Until Start printout/Start printout 2 and End printout/End printout 2 finishes, the instrument 

cannot transition to the next operation.
• When recording is started, the alarm and message printout information stored in the buffer 

prior to recording stop is cleared.

<Related Topics>   Enabling the batch function: Section 7.24 
Setting the number of digits of the lot number and enabling start 
printout 2 and end printout 2: Section 7.24

6.14  Setting Up Start Printout and End printout (/BT1 Option)
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6.15 Setting the Message Format (/BT1 Option)

In the 5 message printouts, up to 69 characters can be printed out including the date/time 
and measured values.*
• Under Message format, you can specify the printout contents of date/time, message 

string, measured values,* and the order of these.
• Messages including measured values* can be printed out even when Start printout or 

End printout is disabled.
• For entering message strings, see section 6.8.

* Computed values can also be included on models with the /M1 option.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Batch and then press the  
key.

3. Press the  key or SHIFT +  key to select MSG format and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting the  key.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

Entering message format

  

Set=Batch

Message1 format
Setting complete

Select message number.

The new setting takes effect.

Batch=MSG format

47:H:M L16 Set the message format.

ESC/?

Remaining number of characters 
that can be printed out.

String entered for the message

Message No.=1
Process-1

Explanation
Message No.
Select from 1 to 5.
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MSG format
Choose a message format. Measured values,* message strings, and date/time can be 
set arbitrarily.

  

47:H:M L16
CHR:Date/Time CHR:01...

CHR:0A...
CHR:L01...
CHR:Date/Time
:

Measured value
Computed value (/M1 option)
Message string (number of characters)
Date/Time

Comment

CHARACTER key

Example: Based on the message 1 string of the standard function, you can set a 
combination with message format 1 and print it out as message 1 including 
measured values.*

  
10th and 11th character of the 
message string (9 characters 
already used, so this represents 
the next characters)

Standard function 
Message 1 string: Process-1°C

Message 1 printout result: 06/30  10:10  Process-1  134.8°C

Message format 1: M/D H:M L09 01L02

Measured value on CH1 (no units)

Space (number of characters: 1)

Space
1-9th characters of the message string

Date/time
* Computed values can also be included on models with the /M1 option.

• Date/Time Format and Number of Characters Used
H:M (Hour:Minute) 5 characters
H:M:S (Hour:Minute:Second) 8 characters
M/D H:M (Month/Day Hour:Minute) 11 characters
M/D H:M:S (Month/Day Hour:Minute:Second) 14 characters
D/M H:M (Day/Month Hour:Minute) 11 characters
D/M H:M:S (Day/Month Hour:Minute:Second) 14 characters
D.M H:M (Day.Month Hour:Minute) 11 characters
D.M H:M:S (Day.Month Hour:Minute:Second) 14 characters
M.D H:M (Month.Day Hour:Minute) 12 characters
M.D H:M:S (Month.Day Hour:Minute:Second) 15 characters
Y/M/D H:M:S (Year/Month/Day Hour:Minute:Second) 19 characters
M/D/Y H:M:S (Month/Day/Year Hour:Minute:Second) 19 characters
D/M/Y H:M:S (Day/Month/Year Hour:Minute:Second) 19 characters
D.M.Y H:M:S (Day.Month.Year Hour:Minute:Second) 19 characters
M.D.Y H:M:S (Month.Day.Year Hour:Minute:Second) 20 characters

•  Format of Measured Values and Computed Values, and Number of Characters Used
• The format for measured values is 01, 02, ...24 (depending on the model). No units 

are added. 7 characters are used.
• The format for computed (/M1 option) values is: 0A, 0B, 0C, 0D, 0E, 0F, 0G, 0J, 0K, 

0M, 0N, 0P, 1A, 1B, 1C, 1D, 1E, 1F, 0G, 1J, 1K, 1M, 1N, and 1P (depending on the 
model). No units are added. 9 characters are used.

• Character String Format
 The format for message strings is L01 (1 character), L02 (2 characters), .... L16 (16 

characters).
 In	the	example	above,	L09	specifies	“Process-1”	and	L02	specifies	“°C	.”

<Related Topics>  Enabling the message format: Section 7.24

6.15  Setting the Message Format (/BT1 Option)
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6.16 Setting the Date/Time When Switching between 
Standard Time and DST

This section explains the details of setting the date/time when switching from the 
standard time to DST and the date/time when switching back from DST to standard time 
if the recorder is used in a region that has DST. When the preset date/time arrives, the 
recorder internal clock automatically switches.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Aux and then press the  key.

3. Press the  key or SHIFT +  key to select DST and then press the  key.

4. Set each item and press the  key.
Press the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.
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ESC/?

Select Use.

Month, day of the week, and time when 
the DST starts. 
 Month

 The n the day of the week of 
 the month

Time

The new setting takes effect.

Set=Aux

Aux=DST

DST=Use

Start month=Apr

Start day=1st-Sun

Start day=1st-Sun

Start time=2:00

End month=Oct

End day=Last-Mon

End day=Last-Mon

End time=1:00

DST
Setting complete

Month, day of the week, and time when 
the DST ends. 
 Month

 The n the day of the week of 
 the month

Time

(Displays the following when the
 DST is set to Use)

Explanation
DST
Select Use to use DST.

Start month, Start day, and Start time
Set the date/time for switching from standard time to DST. Specify the day as the n th 
day of the week of the month.

End month, End day, and End time
Set the date/time for switching from DST to standard time. Specify the day as the n th 
day of the week of the month.

6.16  Setting the Date/Time When Switching between Standard Time and DST
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7.1 Changing the Auxiliary Alarm Function

This section explains the details of setting the alarm system items listed below.
• Diagnosis output using the alarm output relay (I01)
•	 Reflash	alarm	operation	of	the	alarm	output	relay	(I01	to	I03)
• AND/OR operation of alarm output relays
• Energized/De-energized operation of alarm output relays when alarms occur
• Hold/Non-hold operation of alarm output relays
• Hold/Non-hold operation of alarm indications
• The interval of the rate-of-change alarm
• Alarm hysteresis

Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key with Alarm shown on the screen.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

Chapter 7 Setup Operations for Changing/Adding Functions (Basic Setting Mode)
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Select On to set relays I01, I02, and I03 
to reflash alarm operation.

Select On to set relay I01 to diagnosis 
output.

Select the range of relays that are to 
operate using AND logic.

Select the relay’s energized or 
de-energized operation.

Select the relay’s hold or non-hold 
operation.

Select the relay’s hold or non-hold 
operation.

Set the interval of the high limit on 
rate-of-change alarm.

Set the interval of the low limit on 
rate-of-change alarm.

Set the hysteresis of the measurement 
channels.

Set the hysteresis of the computation 
channels.

The new setting takes effect.

(models with /M1)

ESC/?

Basic=Alarm

Diagnosis=Off

Reflash=Off

AND=None

Act=Energize

Behavior=Nonhold

Indicator=Nonhold

Increase=01

Decrease=01

Hysteresis=0.5%

Math hysteresis=0.0%

Alarm
Setting complete

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Diagnosis
When set to On, alarm output relay I01 becomes a dedicated diagnosis output relay, and 
the operation is fixed to OR, de-energized, and non-hold. Diagnosis output is a function 
which outputs a relay signal when there is an error in the plotter operation on the pen 
model, when a burnout is detected, or when there is an error in the A/D converter.

7.1  Changing the Auxiliary Alarm Function
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Reflash
Turns On/Off the reflash alarm operation of alarm output relays I01, I02, and I03.
When set to On, alarm output relays I01, I02, and I03 set to reflash alarm operation, and 
the operation is fixed to OR, de-energized, and non-hold.

AND
Sets the AND/OR operation of alarm output relays.
None: No relays are set to AND operation. All relays are set to OR operation.
I01: Only I01 is set to AND operation.
I01-I** (where ** is the relay number): AND operation for I01-I**.

Act
Sets whether the output relay is energized or de-energized when an alarm occurs.
Energize:   Energizes the relay when an alarm occurs. The relay is de-energized 

during normal operation.
De_energize:  De-energizes the relay when an alarm occurs. The relay is energized 

during normal operation.

Behavior
Specifies whether to set the alarm output relay to hold operation or non-hold operation.
Nonhold:  Releases the relay output at the same time the alarm is released.
Hold:    Holds the relay output until the alarm ACK operation is executed.

Indicator
Specifies whether to set the alarm indication to hold operation or non-hold operation.
Nonhold:  Releases the alarm indication at the same time the alarm is released.
Hold:    Holds the alarm indication until the alarm ACK operation is executed.

Increase
Set the interval of the high limit on rate-of-change alarm to an integer between 1 and 15.
The interval is set to scan interval × (1 to 15).
Pen model: The scan interval is 125 ms. The maximum interval is 1.875 s.
Dot model:   The maximum intervals is 15 s, 37.5 s, 75 s, and 150 s when the scan 

intervals is 1 s, 2.5 s, 5 s, and 10 s, respectively.

Decrease
Set the interval of the low limit on rate-of-change alarm to an integer between 1 and 15. 
The setup procedure is the same as Increase.

Hysteresis
Sets the alarm hysteresis of the measurement channels.
The hysteresis width can be set in the range of 0.0% (Off) to 1.0% of the recording span 
in 0.1 steps.
The hysteresis applies to all high limit and low limit alarms of measurement channels.

Math hysteresis (Models with the Computation Function (/M1 Option))
Sets the alarm hysteresis of the computation channels.
The hysteresis width can be set in the range of 0.0% (Off) to 1.0% of the recording span 
in 0.1 steps.
The hysteresis applies to all high limit and low limit alarms of computation channels.

7.1  Changing the Auxiliary Alarm Function
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7.2 Changing the Integration Time of the A/D 
Converter

This section explains the details of setting the integration time of the A/D converter.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select A/D and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Select the integration time of the 
A/D converter.

The new setting takes effect.
ESC/?

A/D Integrate
Setting complete

Basic=A/D

Integrate=Auto

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Integrate
Selects the integration time of the A/D converter.
Setting Integration Time Scan Interval

Pen Model Dot Model
6-dot 12-dot 18, 24-dot

50 Hz 20 ms 125 ms 1 s 2.5 s 2.5 s
60 Hz 16.7 ms 125 ms 1 s 2.5 s 2.5 s
Auto 20 ms or 16.7ms2, 3 125 ms 1 s 2.5 s 2.5 s
100 ms1 100 ms – 2.5 s 5 s 10 s
1: Selectable only on the dot model.
2: Automatically switch by detecting the power supply frequency.
3:  The integration time is fixed to 20 ms if “Auto” is selected when using the DC power supply on a 

model with the /P1 option.
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7.3 Setting the Burnout Detection Function of 
Thermocouples

This section explains the details of setting the burnout detection function of 
thermocouples to channels set to 1-5V or TC input.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Burnout and then press the  
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

  

Set the channel range.

The new setting takes effect.

Select the recording operation that is 
carried out when a burnout is detected.

ESC/?

First channel
Last channel

01-01 Channel
Setting complete

Basic=Burnout

CH=01-01

Burnout=Off

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Burnout
Selects the action taken when a burnout is detected at the 1-5V input or the 
thermocouple input.
Up:  Records off the scale on the 100% side.
Down: Records off the scale on the 0% side.
Select Off when not using the burnout detection function.
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7.4 Setting the RJC Function on Channels Set to 
TC Input

This section explains the details of setting RJC on channels set to TC input.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select RJC and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

  

Set the channel range.

Select the RJC mode of the 
thermocouple input.

Set the compensation voltage when 
using the external RJC function.

The new setting takes effect.
ESC/?

First channel
Last channel

(When RJC is set to External)

01-01 Channel
Setting complete

Basic=RJC

CH=01-01

RJC=Internal

Volt=     0 

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Explanation
RJC
Sets the RJC mode.
Internal:  Uses the RJC function on the recorder.
External:  Uses an external RJC function. If external is selected, set the compensation 

voltage.

Volt
Sets the compensation voltage when using an external RJC function.
The compensation voltage can be set in the range of –20000 µV to 20000 µV.

7.4  Setting the RJC Function on Channels Set to TC Input
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7.5 Changing the Channel Recording Color (Dot 
Model)

This section explains the details of changing the trend recording color on the dot model.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Color and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

  

Select the channel.

Select the recording color.

The new setting takes effect.
ESC/?

01 Channel Color
Setting complete

Basic=Color

Channel=01

Color=Purple

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Color
Sets the recording color of measurement channels.
By default, the recording colors are set as follows:
Channels 01, 07, 13, and 19: Purple
Channels 02, 08, 14, and 20: Red
Channels 03, 09, 15, and 21: Green
Channels 04, 10, 16, and 22: Blue
Channels 05, 11, 17, and 23: Brown
Channels 06, 12, 18, and 24: Black
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7.6 Recording by Compensating for the Pen Offset 
along the Time Axis (Pen Model)

This section explains the details of setting the compensation for the pen offset along the 
time axis (pen model).
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select POC and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Select On to record by compensating 
for the pen offset along the time axis.

The new setting takes effect.
ESC/?

POC
Setting complete

POC=Off

Basic=POC

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
POC (Pen Offset Compensation)
On: Enables pen offset compensation.
Off: Disables pen offset compensation.

Note
When pen offset compensation is enabled, all pens are aligned with the reference pen (pen that 
is furthest to the back: pen 2 on the 2-pen model, pen 3 on the 3-pen model, and pen 4 on the 
4-pen model) for recording. When recording is started, only the reference pen moves until the 
offset is compensated. This is not a malfunction.
When pen offset compensation is enabled, an asterisk is printed by the time on the periodic 
printout.
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7.7 Turning Printouts ON/OFF
 (Selecting the Channel/Tag Printout and Turning ON/OFF the Channel No., 

Alarm, Recording Start, New Chart Speed, Scale, and Pen Color Printouts)
This section explains the details of turning ON/OFF the printouts of various items.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Print and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  

Select whether to print the channel 
number  beside the trend recording.

Select whether to use the channel 
number or tags for the printout.

Select whether to print the alarm 
occurrence/release.

Select On to enable recording start 
printout.

Select On to print when the chart
speed is changed.

Select On to print the channel scale in 
periodic printout.

Select On to print the pen color in 
periodic printout.

The new setting takes effect.
ESC/?

(Dot model)

(Pen model)

Printout
Setting complete

Basic=Print

CH/Tag=Channel

Alarm=On1

Channel=On

Record On=Off

Chart speed=On

Scale=On

Pen color=On
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Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
CH/Tag
Channel: Prints the channel number.
Tag: Prints the tag.

Channel (Dot Model)
When On is selected channel number or tag is printed by the trend recording.

Alarm
On1:  Prints the alarm information when an alarm occurs or releases.
On2:  Prints the alarm information only when an alarm occurs.
Off:  Does not print alarm information.

Pen Color Printout (Pen Model)
When On is selected, the recording color of the channel whose scale is printed is printed. 
This is valid when scale printout is turned On.

Note
Channel, alarm, recording start, and new chart speed printouts are not performed when the 
chart speed is greater than or equal to 1600 mm/h on the pen model, greater than or equal to 
101 mm/h on the 6-dot or 12-dot model, and greater than or equal to 51 mm/h on the 18-dot or 
24-dot model.

7.7  Turning Printouts ON/OFF 
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7.8 Setting the Periodic Printout Interval and the 
Type of Data to Be Printed

This section explains the details of setting the periodic printout interval and the type of 
data to be printed.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Periodic Printout Interval and Type of Data to Be Printed

Changing the Settings
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Print1 and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  (When Period is set to Manual)

Set the reference time.

Select the periodic printout interval mode.

Select the periodic printout interval.

Set the type of data to be printed to 
instantaneous value or report.
Select Off to disable periodic printout.

The new setting takes effect.
ESC/?

Printout1
Setting complete

Basic=Print1

Periodic=Auto

Ref.Time=00:00

Interval=1h

Mode=Inst

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Types of Report Data to Be Printed
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Print2 and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

  
Select the type of report data to print.

Set the channel range.

Select the sum scale.

The new setting takes effect.
ESC/?

First channel
Last channel

Printout2
Setting complete

Basic=Print2

CH=01-01

Mode=AVE

SUM scale=Off

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

7.8  Setting the Periodic Printout Interval and the Type of Data to Be Printed
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Explanation
Periodic Printout Interval and Type of Data to Be Printed

Periodic
Select the periodic printout interval mode.
Auto:   Automatically sets the printout interval in sync with the chart speed.
Manual:  Set the printout interval manually.

Ref. Time
Sets the reference time for determining the times for executing the periodic printout.
The reference time is set in the range of 00 to 23 in 1 hour steps. Minutes cannot be 
specified.

Interval
Select the interval from 10, 12, 15, 20, 30 minutes, 1, 2, 3, 4, 6, 8, 12, and 24 hours. 
However, printout might not take place at the specified interval depending on the chart 
speed and items printed (for details, see appendix 2).

Mode
Sets the type of measured values to be printed.
Inst:   Prints the measured value or computed value (/M1 option) at that point.
Report:   Prints the report over the interval. If Report is selected, set the types of report 

data to be printed as described in “Types of Report Data to Be Printed” below 
(computation channels are set in section 9.15).

Off:   Disables periodic printout.

Types of Report Data to Be Printed
Mode
Sets the type of report data to be printed.
AVE:  Prints the average value over the interval.
MIX:  Prints the minimum, maximum, and average values over the interval.
SUM:  Prints the sum value over the interval. If SUM is selected, set the sum scale.
MIN:  Prints the minimum value over the interval.
MAX:  Prints the maximum value over the interval.
INST:  Prints the instantaneous value.

SUM scale
Set this item only when SUM is selected.
SUM sums the data every computation interval. For flow values that have units /s, /min, 
or /h, a simple summation results in the actual value not matching the computed result, 
because the scan interval and the unit of the input values are different. In such cases, set 
the sum scale to match the unit of the input value. In effect, the sum value with the same 
unit as that of the input value is calculated.
For example, if the scan interval is 1 s, and the input value is 100 m3/min, a simple 
summation would add 100 every 1 s resulting in 6000 after one minute. However, if the 
sum scale is set to /min, then 1 s/60 s is multiplied every scan interval before the value is 
added giving a result with an m3/min unit.
Off:  Simply sums the measured values.
/s:   Sums by converting the measured values to a value over 1 second.
/min:  Sums by converting the measured values to a value over 1 minute.
/h:   Sums by converting the measured values to a value over 1 hour.
/day:  Sums by converting the measured values to a value over 1 day.

7.8  Setting the Periodic Printout Interval and the Type of Data to Be Printed
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7.9 Setting the Bar Graph Display Mode

This section explains the details of setting the bar graph display mode.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Bar graph and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

  

Set the channel range.

Select the display mode of the bar graph.

The new setting takes effect.
ESC/?

First channel
Last channel

01-01 Channel
Setting complete

Basic=Bar graph

Graph=Normal

CH=01-01

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Graph
Normal:   Sets the base point of the bar graph to the left or right of the recording span 

whichever is smaller in value.
Center:   Sets the base point of the bar graph to the 50% position of the recording 

span.

  Normal

Starting point of the bar graph

Starting point of the bar graph

Center
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7.10 Setting the Key Lock Function

This section explains the details of setting the keys that can be locked and the password 
for releasing the key lock.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Keylock and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

To the next page

Set the password for releasing the key 
lock.

Select whether to use the key lock 
function.

Select Lock to apply the key lock function 
to the RCD key.

Select Lock to apply the key lock function 
to the FEED key.

Select Lock to apply the key lock function 
to the MENU key.

Select Lock to apply the key lock function 
to the DISP MENU.

Basic=Keylock

Keylock=Use

Password=

RCD=Free

Feed=Free

Menu=Free

Disp Menu=Free

(Displays the following when the
 Keylock is set to Use)
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From the previous page
Select Lock to apply the key lock function 
to the alarm ACK operation. 

Select Lock to apply the key lock function 
to the computation start/stop operation.

Select Lock to apply the key lock function 
to the various printout operations.

Select Lock to apply the key lock function 
to the message printout operation.

Select Lock to apply the key lock function 
to the operation of clearing the printout 
buffer. 

The new setting takes effect.

Select Lock to apply the key lock function 
to the operation of resetting the report
data in periodic printout. 

Select Lock to apply the key lock function 
to the operation of moving the carriage 
assembly to a position where the pen can 
be easily replaced. 

Select Lock to apply the key lock function 
to the operation of moving the pen to a 
position where the pen can be easily
replaced. 

ESC/?
Keylock
Setting complete

Alarm ACK=Free

Math=Free

Printout=Free

Message=Free

Buffer clear=Free

Periodic=Free

Pen exchange=Free

Ribbon exchange=Free

(Pen model)

(/M1 option)

(Dot model)

(/EM1 option)

(/EM1 option, dot model)

(/EM1 option)

Select Lock to apply the key lock function to 
the data saving start/stop operation.

Select Lock to apply the key lock function to 
the data replay start/stop operation.

Select Lock to apply the key lock function to 
the SD memory card eject operation.

Data replay=Free

Data save=Free

SD eject=Free

7.10  Setting the Key Lock Function
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Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Keylock
Sets whether to use or not use the key lock function.
If Not is selected, the setup ends here.

Password
Sets the password for releasing the key lock. Set the password using numbers and 
spaces within 4 digits.

Operation of Keys to Be Key-Locked
Sets the operation of the keys to be key-locked. Select Lock or Free for each key 
operation.
RCD:      RCD  key
Feed:     FEED  key
Menu:     MENU  key
Disp Menu:   MENU1  key
Alarm ACK:   Alarm ACK operation under the FUNC  key
Math:       Computation start/stop/reset operation under the FUNC  key  

(/M1 option)
Print out     Printout start/stop/reset operation under the FUNC  key
Message    Message printout operation under the FUNC  key
Buffer clear:   Clear operation of the printout buffer memory under the FUNC  key
Periodic:     Clear operation of the report data of periodic printout under the FUNC  

key
Pen exchange:   Operation of moving the pen to an easily accessible position of 

replacement under the FUNC  key (pen model)
Ribbon exchange:  Operation carried out when replacing the ribbon cassette with the 

power turned ON under the FUNC  key (dot model)
Data save:     Start/stop operation for saving data to the SD memory card under the 

FUNC  key (/EM1 option)
Data replay:    Start/stop operation for replaying data from the SD memory card 

under the FUNC  key (/EM1 option, dot model)
SD eject:     Operation for ejecting the SD memory card under the FUNC  key  

(/EM1 option)

<Related Topics>  Activating/Releasing the key lock: Section 3.13

7.10  Setting the Key Lock Function
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7.11 Enabling the Moving Average Function (Dot 
Model)

This section explains the details of enabling/disabling the moving average function on the 
dot model.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Moving_AVE and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Enable/Disable moving average.

The new setting takes effect.
ESC/?

Move AVE
Setting complete

Basic=Moving_AVE

Moving_AVE=Not

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Moving_AVE
Use:   Enables the setting of the number of samples of the moving average in Setting 

mode.
Not:  The Moving_AVE item does not appear in Setting mode.

<Related Topics>  Setting the moving average function: Section 6.3



IM 04P02B01-01E 7-20

7.12 Enabling the Filter Function (Pen Model)

This section explains details of enabling/disabling the input filter function on the pen 
model.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Filter and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Enable/Disable the filter function.

The new setting takes effect.
ESC/?

Filter
Setting complete

Filter=Not

Basic=Filter

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Filter
Use:  Enables the setting of the filter time constant in Setting mode.
Not:  The Filter item does not appear in Setting mode.

<Related Topics>		Setting	the	filter:	Section	6.2
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7.13 Enabling the Partial Expanded Recording 
Function

This section explains the details of enabling/disabling the partial expanded recording 
function.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Partial and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

Enable/Disable partial expanded recording.

The new setting takes effect.
ESC/?

Partial
Setting complete

Basic=Partial

Partial=Not

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Partial
Use:  Enables the setting of the boundary position and boundary value of the partial 

expanded recording function in Setting mode.
Not: The Partial item does not appear in Setting mode.

<Related Topics>  Setting the partial expanded recording function: Section 6.5
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7.14 Changing the Display/Printout Language

This section explains the details of changing the display/printout language.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Language and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Select the display/printout language.

The new setting takes effect.
ESC/?

Language
Setting complete

Basic=Language

Language=English

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Lang (Language)
English (E): Uses the English alphabet, numbers, and symbols for display and printout.
German (G)*: Uses the German alphabet, numbers, and symbols for display and printout.
French (F)*:  Uses the French alphabet, numbers, and symbols for display and printout.
Japanese (J):  Uses the English alphabet, katakana, numbers, and symbols for display 

and printout.
*:  German and French are supported on version 1.21 or later. The setup items of the 

customized menu and header printout (/BT1 option) are displayed in English.
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7.15 Enabling the Bias, Low-Cut, Alarm Delay, 
Calibration Correction (/CC1 Option) Functions

This section explains the details of enabling/disabling the bias, low-cut, alarm delay, and 
calibration correction (/CC1 option) functions.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Personalize and then press the 
 key.

4. Press the  key with Add function shown on the screen.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  

Enable/Disable the bias function.

Enable/Disable the low-cut function on 
channels set to square root computation.

Enable/Disable the low-cut function on 
channels set to 1-5V.

The new setting takes effect.

Enable/Disable the calibration correction 
function.

(/CC1 option)

ESC/?
Personalize
Setting complete

Basic=Personalize

Mode=Add function

Bias=Not

SQRT low-cut=Use

1-5V low-cut=Not

Calibration=Use

Enable/Disable the alarm delay function.Alarm delay=Not
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Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Bias
Enables/Disables the bias function.
Use:  Enables the setting of the bias value in Setting mode.
Not:  The Bias item does not appear in Setting mode.

SQRT low-cut
Enables/Disables the square root low-cut function.
Use:   Enables the setting of the low-cut function when a channel is set to square root 

computation in Setting mode.
Not:  The SQRT low-cut item does not appear in Setting mode.

1-5V low-cut
Enables/Disables the 1-5V low-cut function.
Use:   Enables the setting of the low-cut function when a channel is set to 1-5V in 

Setting mode.
Not:  The 1-5V low-cut item does not appear in Setting mode.

Alarm delay
Enables/Disables the alarm delay function.
Use:   Enables the setting of delay high limit alarm or delay low limit alarm for the alarm 

type.
Not:   The delay high limit alarm and delay low limit alarm items do not appear as 

possible selections for the alarm type.

Calibration correction
Enables/Disables the calibration correction function.
Use:   Enables the setting of the correction mode and the number of calibration points 

in Basic Setting mode and the setting of the correction points and correction 
values in Setting mode.

Not:  The calibration item does not appear in Basic Setting or Setting mode.

Note
The bias and calibration correction functions (/CC1 option) cannot be enabled simultaneously.

<Related Topics>   Setting the bias value: Section 6.12 
Setting the low-cut value to the measured value: Section 5.1 
Setting the delay high/low limit alarm: Section 5.2 
Setting the correction mode and the number of calibration points for 
calibration correction: Section 7.23 
Performing calibration correction: section 6.13

7.15  Enabling the Bias, Low-Cut, Alarm Delay, Calibration Correction (/CC1 Option) Functions
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7.16 Changing the Time Printout Format

This section explains the details of changing the time printout format of alarm printout, 
message printout, recording start printout, and new chart speed printout.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.
2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 

Setting mode.
3. Press the  key or SHIFT +  key to select Personalize and then press the 

 key.
4. Press the  key or SHIFT +  key to select Time print and then press the 

 key.
5. Set each item and press the  key.

Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  

Select the time printout format of the 
alarm printout.

Select the time printout format of the 
message printout.

Select the time printout format of the 
recording start printout.

The new setting takes effect.

Select the time printout format of the 
new chart speed printout.

ESC/?

Mode=Time print

Alarm=HH:MM

Message=HH:MM

RCD On=HH:MM

C. Speed=HH:MM

Personalize
Setting complete

Basic=Personalize

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Explanation
Alarms
Sets the time printout format of the alarm printout.
HH:MM:   Hour:Minute
HH:MM:SS: Hour:Minute:Second
M/D H:M:  Month Day Hour:Minute
M/D H:M:S: Month Day Hour:Minute:Second
YMD H:M:S: Month Day Year Hour:Minute:Second

Message
Sets the time printout format of the message printout.
HH:MM:   Hour:Minute
HH:MM:SS: Hour:Minute:Second
M/D H:M:  Month Day Hour:Minute
M/D H:M:S: Month Day Hour:Minute:Second
YMD H:M:S: Month Day Year Hour:Minute:Second
None:   Does not print the date/time.

RCD On
Sets the time printout format of the record start time printout
The format is the same as that of the alarm printout.

C. Speed
Selects the time printout format of the new chart speed printout.
The format is the same as that of the alarm printout.

Note
The printout format of the year, month, and day varies depending on the printout/display format 
of the date (see section 7.19).

7.16  Changing the Time Printout Format
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7.17 Initializing the Settings

This section explains the details of initializing the recorder settings to their factory default.
Be careful, because all settings except the date/time and the adjustment values of the 
pen/dot printing position will be initialized.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Initialize and then press the  
key.

4. Press the  key to select the settings to be initialized and then press the  
key.
Set:  Initializes the settings in Setting mode.
Setup+Set: Initializes the settings in Basic Setting mode and Setting mode.

5. To execute the initialization, press the  key to select Yes and then press the 
 key.

The settings are initialized, and the recorder returns to Operation mode.
To cancel the initialization, press the ESC key The screen returns to the Basic=Initialize 
screen.
If you press the  key to select No and press then the  key, nothing happens.

  
Select the range to be initialized.

Select Yes and press  to execute 
initialization and return to Operation
mode.

ESC/?

Basic=Initialize

Mode=Setup+Set

Are you sure?=Yes

Explanation
Items That Are Not Initialized
The following items are not initialized.
• Adjustment value of the pen position and the adjustment value of the printer carriage 

position (Basic Setting mode)
• Date/Time (Setting mode)
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7.18 Assigning Functions to the Remote Control 
Input Terminals (/R1 Option)

This section explains the details of assigning functions to the input terminals of the 
remote control function.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Remote and then press the  
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  

Select the remote control input terminal 
number.

The new setting takes effect.

Select the function to be assigned.

ESC/?
Remote No.1
Setting complete

Basic=Remote

Remote number=1

1=Record On/Off

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Explanation
Remote No.
The remote control terminal numbers are from 1 to 5.

Function to Be Assigned
Record On/Off:  Starts/stops recording.
Alarm ACK:   Executes alarm output release.
Time adjust:   Adjusts the internal clock to the nearest hour.
Manual print:   Executes manual printout.
Message #:   Prints message # (where # is a value between 1 and 5).
Chart speed:   Changes the chart speed.
Math start/stop:   Starts/stops the computation on the computation function (/M1 

option).
Math reset:    Resets the computed result of the computation function (/M1 option).
Priority R_RCD:  Starts/stops recording (/BT1 option).
BatchCMT switch:  Start printout and Start printout 2, End printout and End printout 2 

switches according to the status of the “BatchCMT switch” signal 
during the rising or falling of the “Record On/Off” or “Priority R_RCD” 
signal (/BT1 option).

Data save On/Off: Starts/stops data saving to the SD memory card (/EM1 option).
None:     No function is assigned.

Note 
When you select “Priority R_RCD” and start recording remotely, you cannot stop recording 
using key operation or communications.

<Related Topics>  Setting the secondary chart speed: Section 6.9

7.18  Assigning Functions to the Remote Control Input Terminals (/R1 Option)
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7.19 Changing the Printout/Display Format of the 
Date

This section explains how to change the printout/display format of the year, month, and 
day.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Date format and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Select the date format.

The new setting takes effect.
ESC/?

Date format
Setting complete

Basic=Date format

Type=M.D.Y

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Date Format
Setting Format Example Note
Y/M/D 2005/8/31
M/D/Y 8/31/2005
D/M/Y 31/8/2005
D.M.Y 31.8.2005
M.D.Y Aug.31.2005 Default value
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7.20 Selecting to Show/Hide the FUNC Key Menus

Select the menu for showing/hiding the FUNC key menus. This function is available on 
version 1.31 or later.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Select menu and then press the 
 key.

4. Press the  key with Function shown on the screen.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
To correct the setting the  key.
If you are done, press the ESC key.



IM 04P02B01-01E 7-32

  

Basic=Select menu

Manual print=On Select whether to display Manual 
print. Select On or Off.

Menu=Function

Select func menu
Setting complete

Setup list=On Select whether to display Setup list. 
Select On or Off.

The new setting takes effect.

Message=On Select whether to display Message. 
Select On or Off.

Buffer clear=On Select whether to display Buffer 
clear. Select On or Off.

Periodic=On Select whether to display Periodic. 
Select On or Off.

ESC/?

Data save=On

Data replay=On

SD eject=On

(/EM1 option)

(/EM1 option, dot model)

(/EM1 option)

Select whether to display Data save. 
Select On or Off.

Select whether to display Data replay. 
Select On or Off.

Select whether to display SD eject. 
Select On or Off.

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
On: Display operation menus using the FUNC key. 
Off:  Do not display the operation menu using FUNC keys when Customized Menu is 

enabled.

<Related Topics>  Enabling the Customized Menu: Section 7.22

7.20   Selecting to Show/Hide the FUNC Key Menus
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7.21 Selecting to Show/Hide Setting Mode Menus

Select the menu for showing/hiding the Setting mode menus. This function is available 
on version 1.31 or later.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Select menu and then press the 
 key.

4. Press the  key with Set mode shown on the screen.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
To correct the setting the  key.
If you are done, press the ESC key.

  

Basic=Select menu

Range=On Select whether to display Range in 
Setting mode. Select On or Off.

Bias=On Select whether to display Bias in 
Setting mode. Select On or Off.

Menu=Set mode

Alarm=On Select whether to display Alarm in 
Setting mode. Select On or Off.

Unit=On Select whether to display Unit in 
Setting mode. Select On or Off.

Chart speed=On Select whether to display Chart 
speed in Setting mode. Select 
On or Off.

Aux=On Select whether to display Aux in 
Setting mode. Select On or Off.

To the next page
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Select set menu
Setting complete

The new setting takes effect.

From the previous page

(/BT1 option)

(/BT1 option)

Batch name=On Select whether to display Batch No. 
and Lot No. in Setting mode. Select 
On or Off.

Batch detail=On Select whether to display Batch 
detail in Setting mode. Select On 
or Off.

ESC/?

Calibration=On Select whether to display 
Calibration in Setting mode. 
Select On or Off.

Math=On Select whether to display Math in 
Setting mode. Select On or Off.

(/M1 option)

(/CC1 option)

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
On: Display the menu in Setting mode.
Off: Do not display the menu in Setting mode when Customized Menu is enabled.

<Related Topics>  Enabling the Customized Menu: Section 7.22

7.21  Selecting to Show/Hide Setting Mode Menus
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7.22 Enabling/Disabling the Customized Menu

When the Customized Menu is enabled, the following changes can be made. This 
function is available on version 1.31 or later.
•	 Hide	specified	menu	items	from	the	FUNC	key	menu.
•	 Hide	specified	Setting	mode	menu	items.
• Lock Basic Setting mode.

Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Enabling the Customized Menu

Changing the Settings
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Cust. menu and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting the  key.
If you are done, press the ESC key.

  

Basic=Cust. menu

P_Adj=Off

Basic Cust. menu
Setting complete

Select Use to enable the customized 
menu.

Set the password.

Select whether to use pen/dot printing 
position adjustment without the 
password. Select On or Off.

The new setting takes effect.
ESC/?

Cust. menu=Use

Password=

(Displays the following when the 
Cust. menu is set to Use)

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Disabling the Customized Menu
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Lock and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting the  key.
If you are done, press the ESC key.

  

Password=

Cust. menu=Not

Basic Cust. menu
Setting complete

Select Cust. menu.

Select Lock.

Enter the Password.

Enter Basic Setting mode.

Select Not.

The new setting takes effect.

Menu kind=Lock

ESC/?

Basic=Cust. menu

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Cust. menu (Customized Menu)
Use:   Displays only the desired Setting mode and FUNC key menus, and locks Basic 

Setting mode.
Not:   Displays all Setting mode and FUNC key menus, and releases the Basic Setting 

mode lock.

Password
The password required to release the customized menu or to enter Basic Setting mode. 
Set a password of four digits or fewer, using numbers and spaces.

7.22  Enabling/Disabling the Customized Menu
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Note
Changing the Settings in Basic Setting Mode without Disabling the Basic Setting Mode 
Lock
The settings in Basic Setting mode can be changed without disabling the customized menu.
Procedure

1. Enter a password in the same manner as the procedure for “Disabling the Customized 
Menu,” press the  key, and enter Basic Setting mode.

2. Change settings in the usual manner.
3. The instrument returns to Operation mode with Customized Menu still enabled.

<Related Topics>   Selecting to show/hide the FUNC key menus: Section 7.20 
Selecting to show/hide setting mode menus: Section 7.21 
Adjusting the pen position/dot printing position: Sections 11.5 and 
11.6

7.22  Enabling/Disabling the Customized Menu
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7.23 Setting the Calibration Correction Function 
(/CC1 Option)

This section explains the details of setting the correction mode and the number of 
calibration points.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Calibration and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  

Basic=Calibration

CH=01-01

Point=2

01-01Channel
Setting complete

Set the correction mode.

Set the channel range.

Set the number of calibration points.

The new setting takes effect.
ESC/?

Mode=Revise Value

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Explanation
Mode
Revise Value:   Sets the correction value using the revise value (corrected value – 

measured value).
Abs. Value:  Sets the correction value using the corrected value.

Point
Selects the number of points that make up the segments (including the start and end 
points) in the range of 2 to 16.

<Related Topics>   Enabling the calibration correction function: Section 7.15 
Setting the correction values: Section 6.13

7.23  Setting the Calibration Correction Function (/CC1 Option)
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7.24 Enabling Start Printout, End printout, and 
Message Format (/BT1 Option)

This section explains the details of enabling/disabling the Start printout, End printout, and 
Message format.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Batch and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting the  key.
If you are done, press the ESC key.

  

Basic=Batch

Dual comment=Use

Basic batch
Setting complete

Enable/disable the Start printout and 
End printout function.

Select 4 or 6 digits for the number of 
digits in the lot number, or disable.

Select to enable or disable Start 
printout 2 and End printout 2.

The new setting takes effect.

MSG format=Use Enable/disable the message format 
function.

ESC/?

Batch=Use

(Only when batch is set to Use)

(Only when batch is set to Use)

Lot No.=4

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Explanation
Batch
Use:   When starting/stopping recording, performs Start printout and End printout. You 

can now set up “Lot No.,” “Dual comment,” and, in Setting mode, “Batch.”
Not:  Do not perform Start printout/End printout.

Lot No.
Batch name = Batch No. (character string) and Lot No. (number)
4:    Prints out a 4-digit lot number. You can now set this under “Lot No.” in Setting 

mode.
6:    Prints out a 6-digit lot number. You can now set this under “Lot No.” in Setting 

mode.
Not:  Does not perform printout of the lot number.

Dual comment
Use:  You can now select Start printout 2 and End printout 2 in Setting mode’s Mode.
Not:  There are no Start printout 2 and End printout 2 choices in Setting mode’s Mode.

MSG Format
Use:  You can now set the MSG format in Setting mode.
Not:  The MSG format item is not displayed in Setting mode.

<Related Topics>   Setting the start printout and end printout: Section 6.14 
Setting the batch comment switch: Section 7.18 
Setting the message format: section 6.15

Note
Enabling the header printout (/BT1 option) function performs the following operation.
• When the power supply stops and then resumes, recording remains stopped.

7.24  Enabling Start Printout, End printout, and Message Format (/BT1 Option)
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7.25 Changing the Temperature Unit

This section explains the details of changing the temperature unit on the temperature 
measurement channels.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Temperature and then press the 
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Select the temperature unit.

The new setting takes effect.
ESC/?

Temperature
Setting complete

Basic=Temperature

Temperature= C°

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Temp (Temperature)
The setting is applied to all temperature measurement channels.
°C: Use Celsius.
°F: Use Fahrenheit.
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8.1 Key Operations for Changing the Displayed 
Information

Displaying the Data Display Setup Screen
Hold the MENU1  key for 3 seconds to show the data display setup screen.

  Data display setup screen

Operation mode

Dara display screen MENU1Hold down          or 3 s to switch.

Power ON

The panel keys are set to the functions marked above the keys as shown below.

  
FEEDDISPMENURCD MENUFUNC CH UP

SHIFTESC/?CHARACTER
1

Returning from the Data Display Setup Screen to Data Display Screen
Hold the MENU1  key for 3 seconds to return from the data display setup screen to data 
display screen.

Note
When the data display setup screen is shown, operations such as measurement, alarm, and 
recording continue.

Chapter 8 Setup Operations for Changing the Displayed Contents
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Data Display Setup Menu
This menu is used to assign display types to screen 01 to 15. The  indicates a 
display type. The items to set for each type are shown to the right of the display type.

Tag display type

Screen 01
Screen

1CH digital display
Display type

Display update rate End

2CH digital display Display update rate End

Screen 15 4CH digital display Display update rate End

6CH digital display (dot model) Display update rate End

1CH digital + 1CH bargraph display

1CH digital + 4CH bargraph display (pen model)

2CH digital + 2CH bargraph display

Display update rate End

Display update rate End

Display update rate End

4CH bargraph display (pen model) End

Flag display On/Off for each channel End

Channel alarm status display End

Time/Chart speed display End

DI/DO display (when the /R1, or /A    option is installed) End

(Display in which different screens can be 
assigned to the top and bottom sections)

Channel number Display update rateTop section

Channel number

Display update rate

End

Bottom section

Tag_1CH digital display

Tag_2CH digital display

Tag_1CH digital + 1CH bargraph display

Tag_1CH digital + 4CH bargraph display (pen model)

Status display End

System display End

Lights out End

Skip End

Batch name display (when the /BT1 option is installed) End

12CH digital display (dot model) Display update rate End

Display update rate

End

End

Display update rate End

Display update rate End

Display update rate

Multiple display

EndSD memory card status display (when the /EM1 option is installed)

The display update rate corresponds to “Interval” in the setup menu. It is the time interval at 
which the displayed channel is switched.

8.1  Key Operations for Changing the Displayed Information
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8.2 Changing the Displayed Information

This section explains the details of registering display types to screens 01 to 15. As an 
example, the procedure to set 1-channel digital display (tag display) and the display in 
which different channels are assigned to top and bottom sections is explained below.

Procedure
1-Channel Digital Display (Tag Display)

1. Hold the MENU1  key for 3 seconds to show the data display setup screen.

2. Press the  key or SHIFT +  key to select the screen number and then 
press the  key.
A sample screen of the display type appears. A section of the display blinks to indicate that 
this is a data display setup screen.

3. Press the  or SHIFT +  key to switch the display. Select the TAG001A 
(Tag_1CH digital) display and then press the  key.

4. Press the  key or SHIFT +  key to select the channel switching interval 
and then press the  key.

5. When the Setting complete screen appears, press the  key.
Hold the MENU1  key down for 3 seconds to exit from the data display setup screen.

  

Select the channel switching interval.

Select the display type.

Select the screen No.

Current display type name.

The new setting takes effect.Screen 01
Setting complete

Screen number=01

Interval=Auto2s

TAG001A 200.0 mV

Explanation
Tag Display Type

  

Tag_2CH digital

Tag_1CH digital + 4CH bargraph (Pen model)

Tag_1CH digital + 1CH bargraph

TAG001A:200. 0 mV
TAG002A:200. 0 mV

TAG001A

TAG001A

Interval
Sets the channel switching interval.
Select the interval from 1 s, 2 s, 3 s, 4 s, 5 s, and manual.
1s, 2s, 3s, 4s, 5s: Switches the channels at the specified interval.
Manual: Use the CH UP  key to switch the channel. If you select Manual, specify 

the channels to be displayed.

Assigning Other Display Types
•	 When	assigning	the	flag	display,	specify	whether	to	display	the	flag	for	each	channel.
•	 The	display	in	which	different	screens	can	be	assigned	to	the	top	and	bottom	sections	

is explained on the next page.

<Related Topics>  Display types: Section 12.4
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Procedure
Display in Which Different Screens Can Be Assigned to the Top and 
Bottom Sections (Top: 2-Channel Digital Display, Bottom: Date/Time)

1. Hold the MENU1  key for 3 seconds to show the data display setup screen.
2. Press the  key or SHIFT +  key to select the screen number and then 

press the  key.
A sample screen of the display type appears. A section of the display blinks to indicate that 
this is a data display setup screen.

3. Press the  or SHIFT +  key to switch the display. Select the display in 
which different screens can be assigned to the top and bottom sections (display in 
which UP and DW are shown at the left edge) and press the  key.

4. Set the display type for the top section.
Press the  key or SHIFT +  key to select 2CH digital display, and then 
press the  key.
Set the channel switching interval and other settings.

5. Set the display type for the bottom section.
Press the  key or SHIFT +  key to select date/time, and press the  key.

6. When the Setting complete screen appears, press the  key.
Hold the MENU1  key down for 3 seconds to exit from the data display setup screen.

  

Select the display type.

Select the channel switching interval.
In this example, select Manual.

Select the channel to be displayed
at the left.

Select the channel to be displayed
at the right.

Select the display type of the
bottom section.

Display type of the bottom section

Select the display type.

Display type of the top section

Select the screen No.

Current display type name.

The new setting takes effect.Screen 02
Setting complete

Screen number=02

Upper kind=
01 2000.0 mV 02 2000.0

Upper interval=Manual

Upper: Left=01 Right=0

UP: 01 200.0 mV
DW: 2005/01/01 00:00

Upper: Left=01 Right=0

Lower kind=
2005/01/01 00:00:00

Explanation
Display in Which Different Screens Can Be Assigned to the Top and 
Bottom Sections
You can select the display type (see page 12-12) for the top and bottom sections.

Interval:
See “Interval” on the previous page.

8.2  Changing the Displayed Information
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9.1 Starting/Stopping/Resetting the Computation

This section explains the details of starting/stopping the computation and resetting the 
computed values of computation channels.

Procedure
Starting the Computation

1. Press the FUNC  key.

2. Press the  key to show Math and then press the  key.

3. Press the  key with Start shown on the screen.
The computation starts, and the screen switches to the data display screen.
The word MATH in the status display comes on.

     Math=Start

Stopping the Computation
1. Press the FUNC  key.

2. Press the  key to show Math and then press the  key.

3. Press the  key with Stop shown on the screen.
The computation stops, and the screen switches to the data display screen.
The word MATH in the status display clears.

     Math=Stop

Resetting the Computed Values of All Computation Channels to 0
This operation can be executed only when the computation is stopped.

1. Press the FUNC  key.

2. Press the  key to show Math and then press the  key.

3. Press the  key to show Reset and then press the  key.
The computed values of all computation channels are reset, and the screen switches to the 
data display screen.

     Math=Reset

Chapter 9 Operations Related to the Computation Function (/M1 Option)

* When the            key or            key is pressed while holding down the SHIFT key, the operation is reversed as 
 when the respective key is pressed by itself.
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9.2 Setting the Computing Equation

The computing equation cannot be entered when the computation is in progress. If you 
change the computing equation or the recording span, set the alarm and the partial 
expanded recording again.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3 Press the  key with Formula shown on the screen.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC/? key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC/? key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

 

  

The new setting takes effect.
ESC/?

Select On to use the computing equation.

Set the channel range.

Set the equation.

Set the left span value.

Set the right span value.

First channel
Last channel

Set=Math

Math=Formula

CH=0A-0A

Mode=Off

formula=01

Span left=  -200.00

Span right=   200.00

0A-0A Channel
Setting complete

Setting the Computing Equation
The CHARACTER, , and  keys are used to set the computing equation.
Use the  key or SHIFT +  key to select the position for entering a character.
Use the CHARACTER key or SHIFT + CHARACTER key to select the character type.
Use the  key or SHIFT +  key to select the character.
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Each time you press the CHARACTER key the display changes as shown below.
Pressing the  key or SHIFT +  key switches the character within the selected 
character type and displays the character at the cursor position.
Display (CHARACTER key) Description Character ( key)
01... Measurement channel number Pen model: 01 to 04

Dot model: 01 to 24
0A... Computation channel number Pen model: 0A, 0B, 0C, 0D, 0E, 

0F, 0G, 0J
Dot model: 0A, 0B, 0C, 0D, 0E, 0F, 
0G, 0J, 0K, 0M, 0N, 0P,
1A, 1B, 1C, 1D, 1E, 1F, 1G, 1J, 1K, 
1M, 1N, 1P

+, –, *, /... Symbol and space +, –, *, /, (, ), space
Function Function SQR(, ABS(, LOG(, EXP(, .EQ., 

.NE., .GT., .LT., .GE., .LE., AND, 
NOT, XOR, OR, TLOG.AVE(, 
TLOG.MAX(, TLOG.MIN(,  
TLOG.SUM(, TLOG.P-P(, space

K01-K30 Constant K01 to K30
D01-D05 Status of the remote D01 to D05

control terminals
C01-C12 Communication input data Pen model: C01 to C08

Dot model: C01 to C24
Ins DISP Insert a character
Del DISP Delete a character
Clear DISP Delete the entire string
Copy DISP Store the entire string in the 

memory
Past DISP Paste the string in the memory

Inserting a Character
Press the  key or SHIFT +  key to move the cursor to the position where the 
character is to be inserted.
Press the CHARACTER key or SHIFT + CHARACTER key to show Ins DISP and then 
press the  key. A space for one character is inserted. Enter the character.

Deleting a Character
Use the  key or SHIFT +  key to move the cursor to the character to be deleted.
Press the CHARACTER key or SHIFT + CHARACTER key to show Del DISP and then 
press the  key. The character is deleted.

Deleting an Entire Character String
Press the CHARACTER key or SHIFT + CHARACTER key to show Clear DISP and 
then press the  key. The entire character string is deleted.

Copying & Pasting a Character String
Show the copy source character string.
Press the CHARACTER key or SHIFT + CHARACTER key to show Copy DISP and 
then press the  key. The character string is saved to the memory.
Show the copy destination.
Press the CHARACTER key or SHIFT + CHARACTER key to show Paste DISP and 
then press the  key. The character string is pasted.

9.2  Setting the Computing Equation
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Explanation
Computing Equation

Follow the rules below when writing computing equations.
• Use up to 120 characters to write equations.
•	 The	precedence	of	computing	terms	can	be	specified	using	parentheses.
• Specify the channels in the equation using 2-digit channel numbers.
 Example: 01, 0A
• Specify the constants (K), communication input data (C), and remote control input 

terminal status (D) in the computing equation using 2-digit numbers.
 Example: K01, C01, D01
• The data value for its own channel and channels that are greater in number than its 

own channel are substituted with the data from the previous scan.

Order of Precedence in Computations
The order of precedence of computation in equations is as follows:
Type Operator

(high order of precedence)
Function ABS(), SQR(), LOG(), EXP(), TLOG.MAX(),  

TLOG.MIN(), TLOG.P-P(), TLOG.SUM(), TLOG.AVE()
Power **
Logical negation NOT
Multiplication and division *, /
Addition and subtraction +, –
Greater than and less than .GT., .LT., GE., LE.
Equal and not equal .EQ., .NE.
Logical product AND
Logical sum and exclusive logical sum OR, XOR

(low order of precedence)

Data That Can Be Used in Equations
In TLOG computation, the measured values of measurement channels or computed 
values of computation channels can only be used. For all other computations, all of the 
data types below can be used.
• Measured Values on Measurement Channels
	 Specified	by	the	channel	number.	For	channels	that	have	linear	scaling	enabled,	the	

scaled values are used in the computation.
 Pen model: 01 to 04, dot model: 01 to 24
• Computed Values on Computation Channels
	 Specified	by	the	channel	number.
 Pen model:  0A, 0B, 0C, 0D, 0E, 0F, 0G, 0J
 Dot model:   0A, 0B, 0C, 0D, 0E, 0F, 0G, 0J, 0K, 0M, 0N, 0P, 1A, 1B, 1C, 1D, 1E, 1F,  

1G, 1J, 1K, 1M, 1N, 1P
• Constants (K01 to K30)
 Enter the values as K01 to K30 in the equations.
	 Range	of	values	(maximum	significant	digits	is	5):
 –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
•  Communication Input Data (Pen model: C01 to C08, dot model: C01 to 

C24)
 Enter the data as C01 to C24 in the equations.
	 Range	of	values	(maximum	significant	digits	is	5):	
  –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
 For the procedure of setting the communication input data, see the µR10000/µR20000 

Communication Interface User’s Manual (IM04P01B01-17E).

9.2  Setting the Computing Equation
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• Status of the Remote Control Input Terminal (D01 to D05, /R1 option)
 The status of the remote control input signal (1 or 0) can be used in the computation. 

Use D01 to D05 (the number following the letter D is the remote control input terminal 
number) to specify the status in the equations.

Four Arithmetic Operation
The data that can be used in equations are measured values, computed values, 
constants, communication input data, and remote control input terminal status.
Equation Examples
• Addition   01+02
       (Determines the sum of the measured values of channel 1 and channel 

2.)
• Subtraction 01–02
	 	 	 	 	 	 	(Determines	the	difference	of	the	measured	values	of	channel	1	and	

channel 2.)
• Multiplication 01*K03
      (Multiplies constant K03 to the measured value of channel 1.)
• Division   01/K02
      (Divides the measured value of channel 1 by constant K02.)

Note
By setting an equation similar to the one shown below, you can determine the accumulation 
of a specified channel (in this case channel 01) and make the result the computed value of 
computation channel 0A.
Computing equation of computation channel 0A: 0A+01

Power and Other Computations
The data that can be used in equations are measured values, computed values, 
constants, communication input data, and remote control input terminal status. You can 
nest a computing element inside the parentheses of another computing element.
Equation Examples
• Power     01**02
         (Determines the measured value of channel 1 to the power of 

the measured value of channel 2.)
• Square root   SQR(02)
         (Determines the square root of the measured value of channel 

2.)
• Absolute value  ABS(02)
         (Determines the absolute value of the measured value of 

channel 2.)
• Common logarithm LOG(01)
         (Determines the common logarithm (log10) of the measured 

value of channel 1.)
• Exponent    EXP(01)
        (Determines e to the power of the measured value of channel 1.)

Note
You can determine the natural logarithm by setting an equation like the following.
From logbX = logaX/loga, we obtain logeX = log10X/log10e
Hence, to determine the natural logarithm of channel 1, we set
 Constant K01 = 0.43429(log10e), and
 Computing equation LOG(01)/K01.

9.2  Setting the Computing Equation
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Relational Computation
The data that can be used in equations are measured values, computed values, 
constants, communication input data, and remote control input terminal status. You 
can specify a computing equation that performs relational computation on a computing 
element. (Example: 01.LT.ABS(02))

Equation Examples
02.LT.03
If the measured value of channel 2 is less than the measured value of channel 3, the 
computed result is “1.”  Otherwise, the result is “0.”

02.GT.03
If the measured value of channel 2 is greater than the measured value of channel 3, the 
computed result is “1.”  Otherwise, the result is “0.”

02.EQ.03
If the measured value of channel 2 is equal to the measured value of channel 3, the 
computed result is “1.”  Otherwise, the result is “0.”

02.NE.03
If the measured value of channel 2 is not equal to the measured value of channel 3, the 
computed result is “1.”  Otherwise, the result is “0.”

02.GE.03
If the measured value of channel 2 is greater than or equal to the measured value of 
channel 3, the computed result is “1.”  Otherwise, the result is “0.”

02.LE.03
If the measured value of channel 2 is less than or equal to the measured value of channel 3, 
the computed result is “1.”  Otherwise, the result is “0.”

Logical Computation
Checks whether the two data values, e1 and e2 (e1 only for NOT), are zeroes or 
non-zeroes, and computes according to the conditions. The data that can be used in 
equations are measured values, computed values, constants, communication input data, 
and remote control input terminal status. You can specify a computing equation that 
performs logical computation on a computing element.

AND
Logical Product
(Syntax)    e1ANDe2
(Condition)    If the two data values e1 and e2 are both non-zeroes, the computed 

result is “1.”  Otherwise, it is “0.”
(Explanation) e1 = 0
	 	 →	 e1ANDe2	=	0
 e2 = 0

	 e1	≠	0
	 	 →	 e1ANDe2	=	0
 e2 = 0

 e1 = 0
	 	 →	 e1ANDe2	=	0
	 e2	≠	0

	 e1	≠	0
	 	 →	 e1ANDe2	=	1
	 e2	≠	0

9.2  Setting the Computing Equation
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OR
Logical sum
(Syntax)    e1ORe2
(Condition)    If the two data values e1 and e2 are both zeroes, the computed result is 

“0.”  Otherwise, it is “1.”
(Explanation) e1 = 0
	 	 →	 e1ORe2	=	0
 e2 = 0

	 e1	≠	0
	 	 →	 e1ORe2	=	1
 e2 = 0

 e1 = 0
	 	 →	 e1ORe2	=	1
	 e2	≠	0

	 e1	≠	0
	 	 →	 e1ORe2	=	1
	 e2	≠	0

XOR
Exclusive OR
(Syntax)    e1XORe2
(Condition)    If the two data values e1 and e2 are zero and non-zero or non-zero and  

zero, the computed result is “1.”  Otherwise, it is “0.”
(Explanation) e1 = 0
	 	 →	 e1XORe2	=	0
 e2 = 0

	 e1	≠	0
	 	 →	 e1XORe2	=	1
 e2 = 0

 e1 = 0
	 	 →	 e1XORe2	=	1
	 e2	≠	0

	 e1	≠	0
	 	 →	 e1XORe2	=	0
	 e2	≠	0

NOT
Logical negation
(Syntax)    NOTe1
(Condition)   The result is the inverse of the status of data e1 (zero or non-zero).
(Explanation)	 e1	=	0	 →	 NOTe1	=	1
	 e1	≠	0	 →	 NOTe1	=	0		

Equation Example
01-02OR03.GT.04
Determines the OR of the computed results of “01-02” and “03.GT.04”.

9.2  Setting the Computing Equation
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TLOG Computation
Only measured values and computed values can be used in TLOG computation. In the 
explanation below, e1 is used to represent a measurement or computation channel. You 
cannot specify an equation that contains a computing element inside e1. In addition, only 
one TLOG computation can be specified in a single computing equation.

TLOG.MAX( )
Maximum value
(Syntax)   TLOG.MAX(e1)
(Condition)  Determines the maximum value of channel e1.

TLOG.MIN( )
Minimum value
(Syntax)   TLOG.MIN(e1)
(Condition)  Determines the minimum value of channel e1.

TLOG.AVE( )
Average value
(Syntax)   TLOG.AVE(e1)
(Condition)  Determines the average value of channel e1.

TLOG.SUM( )
Sum value
(Syntax)   TLOG.SUM(e1)
(Condition)  Determines the sum of channel e1.

TLOG.P-P( )
Maximum	−	minimum	value
(Syntax)   TLOG.P-P(e1)
(Condition)		 Determines	the	maximum	−	minimum	value	of	channel	e1.

Equation Example
TLOG.MAX(01) + K01*SQR(02)

Examples of Equations That Are Not Allowed
TLOG.AVE(01) + TLOG.AVE(02)
Reason: TLOG appears twice in one equation.

TLOG.AVE(ABS(01))
Reason: A computing element is used inside the parentheses.

9.2  Setting the Computing Equation
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9.3 Setting the Unit

This section explains the details of setting the unit on computation channels.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3. Press the  key or SHIFT +  key to select Unit and then press the  key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the channel range.

The new setting takes effect.
ESC/?

Set the unit.
First channel

Last channel

0A-0A Channel
Setting complete

Set=Math

Math=Unit

CH=0A-0A

Unit=

Explanation
Characters That Can Be Used for Units
Set the unit using up to 6 characters.
The available characters are as follows:
	 Alphabet,	numbers,	symbols	(%,	#,	°,	@,	+,	–,	*,	/,	(,	),	µ,	Ω,	2, 3, .), and space
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9.4 Setting the Constants Used in Equations

This section explains the details of setting constants to be used in computing equations.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode. 

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3. Press the  key or SHIFT +  key to select Constant and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Select the constant number.

The new setting takes effect.
ESC/?

Set the value.

K01
Setting complete

Set=Math

Math=Constant

Number=K01

K01=1

Explanation
Constant
Up to 30 constants can be registered. Enter the values as K01 to K30 in the equations.
Set the constants in the range shown below. The maximum number of significant digits is 5.
 –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
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9.5 Setting the Alarm

This section explains the details of setting alarms for each computation channel.
If you change the computing equation or the recording span, set the alarm again.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3. Press the  key or SHIFT +  key to select Alarm and then press the  
 key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

Set the channel range.

The new setting takes effect.
ESC/?

Select the level number between 1 and 4.

Select On to set the alarm.  When set 
to On, the settings below can be entered.

Select the alarm type.

Select the value used to turn On the alarm.

Turn relay On when outputting alarms on the 
relay. This setting is valid only on models 
with the /A1, /A2, /A3, /A4, or /A5 option.

Specify the alarm output relay No.

First channel
Last channel

0A-0A CH/level 1
Setting complete

Set=Math

CH=0A-0A

Math=Alarm

Level=1

Alarm=Off

Type=H

Value=     0.00

Relay=Off

Relay number=I01
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Explanation
Alarm Type
Symbol Name
H High limit alarm
L Low limit alarm
T Delay high limit alarm*
t Delay low limit alarm*

* Selectable only when the alarm delay function is enabled. See section 7.15.

If delay high limit alarm or delay low limit alarm is specified, set the alarm delay time.

<Related Topics>   Setting the delay time of the delay high limit alarm or delay low limit 
alarm: Section 9.11 
Enabling the alarm delay function: Section 7.15 
Setting the alarm hysteresis: Section 7.1

Alarm Value
Can be set to a value in the range of –9999999 to 99999999 excluding the decimal  
(–9999999 to 99999999 is the displayable range).

Relay No.
The selectable relay numbers are listed below.
 I01 and I02 on the /A1 option
 I01 to I04 on the /A2 option
 I01 to I06 on the /A3 option
 I01 to I06 and I11 to I16 on the /A4 option
 I01 to I06, I11 to I16, I21 to I26, and I31 to I36 on the /A5 option

9.5  Setting the Alarm
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9.6 Specifying the Timer Used in Statistical 
Calculations (TLOG)

On channels that perform statistical calculation (TLOG), the timer for determining the 
interval is specified. The sum scale is also specified when using statistical calculation.
The timer is also used for the periodic printout of computed values.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3. Press the  key or SHIFT +  key to select TLOG and then press the  
key.

4. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

5. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

6. Hold down the MENU  key for 3 seconds to return to Operation mode.

Set the channel range.

The new setting takes effect.
ESC/?

Select the timer number (Periodic, 1, or 2).

Select the sum scale.

First channel
Last channel

0A-0A Channel
Setting complete

Math=TLOG

Set=Math

CH=0A-0A

Timer number=Periodic

SUM scale=Off
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Explanation
Timer No.
There are three timers.
Periodic: The timer for determining the periodic printout interval. The computed result is 

printed every interval, and the computed TLOG value is reset.
1: The timer of timer No. 1. Specify whether the computed value is printed every 

interval and whether to reset the computed value.
2: The timer of timer No. 2. Specify whether the computed value is printed every 

interval and whether to reset the computed value.
• Timer operation
 The table below shows how each timer operates.

Item Timer # Periodic 1 and 2*

Application Periodic TLOG computation

Target channel Measurement and 
computation channels Computation channels

Timer mode** Absolute time mode Absolute or relative time mode
Reset computed TLOG value Yes Yes/No selectable
Print when computation stops No Yes
* For the timer 1 and 2 settings, see section 9.12.
** Absolute time mode: Keeps time from the reference time.
  Relative time mode: Starts the time in sync with the starting of the computation.

SUM scale
Set the sum scale when using statistical calculation (TLOG.SUM).
For the definition of the term “sum scale,” see page 7-14.
Off:  Simply sums the computed values.
/s:   Sums by converting the computed values to a value over 1 second.
/min:  Sums by converting the computed values to a value over 1 minute.
/h:   Sums by converting the computed values to a value over 1 hour.
/day:  Sums by converting the computed values to a value over 1 day.

<Related Topics>   Setting the periodic printout timer: Section 7.8 
Setting Timer 1 and Timer 2: Section 9.12

9.6  Specifying the Timer Used in Statistical Calculations (TLOG)
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9.7 Setting Recording Zones for Each Channel 
(Zone Recording)

This section explains the details of setting the recording zone for each computation 
channel.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.
2. Press the  key or SHIFT +  key to select Math and then press the  key.
3. Press the  key or SHIFT +  key to select Aux and then press the  key.
4. Press the  key or SHIFT +  key to select Zone and then press the  key.
5. Set each item and press the  key.

Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

7. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the channel range.

The new setting takes effect.
ESC/?

Set the leftmost value of the recording 
zone.

Set the rightmost value of the recording 
zone.

First channel
Last channel

0A-0A Channel
Setting complete

Set=Math

Math=Aux

Aux=Zone

CH=0A-0A

Left=  0

Right=100

Explanation
Zone
The recording zone can be set in the following range.
Leftmost position: 0 mm to 175 mm
Rightmost position: 5 mm to 180 mm
Set a larger value for the rightmost position than the leftmost position.
Set at least 5 mm for the zone width.

Note
If the zone is set to a value less than 40 mm, scale printout of periodic printout cannot be 
executed.
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9.8 Setting the Partial Expanded Recording

This section explains the details of expanding a section of the recording range.
If you change the computing equation or the recording span, set the partial expanded 
recording again.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3. Press the  key or SHIFT +  key to select Aux and then press the  key.

4. Press the  key or SHIFT +  key to select Partial and then press the  
key.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

7. Hold down the MENU  key for 3 seconds to return to Operation mode.

  

Set the channel range.

The new setting takes effect.
ESC/?

Select On to use the partial expanded 
recording function.

Set the boundary position as 
a percentage where the recording span 
is assumed to be 100%.

Set the boundary value within the 
recording span.

First channel
Last channel

0A-0A Channel
Setting complete

Set=Math

Math=Aux

Aux=Partial

CH=0A-0A

Partial=Off

Expand=50

Boundary=       0.00

<Related Topics>   Enabling the partial expanded recording function: Section 7.13
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9.9 Turning Trend Recording (Dot Model) and 
Periodic Printout (Including the Printout Using 
the TLOG Timer) ON/OFF for Each Channel

This section explains the details of setting the trend recording and periodic printout for 
each computation channel.
The following settings can be entered for each channel.
• Turn trend recording ON/OFF (dot model only).
• Turn the printing of computed values ON/OFF during periodic printout.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3. Press the  key or SHIFT +  key to select Aux and then press the  key.

4. Press the  key or SHIFT +  key to select Print out and then press the  key.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

7. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the channel range.

The new setting takes effect.
ESC/?

Turn trend recording On/Off.

Select whether to print the computed 
values during periodic printout and 
printout using the TLOG timer (On/Off).

(Dot model)

Last channelFirst channel

0A-0A Channel
Setting complete

Set=Math

Math=Aux

Aux=Print out

Trend=On

Periodic=On

CH=0A-0A

Explanation
Periodic Printout
On:	 Prints	the	computed	values	(instantaneous	values	or	report	data)	of	the	specified	

channel during periodic printout.
Off:	 Does	not	print	the	channels	and	computed	values	during	periodic	printout.
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9.10 Setting Tags on Channels

This section explains the details of setting the tag on computation channels.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3. Press the  key or SHIFT +  key to select Aux and then press the  key.

4. Press the  key or SHIFT +  key to select Tag and then press the  key.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

7. Hold down the MENU  key for 3 seconds to return to Operation mode.

  
Set the channel range.

The new setting takes effect.
ESC/?

Set the tag.
First channel

Last channel

0A-0A Channel
Setting complete

Set=Math

Math=Aux

Aux=Tag

Tag=

CH=0A-0A

Explanation
Characters That Can Be Used for Tags
Set the tag using up to 7 characters.
The available characters are as follows:
	 Alphabet,	numbers,	symbols	(%,	#,	°,	@,	+,	–,	*,	/,	(,	),	µ,	Ω,	2, 3, .), and space

<Related Topics>   Printing tags in place of channel numbers: Section 7.7 
Displaying tags in place of channel numbers: Section 8.2
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9.11 Setting the Alarm Delay Duration

This section explains the details of setting the duration of the delay high limit and delay 
low limit alarms.

Procedure
1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Press the  key or SHIFT +  key to select Math and then press the  key.

3. Press the  key or SHIFT +  key to select Aux and then press the  key.

4. Press the  key or SHIFT +  key to select Alarm delay time and then 
press the  key.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

7. Hold down the MENU  key for 3 seconds to return to Operation mode.

Set the channel range.

The new setting takes effect.
ESC/?

Set the alarm delay time.
First channel

Last channel

Set=Math

Math=Aux

Aux=Alarm delay time

Duration=  10

CH=0A-0A

0A-0A Channel
Setting complete

Explanation
Duration
The duration can be set to a value in the range of 1 to 3600 s.
However, the alarm delay time is an integer multiple of the scan interval. For example,  if 
the scan interval on the dot model is 2.5 s, the actual duration is an integer multiple of 2.5 s. 
If the set value is not equal to an integer multiple of 2.5 s, the duration is the smallest 
integer multiple of 2.5 s greater than the set value.
Example: The actual duration for 1 s and 2 s is 2.5 s.

<Related Topics>  Enabling the alarm delay function: Section 7.15
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9.12 Setting the Timer Used in TLOG Computation 
and Periodic Printout

This section explains the details of setting the timer used in TLOG computation and 
periodic printout.
Basic Setting mode cannot be entered when recording is in progress or when computation 
is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Math and then press the  key.

4. Press the  key with Timer (TLOG) shown on the screen.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  

Select the timer No.

The new setting takes effect.
ESC/?

Select the timer type.

(When the mode is set to Absolute)

Select the timer interval.

Set the reference time.

Select On to reset the computed values 
every interval.

Select On to print the computed values 
every interval.

Math Timer
Setting complete

Basic=Math

Math=Timer(TLOG)

Timer number=1

Mode=Absolute

Interval=1h

Ref.Time=00:00

Reset=Off

Print=Off
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Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Timers
Timer features
• The timer determines the interval used to calculate the report data (the average, 

minimum, maximum, sum value), etc.
• The timer is also used to set the interval at which the computed values are printed on 

the chart paper.

Number of Timers
There are two timers: Timer No. 1 and 2. The timer that is used can be set for each 
channel.

Timer Type
There are two timer modes, absolute time mode and relative time mode. For absolute 
time mode times, set the referernce time and interval; for relative time mode timers, set 
the interval.
• Absolute (Absolute Time Mode)
 After the computation is started, the timer times out at the times determined by the 

reference time (on the hour) and the interval. The Ref. Time (refarence time) is set 
on the hour (00 to 23).
Example 1: Reference time:  14:00
 Interval:  12h
 The timeout times are hour 2 and hour 14.
Example 2: Reference time:  00:00
 Interval:  10min
 The timeout times are 0 hour, 0 hour 10 min, 0 hour 20 min, ... 23 hour 40 

min, and 23 hour 50 min. For example, if computation is started at 9 hour 
36 min, the timeout times are 09 hour 40 min, 09 hour 50 min, 10 hour, 
and so on.

• Relative (Relative Time Mode)
 The clock is started in sync with the starting of the computation, and the timer times 

out	every	specified	interval.	In	this	mode,	the	timer	and	the	clock	stop	when	a	power	
failure occurs.
Example: Interval:  00:15
 The timer times out every 15 minutes after the computation is started.

• Off
	 If	Off	is	selected,	the	TLOG	computation	continues,	but	reset	and	printout	are	not	

performed. To reset computed result, use the remote control function (/R1 option) or 
carry it out manually (using the FUNC key).

Interval
Select from 10, 12, 15, 20, 30min, 1, 2, 3, 4, 6, 8, 12, and 24h.

<Related Topics>   Setting the timer to be used for each channel: Section 9.6 
Resetting the computation remotely: Section 7.18 
Resetting the computation manually: Section 9.1

9.12  Setting the Timer Used in TLOG Computation and Periodic Printout
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Reset
Selects whether to reset the TLOG computed value at each interval. The figure below 
illustrates the reset operation for sum computation (TLOG.SUM).
 Example: TLOG.SUM computation

   

1 2 3

ResetReset Reset
Reset: On

Timer timeout

Reset: Off

When reset is ON, the sum value is calculated over each interval. When set to Off, the 
sum value from computation start is calculated.

Print
On: Prints the computed value every interval specified by the timer. Computation 

channels set to Off do not apply.
Off: Does not print.

9.12  Setting the Timer Used in TLOG Computation and Periodic Printout
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9.13 Changing the Channel Recording Color (Dot 
Model)

This section explains the details of changing the recording colors of computation 
channels.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.
2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 

Setting mode.
3. Press the  key or SHIFT +  key to select Math and then press the  key.
4. Press the  key or SHIFT +  key to select Color and then press the  

key.
5. Set each item and press the  key.

Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Select the channel.

The new setting takes effect.
ESC/?

Select the recording color.

0A Channel color
Setting complete

Basic=Math

Math=Color

Channel=0A

Color=Purple

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Color
This section explains the details of changing the recording colors of computation 
channels.
The default values are as follows:
 Purple: Channels 0A, 0G, 1A, and 1G. Red: Channels 0B, 0J, 1B, and 1J.
 Green: Channels 0C, 0K, 1C, and 1K. Blue: Channels 0D, 0M, 1D, and 1M.
 Brown: Channels 0E, 0N, 1E, and 1N. Black: Channels 0F, 0P, 1F, and 1P.
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9.14 Changing the Channel Assignments of 
Recording Pens (Pen Model)

Measurement channels and computation channels can be arbitrarily assigned to 
recording pens.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Math and then press the  key.

4. Press the  key or SHIFT +  key to select Output pen and then press the 
 key.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  
Select the pen number and channel 
number.

The new setting takes effect.
ESC/?

Pen 1
Setting complete

Basic=Math

Math=Output pen

Pen=1    CH=01

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Output pen
Measurement channels and computation channels can be arbitrarily assigned to 
recording pens.
The default values are as follows:

Pen No. 1 (red): Channel 01
Pen No. 2 (green): Channel 02
Pen No. 3 (Blue): Channel 03
Pen No. 4 (violet): channel 04
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9.15 Changing the Type of Report Data Printed in 
Periodic Printout

This section explains the details of selecting the type of report (the average, minimum, 
maximum, or sum) printed in periodic printout.
To print the report data during periodic printout, set the type of data to be printed to report 
(see section 7.8).
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Math and then press the  key.

4. Press the  key or SHIFT +  key to select Print2 and then press the  
key.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
To correct the setting, press the  key.
If you are done, press the ESC key.

  

Set the channel range.

The new setting takes effect.
ESC/?

Select the type of report data to print.

Select the sum scale.

First channel
Last channel

Periodic
Setting complete

Basic=Math

Math=Print2

CH=0A-0A

Mode=AVE

SUM scale=Off

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Explanation
Mode
Sets the type of report data to be printed.
AVE:  Prints the average value over the interval.
MIX:  Prints the minimum, maximum, and average values over the interval.
SUM:  Prints the sum value over the interval. If SUM is selected, set the sum scale.
MIN:  Prints the minimum value over the interval.
MAX:  Prints the maximum value over the interval.
INST:  Prints the instantaneous value.

SUM scale
Set this item only when SUM is selected.
For the definition of the term “sum scale,” see page 7-14.
Off:  Simply sums the  computed values.
/s:   Sums by converting the computed values to a value over 1 second.
/min:  Sums by converting the computed values to a value over 1 minute.
/h:   Sums by converting the computed values to a value over 1 hour.
/day:  Sums by converting the computed values to a value over 1 day.

<Related Topics>   Setting the periodic printout interval and the type of data to be 
printed: Section 7.8

9.15  Changing the Type of Report Data Printed in Periodic Printout
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9.16 Setting the Bar Graph Display Mode

This section explains the details of setting the bar graph display mode.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic  
Setting mode.

3. Press the  key or SHIFT +  key to select Math and then press the  key.

4. Press the  key or SHIFT +  key to select Bar graph and then press the 
 key.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

  
Set the channel range.

The new setting takes effect.
ESC/?

Select the display mode of the bar 
graph.

First channel
Last channel

0A-0A Channel
Setting complete

Basic=Math

Math=Bar graph

CH=0A-0A

Graph=Normal

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Explanation
Graph
Normal: Sets the base point of the bar graph to the left or right of the recording span 

whichever is smaller in value.
Center: Sets the base point of the bar graph to the 50% position of the recording span.
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9.17 Setting the Procedure Taken When the 
Computed Result Is in Error

This section explains the details of setting the procedure taken when the computed result 
is in error.
Basic Setting mode cannot be entered when recording is in progress or when 
computation is in progress on models with the computation function (/M1 option).

Procedure
Changing the Settings

1. Hold down the MENU  key for 3 seconds to enter Setting mode.

2. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

3. Press the  key or SHIFT +  key to select Math and then press the  key.

4. Press the  key or SHIFT +  key to select Error data and then press the 
 key.

5. Set each item and press the  key.
Use the  key or SHIFT +  key to select values.
For the procedure on how to enter values or characters, see section 4.2.
If you press the ESC key in the middle of the operation, the settings entered up to 
then are cancelled, and the display returns to a higher level menu.

6. When the Setting complete screen appears, do either of the following:
Press the  key to set other channels.
If you are done, press the ESC key.

  
Select the computation error procedure.

The new setting takes effect.
ESC/?

Select the input overflow procedure.

Math exception
Setting complete

Basic=Math

Math=Error data

Error=+Over

Over=Skip

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.
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Explanation
Error
Specifies how to display or print the computed result when computation errors occur.
+Over: Set to +over. Displayed/Printed as “+Over.”
–Over: Set to –over. Displayed/Printed as “–Over.”

Computation that result in errors
• x/0
• SQR(-x)
• LOG(-x)
• When a channel set to Skip is included in the equation

Over
Selects the procedure when an “over” value* is input for TLOG.SUM or TLOG.AVE 
computation.

*  An “over” value on a measurement channel refers to +Over or –Over. See section 12.4. An 
“over” value on a computation channel refers to a value that is less than or equal to  
–100000000 or greater than or equal to 100000000 excluding the decimal.

Skip:  The “over” value is not used in the computation.
Limit:  The following limit value is used for the computation.
Channel Limit Value
Measurement channel • For scaling (1-5V, scaling, and square root)

 –Over: –31500, +Over: 31500 (excluding the decimal)
• For input types other than scaling
 –Over: The minimum measurable value at the specified range type 

(Example: –2.000 at 2 V range)
 +Over: The maximum measurable value at the specified range type 

(Example: 2.000 at 2 V range)
Computation channel –Over: –100000000, +Over: 100000000 (excluding the decimal)

  9.17  Setting the Procedure Taken When the Computed Result Is in Error
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10.1 A List of Error Messages

There are cases in which error codes and messages are displayed on the screen during 
operation. The error messages and their description are listed below.

Setting Errors
Code Message Explanation/Countermeasures
1 System error. Contact your nearest YOKOGAWA dealer.
2 Incorrect date or time setting. Check the setting.
3 A disabled channel is selected. The channel does not exist.
4 Incorrect function parameter. Incorrect communication parameter.
5 The input numerical value exceeds the set range. –
6 Incorrect input character string. The entered character cannot be used.
7 Too many characters. –
8 Incorrect input mode. Incorrect range mode (Volt, TC, Scale, etc.) setting.
9 Incorrect input range code. Incorrect range type (2 V, R, PT100, etc.) setting.
10 Format error. Incorrect character string format.
11 Range settings are not same within the selected 

channels.
Channels whose range differs cannot be set simultaneously.

12 An invalid characters. Contains an invalid character.
13 Ref. CH error. Specify a channel whose range is set to voltage, TC, or RTD for 

the reference channel.
15 Too many characters for printout. Too many characters in the message printout including 

measured/computed values.
16 Too many characters for message. Cannot enter a setting that exceeds the message string (16 

characters).
21 Cannot set an alarm for a SKIPPED channel. –
22 The upper and lower span limits are equal. This is not allowed.
23 The upper and lower scale limits are equal. This is not allowed.
24 The lower span limit is greater than the upper span 

limit.
–

25 The lower scale limit is greater than the upper scale 
limit.

–

26 Bias cannot be set to the SKIPPED channel. –
27 Bias cannot be set to the DI channel. –
30 The partial boundary value exceeds the range of the 

span.
–

31 Partial is invalid on the SKIPPED channel. –
35 The upper and lower limits of the printing zone are 

equal.
Set	the	rightmost	value	of	the	zone	–	the	leftmost	value	≥	5	mm.	

36 The lower limit of the printing zone is greater than  
the upper limit.

Set	the	rightmost	value	of	the	zone	–	the	leftmost	value	≥	5	mm.

37 The printing zone is narrower than the minimum  
width (5 mm).

Set	the	rightmost	value	of	the	zone	–	the	leftmost	value	≥	5	mm.

38 Partial is invalid on the DI channel. –
39 The bias and the calibration cannot be used 

simultaneously.
–

40 Datume	value	(1	>=	2) Set the correction point (measured value) of the first point less 
than that of the second point in the calibration correction.

41 Datume	value	(n-1	>	n) Set the correction point (measured value) of the n–1th point less 
than or equal to that of the nth point in the calibration correction.

42 Revise	value	(n-1	>=	n) Set the correction value of the n–1th point less than that of the nth 
point in the calibration correction.

47 All items in DISP menu parameters are set to SKIP. –
48 Start = Finish. The DST start time and end time cannot be set to the same time.
49 Invalid or missing DST time settings. Since the time gains one hour when the DST starts, the set-up 

time does not exist.
61 There is no channel specified by the MATH 

expression.
Set a computation channel.

62 MATH expression grammar is incorrect. Enter the equation correctly.
63 MATH expression sequence is incorrect. Enter the equation correctly.

Chapter 10 Troubleshooting
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Code Message Explanation/Countermeasures
64 MATH upper and lower span values are equal. This is not allowed.
70 MATH constant description is incorrect. Incorrect computation constant syntax.
71 The range of the MATH constant is exceeded. –
72 MATH channel is turned off –
81 All space or ‘quit’ string cannot be specified. –
86 The key-lock release password is incorrect. Enter the correct password.
87 This key is locked. –
91 Password is incorrect. Enter the correct password.
100 IP address doesn’t belong to class A, B, or C. –
101 The result of the masked IP address is all 0s or 1s. –
102 SUBNET mask is incorrect. Set a correct subnet mask.
103 The net part of default gateway is not equal to  

that of IP address.
Set the correct default gateway.

151 This action is invalid during calculation. –
160 This action is invalid during chart end. –
161 This action is invalid during pen hold. –
162 Cannot set an number for a skipped data. –
163 This action is invalid during record. –
164 This action is invalid during manual printing. –
165 This action is invalid during list printing. –
166 This action is invalid during setup list printing. –
167 This action is invalid during chart feed. –
169 This action is invalid during ribbon hold. –
170 This action is invalid during priority remote record. Recording stop via communications or key operation cannot be 

accepted under the current settings. Perform the Stop using the 
remote control function.

171 This action is invalid during batch. Cannot enter Basic Setting mode during header printout (until 
End printout is finished).

172 Action not executable while accessing SD card. Cannot be executed while the SD memory card is being 
accessed.

173 Action not executable while data save is in progress. Cannot be executed while data is being saved.
174 Action not executable while data replay is in progress. Cannot be executed while data is replayed.
175 Ejecting SD card is not possible. The SD memory card cannot be ejected currently. Try again 

later.
176 File already exists. Unable to save because a file with the same name already 

exists. Change the file name.
177 File does not exist. The specified file does not exist. Check the file name.
178 There is no SD card. Insert the SD memory card properly.
179 Please acknowledge all active alarms. Perform alarm acknowledge operation (alarm ACK).

Operation Errors
Code Message Explanation/Countermeasures
232 There is no available data. There is no data for periodic printout or data for calculating 

TLOG when the timer expired.
233 SD card access error. Unable to access the SD memory card. Check that the SD 

memory card is inserted properly, that there is enough free 
space, and that the card is not locked.

234 The file is damaged. The file is corrupt.
235 The file is not supported. Data replay is not possible because the model, option, or version 

is different.

Communication Errors
Code Message Explanation/Countermeasures
300 Command is too long. –
301 Too many number of commands delimited with ’;’. Keep the number of commands separated by sub delimiters 

under 10.
302 This command has not been defined. –
303 Data request command can not be enumerated with 

sub-delimiter.
–

350 Command is not permitted to the current user level. –
351 This command cannot be specified in the current mode. –

10.1  A List of Error Messages
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Code Message Explanation/Countermeasures
352 The option is not installed. –
353 This command cannot be specified in the current setting. –
354 This command is not available during calculation. –
390 Command error. –
391 Delimiter error. –
392 Parameter error. –
393 No permission. –
394 No such connection. –
395 Use “quit” to close this connection. Attempted to disconnect its own connection.
396 Failed to disconnect. –
397 No TCP control block. The control block of the specified connection cannot be found.
400 Input username. –
401 Input password. –
402 Select username from ‘admin’ or ‘user’. If the recorder is configured not to use the user name and 

password, use user names ‘admin’ or ‘user’.
403 Login incorrect, try again! –
404 No more login at the specified level is acceptable. –
420 Connection has been lost. –
421 The number of simultaneous connection has been 

exceeded.
–

422 Communication has timed-out. –

Warning Messages
Code Message Explanation/Countermeasures
600 Initialized. Settings and measured data have been initialized. If this 

message always appears when you turn the power off and then 
back on, contact your nearest YOKOGAWA dealer.

612 Some items not set. Some of the settings could not be loaded because the model, 
the number of channels, options, the setup items in basic setting 
mode, or the like was different.
If you change a setup item in Basic Setting mode from the 
Configuration Software, load the settings of Basic Setting mode. 
See “Loading the Settings of Basic Setting Mode and Setting 
Mode”	in	“Loading	Setup	Data”	of	the	μR10000/μR20000	SD	
Memory Card (/EM1 Option) User’s Manual (IM 04P01B01-03E).

613 Less than 10% free space on the SD card. The amount of free space on the SD memory card is low. Stop 
recording to the SD memory card and replace the SD memory card.

614 Less than 25 MB free space on the SD card. The amount of free space on the SD memory card is low. 
Replace the SD memory card.

System Errors
Code Message Explanation/Countermeasures
902 RAM failure. Contact your nearest YOKOGAWA dealer.
910 A/D error. Contact your nearest YOKOGAWA dealer.
921 A/D calibration value error. Contact your nearest YOKOGAWA dealer.
922 A/D calibration is in the wrong order. Contact your nearest YOKOGAWA dealer.
930 Memory acquisition failure. Contact your nearest YOKOGAWA dealer.
940 The ethernet module is down. Contact your nearest YOKOGAWA dealer.
950 A/D number error. Contact your nearest YOKOGAWA dealer.
951 EEPROM write error. Contact your nearest YOKOGAWA dealer.
960 Ribbon error Contact your nearest YOKOGAWA dealer.
961 Printer error Contact your nearest YOKOGAWA dealer.
962 Plotter error Contact your nearest YOKOGAWA dealer.
963 Pen 1 error Contact your nearest YOKOGAWA dealer.
964 Pen 2 error Contact your nearest YOKOGAWA dealer.
965 Pen 3 error Contact your nearest YOKOGAWA dealer.
966 Pen 4 error Contact your nearest YOKOGAWA dealer.
B5 (No messages) Contact your nearest YOKOGAWA dealer.
B6 (No messages) Contact your nearest YOKOGAWA dealer.

10.1  A List of Error Messages
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10.2 Troubleshooting Flow Charts

Follow the flow charts to correct the problem.

Is the power supply 
connected properly?

Is the power supplied 
properly?

NO

NO

NO

YES

YES

YES

Nothing works (pen and chart paper do not move).

Is the power switch 
turned ON? Does the switch 

work properly?

Connect properly.

Turn ON the power properly.

Contact your nearest 
YOKOGAWA dealer.

Section 2.5

Section 2.6

Supply the power at the specified 
voltage and frequency.

Does the input meet 
the specifications?

NO

NO

YES

YES

• The reading error is large.
• The indication is unstable.
• The pen is off the scale on either the 0% or 100% side.

Adjust the span and range.

Change the input to meet
the specifications.           

Are the span and range 
settings correct?

To the next page
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NO

NO

NO

YES

YES

YES

Is the input wiring correct?

• Attach the input terminal cover properly.
• Protect the input terminal from wind or fans.
• Keep the temperature fluctuation near the input
 terminal to a minimum.

Is the input free of noise?

Is the environmental 
temperature kept constant?

• Separate the input wiring from the noise source.      
• Ground the recorder properly.
• Ground the measured object properly.
• Insulate the TC from the measured object.
• Use shielded cables for input.
 Select the integration time of the A/D converter
 (See section 7.2).
• Use input filter (pen model: see sections 7.12 and 
 6.2), moving average (dot model: see sections 
 7.11 and section 6.3).

• Wire correctly (see section 2.3).
• Install the terminal block correctly.
• Fasten the terminal screws correctly.
• Insulate the RTD from ground.
• If burnt, replace the TC.

Is the input wiring parallel 
with other equipment?

NO

NO

YES

YES

Is the RJC setting 
correct (TC input)?

• Stop the TC burnout upscale/
 downscale function of other equipment.
• Ground the recorder and other equipment at the 
 same grounding pole.
• Disconnect parallel wiring.
 (Use a double-element TC, for instance.)

Set correctly. Section 7.4

YES

From the previous page

Contact your nearest 
YOKOGAWA dealer.

NO

YES

Is the pen 
position and dot 

printing position adjustment 
correct?

Adjust the pen position or dot printing position                        Section 11.5
Section 11.6

10.2  Troubleshooting Flow Charts
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Is the input free of noise? NO

YES

• Separate the input and 
  communication wiring from the 
  noise source.
• Ground the recorder properly.
• Use shielded cables for input and 
  communication wiring.
• Insert an isolation transformer 
  into the power line.
• Insert a power line filter into the 
  power line.
• If an inductive load is connected 
  to an alarm contact output, use a 
  surge suppresser on that line.

Contact your nearest 
YOKOGAWA dealer.

Display and other functions do not work properly.

Is the key lock released? NO

YES

Release the key lock using the 
FUNC key (see section 3.13).

Contact your nearest 
YOKOGAWA dealer.

Keys do not work.

Is the customize 
menu released?

NO

YES

Disable the Customized Menu 
with a key operation (see section
7.22).

Contact your nearest 
YOKOGAWA dealer.

Some of the menus are not displayed.
Unable enter Basic Setting mode.

10.2  Troubleshooting Flow Charts
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11.1 Periodic Inspection

Check the operation periodically to keep the recorder in good working order.
Perform the following checks and replace worn parts as needed.

•	 Is	the	indication	and	recording	functioning	properly?	If	not,	see	chapter	10.
•	 Are	recorded	lines	or	printed	characters	clear	(not	blurred)?
 For the replacement procedure of felt pens and plotter pens, see section 3.3 (pen 

model).
 For the replacement procedure of the ribbon cassette, see section 3.4 (dot model).
•	 Is	the	chart	paper	feeding	properly	(no	paper	jams)?	If	not,	see	chapter	10.
•	 Is	there	enough	chart	paper	remaining?
 Remaining chart length is printed on the left margin of the chart at intervals of 20 cm.
 For the chart paper replacement procedure, see section 3.2.

  

Remaining amount of chart paper

Chapter 11 Maintenance
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11.2 Cleaning the Recorder

CAUTION
• When cleaning, be sure not to scratch the flexible printed circuit board of the 

plotter carriage.
• Do not apply lubricating oil to the shaft.

Pen Model
To maintain smooth operation, it is recommended that the plotter carriage shaft be 
cleaned once a year.

Cleaning Procedure
Wipe the dust off the plotter carriage shaft using a soft lint-free cloth or paper.
If the dirt does not come off easily, apply ethyl alcohol to the cloth or paper.

  

Plotter carriage

Shaft

Dot Model
To maintain smooth operation, wipe the dust off the two shafts of the printer carriage 
using a soft lint-free cloth or paper. It is recommended that these shafts be cleaned once 
a year.

  

Printer carriage

Shaft
Shaft
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11.3 Replacing the Internal Light LED

If the brightness of the internal light degrades with time, replace the LED.
For the replacement parts, see section 11.7.

CAUTION
• The LED is connected to the internal circuitry through the flexible printed circuit 

board. Do not pull the LED with force.
• Be sure not to break the flexible printed circuit board.

Replacement Procedure
1. Open the door and turn OFF the power switch.
2. Open the display and key panel section.
3. Pull out the internal light LED assembly. The LED assembly is attached to the left 

and right of the display and key panel section.

     

Display and key panel

LED assembly

LED assembly

4. Remove the LED assembly from the connector of the flexible printed circuit board.

    

LED assembly

Connector

Flexible printed 
circuit board

Flexible printed 
circuit board

LED assembly

Connector

5. Connect the new LED assembly.
6. Push the LED assembly back into the display and key panel section.

Be	sure	not	to	bend	or	scratch	the	flexible	printed	circuit	board.

    Flexible printed circuit board

LED assembly

7. Turn the power switch ON and check that the internal light comes on a few 
seconds later.
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11.4 Calibrating the Recorder

Calibrate the measured value against the input.
It is recommended that the recorder be calibrated once a year to assure its measurement 
accuracy.
For details regarding calibration, contact your nearest YOKOGAWA dealer.

Required Instruments
A calibration instrument with appropriate resolution is required for calibrating the recorder.
Recommended Instrument
• DC voltage standard: Model 9100 by FLUKE or equivalent
 Main Specifications
 Output accuracy: ±(0.005% + 1 µV)
• Decade resistance box: Yokogawa Test & Measurement Model 2793-01 or equivalent
 Main Specifications
	 Accuracy	of	output	range	0.1	to	500	Ω:	±(0.01%	+	2	mΩ)
	 Resolution:	0.001	Ω
• 0°C standard temperature device: ZC-114/ZA-10 by Coper Electronics or equivalent
 Main Specifications
 Standard temperature stability accuracy: ±0.05°C

For information on purchasing the calibration instruments, contact your nearest 
YOKOGAWA dealer.

Calibration Procedure
1. Wire the recorder and the calibration instrument as shown in the following figure, 

and adequately warm up the instruments (the warm-up time of the recorder is at 
least 30 minutes).

2. Check that the operating environment such as ambient temperature and humidity 
is within the normal operating conditions (see section 12.6).

3. Apply appropriate input signals corresponding to 0%, 50%, and 100% of the input 
range and calculate the errors from the readings.
If	the	error	is	outside	the	accuracy	specifications,	contact	your	nearest	YOKOGA-
WA dealer.

Note
For thermocouple inputs, you must measure the temperature of the input terminal and apply a 
voltage taking into account the reference junction temperature.

DC Voltage Measurement

  

DC voltage standard

+
–

Input terminal

L
N

µR20000+/A–/B
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Temperature Measurement When Using an RTD

  

Decade resisitance box

The resistance of three lead 
wires must be equal.

(Model 2793-01 from Yokogawa
 Test & Measurement)

Input terminal

+/A/b –/B µR20000

L
N

Temperature Measurement When Using a Thermocouple
Thermocouple wires or TC extension wiresCopper wires

DC voltage standard

+
-

Input terminal

µR20000

Thermocouple 
wires

Copper 
wires

(0°C standard temperature device  
ZC-114/ZA-10 by Coper Electronics)

+/A–/B

L
N

RJC of TC input
As the measurement terminal of the recorder is generally at room temperature, the actual 
output of the thermocouple is different from the values given on the thermoelectromotive 
force table based on 0°C. The recorder performs compensation by measuring the 
temperature at the input terminal and adding the corresponding thermoelectromotive 
force to the actual output of the thermocouple. Therefore, when the measurement 
terminal is shorted (equivalent to the case when the detector tip is 0°C), the measured 
value indicates the temperature of the input terminal.
When calibrating the recorder, this compensation voltage (thermoelectromotive force of 
0°C reference corresponding to the input terminal temperature) must be subtracted from 
the output of the DC voltage standard before application. As shown in the figure, by using 
the 0°C standard temperature device to compensate the reference junction at 0 °C, you 
can input the thermoelectromotive force of 0 °C reference from the DC voltage standard 
and perform the calibration.

11.4  Calibrating the Recorder
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11.5 Adjusting the Pen Position (Pen Model)

This section explains the details of adjusting the pen position on the chart paper.
It is recommended that the pen be adjusted once a year to assure its recording accuracy.

Note
Pen position is adjusted under standard operating conditions when the recorder is shipped from 
the factory. Because the chart paper may expand or contract depending on the environment in 
which the recorder is used, it is recommended that the position be readjusted before use.

Procedure
1. Warm up the recorder for at least 30 minutes.

2. Check that the operating environment such as ambient temperature and humidity 
is within the normal operating conditions (see section 12.6).

3. Hold down the MENU  key for 3 seconds to enter Setting mode.

4. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

5. Press the  key or SHIFT+  key to select P_Adj and then press the  key.

6. Press the  key to select Zero (left edge of the chart paper) or Full (right edge 
of the chart paper) and then press the 	key.	Adjust	Zero	first	and	then	Full.

7. Select the Pen No.

8. Adjust the pen position.
Increase or decrease the setting to align the pen position with the scale line on 
the chart paper. Then, press the  key. To change the setting, press the  
key to move the cursor and  key to change the value.
The pen moves after the  key is pressed.
A value change of 1 corresponds to 0.033 mm change in the pen position. De-
creasing the value moves the pen to the left and increasing the value moves the 
pen to the right.

9. Press the  key to set adjust other pens.
Press the ESC	key	to	finish	the	adjustment.	The	screen	returns	to	the	
Basic=P_Adj screen.

  
Select the pen No.

Select Zero or Full.

Change the value to adjust the pen 
position.

The pen moves.
ESC/?

Basic=P_Adj

P_Adj=Zero

P_Adj
Setting complete

Pen No.=1

Zero=40
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Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key. Press 
the  key to select Store and then press the  key. The changes are applied, and 
the screen returns to Operation mode. If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode. Press the ESC key to 
return to the Basic= screen.

Note
When the Customized Menu is enabled, the operation is different.
• When “P_Adj” in the Customized Menu is On

1. Perform steps 1-4 of “Adjusting the Pen Position.”
2. When the instrument enters Basic Setting mode, “Menu kind” appears. Select “Free” 

then press a  key.
3. Perform the steps starting with step 5 of “Adjusting the Pen Position.”

•	 When	“P_Adj”	in	the	Customized	Menu	is	Off
 See “Disabling the Customized Menu” or “Changing the Settings without Disabling the Basic 

Setting Mode Lock.”

<Related Topics>   Enabling/Disabling the customized menu: Section 7.22 
Changing the settings without releasing the basic setting mode lock: 
Section 7.22

11.5  Adjusting the Pen Position (Pen Model)
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11.6 Adjusting the Dot Printing Position (Dot Model)

This section explains the details of adjusting the dot printing position on the chart paper.
It is recommended that the position be adjusted once a year to assure its recording 
accuracy.

Note
Dot printing position is adjusted under standard operating conditions when the recorder is 
shipped from the factory. Because the chart paper may expand or contract depending on the 
environment in which the recorder is used, it is recommended that the position be readjusted 
before use.

Procedure
1. Warm up the recorder for at least 30 minutes.

2. Check that the operating environment such as ambient temperature and humidity 
is within the normal operating conditions (see section 12.6).

3. Hold down the MENU  key for 3 seconds to enter Setting mode.

4. Hold down the  and  keys simultaneously for 3 seconds to enter Basic 
Setting mode.

5. Press the  key or SHIFT +  key to select P_Adj and then press the  
key.

6. Press the  key to select Hysteresis, Zero (left edge of the chart paper), or 
Full (right edge of the chart paper) and then press the  key. Adjust Hysteresis 
first	followed	by	Zero	and	then	Full.

 Adjusting the Hysteresis
 A line is drawn on the chart paper If the line appears as shown in Figure a, increase 

the displayed setting. Then press the  key. If the line appears as shown in Figure b, 
decrease the displayed setting. Then, press the  key.

 To change the setting, press the  key to move the cursor and  key to change 
the value.

 Repeat this procedure until the line becomes straight.
 A value change of 1 corresponds to 0.1 mm change in the dot printing position.

   

Up
Down

Up
Down

Down
Up

Figure a Figure b
Shows the movement of 
the printer carriage.

Shows the printed dots.

 Adjusting Zero and Full
 A line is drawn to the left edge for Zero and right edge for Full.
 Increase or decrease the displayed setting so that the drawn line is aligned with the 

scale line on the chart paper. Then, press the  key. The procedure of changing the 
setting is the same as with the adjustment of hysteresis.

 The line moves after the  key is pressed.
 A value change of 1 corresponds to 0.1mm change in the dot printing position. 

Decreasing the value moves the line to the left and increasing the value moves the 
line to the right.
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7. Press the ESC key to finish the adjustment. The screen returns to the 
Basic=P_Adj screen.

  

Select  Hysteresis, Zero, or Full.

Change the value to adjust the dot 
printing position.

The dot printing position moves.
ESC/?

Basic=P_Adj

P_Adj=Hysteresis

P_Adj
Setting complete

Hysteresis=-2

Applying the Changes and Returning to Operation Mode
Press the  key or SHIFT +  key to select End and then press the  key.  Press 
the  key to select Store and then press the  key.  The changes are applied, and 
the screen returns to Operation mode.  If you select Abort and press the  key, the 
changes are discarded, and the screen returns to Operation mode.  Press the ESC key 
to return to the Basic= screen.

Note
When the Customized Menu is enabled, the operation is different.
• When “P_Adj” in the Customized Menu is On

1. Perform steps 1-4 of “Adjusting the Dot Printing Position.”
2. When the instrument enters Basic Setting mode, “Menu kind” appears. Select “Free” 

then press a  key.
3. Perform the steps starting with step 5 of “Adjusting the Dot Printing Position.”

•	 When	“P_Adj”	in	the	Customized	Menu	is	Off
 See “Disabling the Customized Menu” or “Changing the Settings without Disabling the Basic 

Setting Mode Lock.”

<Related Topics>   Enabling/Disabling the customized menu: Section 7.22 
Changing the settings without releasing the basic setting mode lock: 
Section 7.22

11.6  Adjusting the Dot Printing Position (Dot Model)
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11.7 Recommended Replacement Periods for Worn 
Parts

To preserve the reliability of the recorder and to use the recorder in good condition for 
an extended time, it is recommended that periodic replacements be made on parts. The 
replacement parts may change to accommodate preventive maintenance over extended 
time. Be sure to check with your nearest YOKOGAWA dealer.
The table below shows the recommended replacement period for expendable parts.
The replacement period shown here applies when the recorder is used under standard 
operating conditions. For the actual replacement period, consider the actual conditions of use.
Replacement of parts other than the chart paper, pen, ribbon cassette, and internal light 
LED will be carried out by a YOKOGAWA engineer or an engineer certified by YOKOGAWA. 
Contact your nearest YOKOGAWA dealer when such replacement is necessary.

Note
The replacement period of the display and the internal light LED is the half life of the brightness. 
The deterioration of brightness varies depending on the condition of use, and its determination 
is subjective. Consider these facts for determining the actual replacement period.

Pen Model
Item Replacement 

Period Part Name Part No. Note Quantity 
Used

Z-fold chart paper 41 days
33 days CHART B9573AN When used at 20 mm/h

When used at 25 mm/h 1

Felt pen 2 km PEN ASSY
B9902AM 
B9902AN 
B9902AP 
B9902AQ

Red 
Green 
Blue 
Violet

At a pen speed of 
10 cm/s 1 each

Plotter pen 60,000 
characters** PEN ASSY B9902AR When printing continuously 1

Display 5 years* DISPLAY  ASSY B8802CA    1
Chart paper feed 
motor 5 years MOTOR ASSY B9905GS 1

Plotter carriage 5 years CARRIAGE ASSY B8802CV 1
Plotter motor 5 years MOTOR ASSY B9905NS For the X-axis 1
Lever 5 years Lever ASSY B9900RH For the plotter 1

Pen servo 5 years SERVO ASSY B8802KE Shared by all pens (excludes 
the pen arm ASSY) 1 to 4

Internal light LED 2 years* LED ASSY B8800CR 2
* The half life of the brightness at the factory default brightness setting.
** Smearing may occur around the ridge-folding part of the chart paper.

Dot Model
Item Replacement 

Period Part Name Part No. Note Quantity 
Used

Z-fold chart paper 41 days
33 days CHART B9573AN When used at 20 mm/h

When used at 25 mm/h 1

Ribbon cassette 3 months RIBBON CASSETTE B9906JA 1
Display 5 years* DISPLAY ASSY B8802CA 1
Chart paper feed 
motor 5 years MOTOR ASSY B9905GS 1

Pulley 3 years PULLY B9901EY For the carriage 2
Carriage motor 5 years MOTOR ASSY B9906FX 1
Carriage 5 years CARRIAGE ASSY B8803BB 1
Ribbon shift motor 5 years MOTOR ASSY B9906FS 1

Ribbon shift gear 5 years Ribbon Swing Gear 
ASSY B8803BS 1

Ribbon feed motor 5 years MOTOR ASSY B9906GL 1

Ribbon feed gear 5 years RIBBON HOLDER 
ASSY B8803AJ Included RIBBON FEED 

MOTOR, RIBBON HOLDER 1

Internal light LED 2 years* LED ASSY B8800CR 2
* The half life of the brightness at the factory default brightness setting.
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12.1 Input Specifications

Number of Inputs and Scan Interval on the Pen Model
Item Specifications
Number of inputs 1, 2, 3, or 4
Scan interval 125 ms

Number of Inputs and Scan Interval on the Dot Model
Item Specifications
Number of inputs 6, 12, 18, or 24
Scan interval Integration time of 

the A/D  converter 20 ms/16.7 ms 100 ms
Model

6 dot 1 sec 2.5 sec
12 dot 2.5 sec 5 sec
18 dot 2.5 sec 10 sec
24 dot 2.5 sec 10 sec

Input Type
Item Specifications
Input type DC voltage, 1-5V, TC, RTD, DI (ON/OFF input), DC current (by adding an external shunt resistor)
Input Range and Measurable Range

Input Range Type Measurable Range
Volt 20 mV –20.00 to 20.00 mV

60 mV –60.00 to 60.00 mV
200 mV –200.0 to 200.0 mV
2 V –2.000 to 2.000 V
6 V –6.000 to 6.000 V
20 V –20.00 to 20.00 V
50 V –50.00 to 50.00 V
1-5V (0.800 to 1.200 V range) to (4.800 to 5.200 V range)

TC R1 0.0 to 1760.0°C 32 to 3200°F
S1 0.0 to 1760.0°C 32 to 3200°F
B1 0.0 to 1820.0°C 32 to 3308°F
K1 –200.0 to 1370.0°C –328 to 2498°F
E1 –200.0 to 800.0°C –328.0 to 1472.0°F
J1 –200.0 to 1100.0°C –328.0 to 2012.0°F
T1 –200.0 to 400.0°C –328.0 to 752.0°F
N1 0.0 to 1300.0°C 32 to 2372°F
W2 0.0 to 2315.0°C 32 to 4199°F
L3 –200.0 to 900.0°C –328.0 to 1652.0°F
U3 –200.0 to 400.0°C –328.0 to 752.0°F
WRe4 0.0 to 2400.0°C 32 to 4352°F

RTD PT (Pt100)5 –200.0 to 600.0°C –328.0 to 1112.0°F
JPT (JPt100)5 –200.0 to 550.0°C –328.0 to 1022.0°F

DI Level 0: Less than 2.4 V, 1: Greater than or equal to 2.4 V
Within ±6 V

Contact6 0: Open, 1: Closed
1 R, S, B, K, E, J, T, N: IEC 584-1 (1995), DIN IEC 584, JIS C1602-1995
2 W: W-5% Re/W-26% Re (Hoskins Mfg. Co.), ASTM E988
3 L: Fe-CuNi, DIN 43710, U: Cu-CuNi, DIN 43710
4 WRe: W-3%Re/W-25%Re (Hoskins Mfg. Co.)
5 Pt100: JIS C 1604:2013, IEC 60751:2008, DIN EN 60751:2009 

JPt100: JIS C1604-1989, JIS C1606-1989 
Measurement current: i = 1 mA (Pt100, JPt100)

6 Detected	current	value:	approx.	10	μA

Chapter 12 Specifications
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Item Specifications
Input type Floating unbalanced input.

Isolation between channels (except, b terminal is shared for RTD input).
Burnout Detection of TC Can be set for each channel.

Upscale/Downscale switchable.
Input Type Operating Conditions
TC input 2	kΩ	or	less:	normal,	10	MΩ	or	more:	burnout,	detection	current:	approx.	10	µA
1-5V input 0.2 V or less: burnout

RJC of TC input Set whether to use the recorder RJC function or an external RJC function for each channel.
Set the compensation voltage when using an external RJC function.
Compensation voltage range: –20000 µV to 20000 µV.

A/D converter
Resolution 16 bits
Integration time Pen model: Selectable from 20 ms (50 Hz), 16.7 ms (60 Hz), and Auto (auto switch between 20 ms 

and 16.7 ms according to the power supply frequency).
Dot model: Selectable from 20 ms (50 Hz), 16.7 ms (60 Hz), 100 ms and Auto (auto switch 

between 20 ms and 16.7 ms according to the power supply frequency).
Filter function (pen model) Filter ON/OFF switchable for each channel.

Time constant selectable from 2, 5, and 10 s.
Moving average function
(dot model)

Moving average ON/OFF switchable for each channel.
The number of samples of the moving average is selectable between 2 and 16.

Input Computation (Standard Function)
Item Specifications
Delta computation Calculates the difference between two channel inputs using the following equation.

Delta = (the input value of the channel set to delta computation) – (the input value of the 
reference channel)
where (reference channel number) < (channel number set to delta computation).

Computable input type: DC voltage, TC, and RTD. The channel set to delta computation and the 
reference channel is set to the same range type.

Linear scaling Scales the input value to a value with a unit suitable for the application.
Computable input type: DC voltage, TC, RTD, DI
Value after scaling

Mantissa: –20000 to 30000
Decimal place: Can be set arbitrarily
Unit: Can be set arbitrarily (up to 6 characters)

Displayable and printable range
–19999 to 31500

Computation on the 1-5V input
Linear scaling Linearly scales the 1-5V signal.

Value after scaling: Same as linear scaling.
Displayable and printable range: Same as linear scaling.

Low-cut function Sets values below 0% of the recording span to the leftmost value of the scale. The leftmost value of 
scale must be less than the rightmost value of scale.

Square root computation Takes the square root of the input value and linearly scales the result.
Computable input type: DC voltage

Linear scaling Value after scaling: Same as linear scaling.
Displayable and printable range: Same as linear scaling.

Low-cut function Sets values below the low-cut point to the leftmost value of scale. The leftmost value of scale must 
be less than the rightmost value of scale.

Low-cut point range: 0.0 to 5.0% of the recording span (0.1% steps)
Bias Adds a bias to the measuring input value.

Bias value range: ±10% of the span of the measurable range at the specified range type.
±10% of the scaling span if linear scaling is used.

12.1  Input Specifications
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12.2 Alarm Function Specifications

Item Specifications
Number of alarms Up to four alarms (level) for each measurement channels.
Alarm types High limit (H), low limit (L), difference high limit (h), difference low limit (l), high limit on rate-of-

change (R), low limit on rate-of-change (r), delay high limit (T), delay low limit (t). The symbol 
indicating the alarm is given in parentheses.
Rate-of-change calculation interval of rate-of-change alarms (can be set individually for the high 
limit on rate-of-change and low limit on rate-of-change alarms)

Rate-of-change calculation interval = Scan interval × the number of sampled data
where the number of sample data is a value between 1 and 15

Alarm delay time of delay high and low limit alarms (can be set for each channel, common within a 
channel)

1 to 3600 s (1 hour)
However, if the alarm delay time setting is not an integer multiple of the scan interval, the alarm 
delay time is set to a value that is the first integer multiple of the scan interval exceeding the 
delay time setting.

Hysteresis Set a width to the value for detecting alarm occurrence/release (common to all channels and all 
levels)
Applied to high limit alarm and low limit alarm.
Hysteresis range: Approx. 0.0% to 1.0% of the recording span (0.1% steps)

Display Indicates the alarm occurrence status on the display.
Indication for each channel: Displays the alarm type (display precedence: H, L, T, t, h, l, R, and r).
Alarm summary display: Displayed using an icon.
Displays the alarm point mark and status on the bar graph.

Non-hold/hold operation of alarm indication
Turn ON/OFF the indication along with the alarm occurrence/release (non-hold) or hold the 
indication until the alarm ACK operation.

Alarm relay contact output (optional specifications)
See section 12.5
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12.3 Recording Function Specifications

Trend Recording (Pen Model)
Item Specifications
Recording pen Disposable felt pen
Step response time Approx. 1.5 s (using the IEC61143 measurement method)
Number of pens Up to 4
Recording color Pen 1: Red, pen 2: Green, pen 3: Blue, pen 4: Violet
Trend recording Updates the data at the scan interval. Continuous recording.
Pen offset compensation Records by compensating for the offset of each pen along the time axis.
Chart speed 5 to 12000 mm/h (82 steps).
Zone recording Recording zone can be specified for each channel.

Recording width: 5 mm or more (1 mm steps)
Partial expanded recording Records by expanding the right or left side of the boundary position (the other section is reduced).

Boundary position: 1 to 99%
Boundary value: Within the recording span range

Trend Recording (Dot Model)
Item Specifications
Recording method Trend recording by a 6-color wire dot printer
Recording color Purple, Red, Green, Blue, Brown, Black
Trend recording interval Records at the following interval through a raster scan system.

Auto: Synchronizes to the chart speed and automatically sets to the interval so that the dots 
do not overlap many times.

Fix: 10 s/6 channels, 15 s/12 channels, 20 s/18 channels, 30 s/24 channels 
Chart speed 1 to 1500 mm/h (1 mm steps)
Recording ON/OFF Recording can be turned ON/OFF for each channel.
Zone recording Same as the pen model.
Partial expanded recording Same as the pen model.

Chart Paper
Item Specifications
Printing width 180 mm
Type/Length Z-fold type. Approx. 20 m.
Chart paper feeding accuracy

Within ±0.1% After feeding 1000 mm and with respect to the print scale on the chart paper.
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Printouts (Pen Model)
Item Specifications
Recording pen (color) Plotter pen (purple)
Alarm printout Prints alarm occurrence/release.

Printout contents Occurrence ( )/release ( ) marks, channel number or tag, alarm type, alarm level, time, printout 
buffer overflow mark.

Time printout format Selectable from hour:minute, hour:minute:second, month:day:hour:minute, month:day:hour:minute:
second, and year:month:day:hour:minute:second.

Alarm printout buffer Stores 24 occurrences of alarm information waiting to be printed.
Periodic printout Prints at specified time intervals from the reference time.

Interval Reference time: 00 hour 00 minute to 23 hour 00 minute (1 hour steps, minute fixed)
(see appendix 2) Auto: Automatically determined from the chart speed.

Manual: Select 10 min, 12 min, 15 min, 20 min, 30 min, 1 hour, 2 hours, 3 hours, 4 hours, 
6 hours, 8 hours, 12 hours, or 24 hours.

Mode Selectable from disable periodic printout, print instantaneous values, and print report data (report mode).
Report data: Selectable from the average, minimum, maximum, minimum/maximum/average, sum 
value, and instantaneous value.

Printout contents For instantaneous values: Date/Time, offset compensation ON/OFF, channel information (measured 
value, alarm status, unit, delta computation ON/OFF, scale, channel 
number or tag, recording color), chart speed (with time ticks)

For report data: Report start/end date/time, offset compensation ON/OFF, events, channel 
information (value, unit, range change occurrence, scale, recording color), chart 
speed (with time ticks)

Message printout Prints preset message strings.
Number of messages 5
Printout contents Time, message (up to 16 characters), printout buffer overflow mark.
Time printout format Selectable from hour:minute, hour:minute:second, month:day:hour:minute,  

month:day:hour:minute:second, year:month:day:hour:minute:second, and not print.
Message printout buffer Stores 5 messages waiting to be printed.

Recording start printout Prints at the start of recording.
Printout contents Time and chart speed, printout buffer overflow mark.
Time printout format Selectable from hour:minute, hour:minute:second, month:day:hour:minute,  

month:day:hour:minute:second, and year:month:day:hour:minute:second.
New chart speed printout Prints when the chart speed is changed.

Printout contents Chart speed and time, printout buffer overflow mark.
Time printout format Selectable from hour:minute, hour:minute:second, month:day:hour:minute,  

month:day:hour:minute:second, and year:month:day:hour:minute:second.
Manual printout Prints the measured values of all channels and the computed results when computation mode is on.

Printout contents Measured values of all channels at that point.
Trend recording is temporarily suspended.

Setting printout (List) Prints the settings of items in Setting mode.
Printout contents Range setting, alarm setting, etc.

Trend recording is temporarily suspended.
Setting printout (Setup) Prints the settings of items in Basic Setting mode.

Printout contents Basic alarm specifications, basic recording specifications, etc.
Trend recording is temporarily suspended.

Items dependent on the 
chart speed Chart speed Periodic printout

Alarm printout 
Message printout 

Record start printout 
New chart speed printout

5 to 9 mm/h Not printed Printed
10 to 1500 mm/h Printed Printed

1600 mm/h or higher Not printed Not printed

Chart speed Periodic printout interval
10 to 18 mm/h 8 hours
20 to 36 mm/h 4 hours
40 to 72 mm/h 2 hours

75 to 135 mm/h 1 hour
150 to 180 mm/h 30 minutes
200 to 320 mm/h 20 minutes

360 to 1500 mm/h 10 minutes
Date printout format Select the printout format of the date from Y/M/D, M/D/Y, D/M/Y, D.M.Y, and M.D.Y. The format 

applies to the date printout of all printout items.

12.3  Recording Function Specifications
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Printout (Dot Model)
Item Specifications
Recording Dot printing.
Channel printout Prints the channel number or tag beside the trend recording every approx. 25 mm of chart paper.

Channel printout ON/OFF selectable.
Alarm printout Prints alarm occurrence/release.

Printout contents Occurrence ( , red)/release ( , blue) marks, channel number or tag, alarm type, alarm level, time, 
printout buffer overflow mark.

Time printout format Selectable from hour:minute, hour:minute:second, month day hour:minute, month day hour:minute:
second, and month day year hour:minute:second.

Alarm printout buffer Stores 24 occurrences of alarm information waiting to be printed.
Periodic printout Prints at specified time intervals from the reference time.

Interval (see  appendix 2) Same as the pen model.
Measured value Same as the pen model.
Printout contents For instantaneous values: Same as the pen model except offset compensation ON/OFF and 

recording color are not printed.
For report data: Same as the pen model except offset compensation ON/OFF and 

recording color are not printed.
Message printout Same as the pen model.
Recording start printout Same as the pen model. With time ticks.
New chart speed printout Same as the pen model. With time ticks.
Manual printout Same as the pen model.
Setting printout (List) Same as the pen model.
Setting printout (Setup) Same as the pen model.
Items dependent on the chart speed

6-dot model / 12-dot model 18-dot model / 24-dot model

Chart speed

Channel printout 
Alarm printout  

Message printout  
Record start printout  

New chart speed printout

Chart speed

Channel printout 
Alarm printout  

Message printout  
Record start printout  

New chart speed printout
1 to 9 mm/h Printed 1 to 9 mm/h Printed

10 to 100 mm/h Printed 10 to 50 mm/h Printed
101 to 1500 mm/h Not printed 51 to 1500 mm/h Not printed

Chart speed Periodic printout interval
6 dot model 12 dot model 18 dot model 24 dot model

1 to 9 mm/h Not printed Not printed Not printed Not printed
10 to 19 mm/h 8 hours 12 hours 12 hours 24 hours
20 to 39 mm/h 4 hours 8 hours 8 hours 12 hours
40 to 50 mm/h 2 hours 4 hours 4 hours 8 hours
51 to 79 mm/h 2 hours 4 hours Not printed Not printed

80 to 100 mm/h 1 hour 2 hours Not printed Not printed
101 to 1500 mm/h Not printed Not printed Not printed Not printed

Date printout format Same as the pen model.

Values for Special Measured Values
Same as “Special values” for the digital display on page 12-8.

12.3  Recording Function Specifications
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12.4 Display Function Specifications

Display and Displayed Contents
This section explains the specifications of the display functions of measurement channels and computation 
channels (/M1 option). Display examples are illustrations used to explain the displayed contents and differ in 
appearance from the actual displays.
Item Specifications
Display VFD (181 × 16, dot matrix)

Up to 20 characters using large fonts. 30 characters × 2 lines using normal fonts.
Number of screens 15 (switched using keys)
Displayed information

Display type 1CH digital display
2CH digital display
4CH digital display
6CH digital display (dot model)
12CH digital display (12-, 18-, or 24-dot model)
1CH digital + 1CH bargraph display
1CH digital + 4CH bargraph display (pen model)
2CH digital + 2CH bargraph display
4CH bargraph display (pen model)
Flag display
Channel alarm status display
Date, time, and chart speed display
DI/DO display (/Ax or /R1 option)
1CH digital display (tag display)
2CH digital display (tag display)
1CH digital + 1CH bargraph display (tag display)
1CH digital + 4CH bargraph display (tag display) (pen model)
Status display
System display
Batch name display (/BT1 option)
SD memory card status display (/EM1 option)
Lights out
Skip
Multiple display

The following screens can be assigned arbitrarily to the top and bottom sections of the display.
1CH digital display
2CH digital display
3CH digital display
Date/Time
Chart speed display
Channel alarm status display
1CH digital display (tag display)
Status display
Lights out

Display update of measured values / computed values
When displayed channels are fixed

Dot model: Updated at the scan interval
Pen model: Updated every 2 s

When displayed channels are automatically switched
Switches the channel and measured values at 1, 2, 3, 4, or 5 second intervals.

Status display
RECORD This indicator turns ON when recording is started and turns OFF when stopped.
ALARM The indicator turns ON when an alarm occurs and turns OFF when the alarm is released.

If the alarm indication is set to hold operation, the indicator blinks when an alarm occurs. When 
alarm ACK operation is performed, the indicator turns ON or OFF.

MATH This indicator turns ON when computation on the computation function (/M1 option) is started and 
turns OFF when stopped.

KEYLOCK This indicator turns ON when key lock is activated and turns OFF when released.
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Item Specifications
CHART END This indicator turns ON when the remaining amount of chart paper falls to approximately 2 cm on 

models with the FAIL/chart end detection and output function (/F1 option).
Display type specifications
Digital display

Measured value or computed value
• DC voltage input: Displays values between “the min. measurable value – 5% of the span of the 

measurable range” and “the max. measurable value + 5% of the span of the measurable range” 
of the range (example: –2.200 to 2.200 V for the 2 V range).

• TC and RTD input: Displays values for input values between “the min. measurable value – 10°C” 
and “the max. measurable value + 10°C” (example: –10.0°C to 1770.0°C for TC R)

• ON/OFF input (DI): Displays the input value 0 or 1.
• Linear scaling (1-5V, scaling, and square root): Displays value for input values between “the 

leftmost value of scale – 5% of scaling span” and “the rightmost value of scale + 5% of scaling 
span” (example: –5.0 to 105.0 when scaled to 0.000 to 100.0). However, the displayable range 
during scaling is from –19999 to 31500 (excluding the decimal). Values below –19999 and values 
above 31500 are displayed as –Over and +Over, respectively.

• Computation channel (/M1 option): Displays values in the range of –9999999 to 99999999.
Channel number Displayed with two characters (example: 01 and 0A)
Alarm Alarms are displayed using the symbols below. If multiple alarms are occurring simultaneously, the 

alarm with higher precedence is shown.
(Higher precedence) H, L, T, t, h, l, R, r (Lower precedence)

Special values Measurement channel
Status Display Description
+Over +Over See below.
–Over –Over See below.
Skip SKIP A value for channels set to skip.
Error ERROR Values such as when both the reference channel and measurement 

channel are +Over or –Over in delta computation.
+Burnout B.out A value displayed when a burnout is detected on a channel set to 

burnout up scale.
–Burnout B.out A value displayed when a burnout is detected on a channel set to 

burnout down scale.

+Over and –Over of measurement channels
A condition in which the value is outside the display range indicated in “Measured value or 
computed value” above. For example,
• For 2 V range, values below –2.200 V are –Over and values over 2.200 V are +Over.
• For TC R, values below –10.0°C are –Over and values over 1770.0°C are +Over.
• If scaled to 0.0 to 100.0, values below –5.0 are –Over and values above 105.0 are +Over. 

However, the displayable range during scaling is from –19999 to 31500 (excluding the decimal). 
Values below –19999 and values above 31500 are displayed as –Over and +Over, respectively.

Computation channel
Status Display Description
+Over +Over When the computed result exceeds 99999999.
–Over –Over When the computed results is less than –9999999.
OFF SKIP A value for channels set to Off.

Channel switching interval The switching interval of displayed channels can be set to 1 s, 2 s, 3 s, 4 s, or 5 s.
Bar graph display Displays the measured value on a bargraph.

Relationship between the digital display and bargraph
Displays the same channel on the digital display and bargraph. On the 2CH digital + 2CH bargraph 
display, the top bargraph is the left digital display channel and the bottom graph is the right digital 
display channel.

Scale Displays 10 equally spaced scale marks.
Alarm point mark For a channel set to delta computation, the alarm point marks of h and l are displayed. For all other 

channels, the alarm point marks of H, L, T, and t are displayed.
• Blinks on the bargraph when an alarm occurs. Stops blinking when the alarm is released.

Bar graph display mode Selectable from the two modes below.
• Set the base point of the bargraph to the left or right of the recording span whichever is smaller in 

value.
• Set the base point of the bargraph to the 50% position of the recording span.

12.4  Display Function Specifications
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Item Specifications
Flag display Displays measured values using flags.

Display channel The flag can be turned ON/OFF for each channel.
Flag (If flags overlap, the channel with the smallest number is displayed on top)

Scale Displays 10 equally spaced scale marks.
Channel alarm status display

Lists the alarm status of all channels using the symbols below.
Symbol Description
• Alarm is not set.
– Alarm is not occurring.
Channel number Alarm is occurring.

Displays the channel number when an alarm occurs and clears when the alarm is 
released.
If the alarm indication is set to hold operation, the indicator blinks when an alarm 
occurs. When alarm ACK operation is performed, the indicator turns ON (stop 
blinking) or OFF.

Date/time and chart speed display
Displays the date/time on the left and chart speed on the right.
The date display format can be selected. The format is common with the “Date printout format.”

DI/DO status display DI:Displays the ON/OFF state of the remote control input terminal (/R1 option).
DO: Displays the relay operation (active) of the alarm output terminal (/A1, /A2, /A3, /A4, or /A5 

option).
Multiple display (display in which different screens can be assigned to the top and bottom sections)

8 display types (see page 12-7) can be assigned to the top and bottom sections of the display (VFD).
Tag display Displays 7-digit tags in place of channel numbers.

See the digital display and bar graph display sections.
Status display Displays the status below. The display condition is the same as the status display under the main 

display (see page 12-7).
Alarm and chart end (/F1 option)

System display Displays system information by switching screens every 3 seconds. The main displayed contents 
are as follows:
Analog: Number of inputs
Option1, Option2: Options that are installed
Math: Number of computation channels
Periodic: Periodic printout interval
Interval: Trend recording interval (dot model)
POC: Pen offset compensation ON/OFF (pen model)
MAC address: MAC address
Version: Recorder version number (firmware version number)

Batch name display Batch name: Batch number (up to 26 characters) and lot number (4 or 6 digit number, or none) 
(/BT1 option)

SD memory card status 
display

Displays the SD memory card status, usage, free space, capacity, volume label, and the remaining 
length of time for saving data.

Lights out Displays nothing.
Skip Skips the screen during screen switching.

12.4  Display Function Specifications
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Name Description
1CH digital display

2CH digital display

4CH digital display

6CH digital display
(Dot model)

12CH digital display
(12-, 18-, or 24-dot model)

4CH bargraph display
(Pen model)

1CH digital + 1CH bargraph 
display

2CH digital + 2CH bargraph 
display

1CH digital + 4CH bargraph 
display (Pen model)

Mode: Displays “d” on channels “Delta computation” is set.
Alarm Value Unit

Measurement channel

Measurement channel

Measurement channel

Computation channel

Computation channel

Computation channel

Measurement channel

Computation channel

Value and bar graph of the same channel.
Uses the same digital display format as “1CH digital display.”

Bar graphs are assigned channels 1 to 4 from the top.
Uses the same digital display format as “2CH digital display.”

Bar graphs are assigned channels 1 to 4 from the top.

Digital display on the left and the top bar graph are for the same channel.  
Digital display on the right and the bottom bar graph are for the same channel.  
Uses the same digital display format as “4CH digital display.”

Value: 5 or 6 digits  
 “1”: channels 1 to 12,  “2”: channels 18 to 24

Displayable values are –19999 to 99999 and a decimal.  If this range is exceeded, the value 
is displayed as “+####” or “–####.”

Channel: 2 digits, mode: 1 digit, alarm: 1 digit, value: 7 digits, unit: 6 digits

Channel: 2 digits, alarm: 1 digit, value: 6 digits

Measurement channels
Channel: 2 digits, mode: 1 digit, alarm: 1 digit, value: 7 digits, unit: 6 digits
Computation channels
Channel: 2 digits, alarm: 1 digit, value: 9 digits, unit: 6 digits

Measurement channels
Channel: 2 digits, mode: 1 digit, alarm: 1 digit, value: 7 digits, unit: 3 digits
Computation channels
Channel: 2 digits, alarm: 1 digit, value: 9 digits, unit: 2 digits

Channel: 2 digits, alarm: 1 digit, value: 9 digits, unit: 6 digits

Channel: 2 digits, alarm: 1 digit, value: 6 digits

Channel

01dH-1999.9ABC 02dH-1999.9ABC
0AH9999999.9AB 0BH9999999.9AB

01dH-1999.9ABC 02dH-1999.9ABC

0AH9999999.9AB 0BH9999999.9AB

01H-1999.9 02H-1999.9 03H-1999.9
04H-1999.9 05H-1999.9 06H-1999.9

0AH-1999.9 0BH9999.9 0CH9999.9
0DH9999.9 0EH9999.9 0FH9999.9

999.9 999.9 999.9 999.9 999.9 999.9
999.9 999.9 999.9 999.9 999.9 999.9

01dH-1999.9ABCDEF
0AH9999999.9ABCDEF

01dH-1999.9ABCDEF

0AH9999999.9ABCDEF

01dH-1999.9ABCDEF

01dH-1999.9ABCDEF

0AH9999999.9ABCDEF

0AH9999999.9ABCDEF

1

12.4  Display Function Specifications



12-11IM 04P02B01-01E 

Specifications

11

22

33

44

55

66

77

88

99

1010

1111

1212

AppApp

IndexIndex

Name Description

Tag Alarm Value Unit Unit with 5 or 6 digits

Unit with 4, 5, or 6 digits

Measurement 
channel

Measurement channel
Computation channel

Measurement channel

Measurement channel

Computation 
channel

Computation channel

Computation channel

Tag_1CH digital display

Tag_2CH digital display

Tag_1CH digital + 1CH 
bargraph display

Tag_1CH digital + 4CH 
bargraph display (Pen model)

DI/DO display

Status display

System display

Displays the appropriate 
mark.

The displayed contents switches 
every three sconds.

Alarm Chart end

Flag display

Channel alarm status display

Time/chart speed display

Measurement channels 1 to 24
Computation channels 0A to 1P

DI: Remote control inputs 
(/R1 option)

DO: Alarm output relays
(/Ax option)

Date, time, and chart speed

See the next page.

The date display format can be changed on the Basic Setting mode.

Flag and scale

•  Alarm is not set.
–  Alarm is not occurring.
Channel number Alarm is occurring.

 
 
 :123456 789012 345678 901234
:ABCDEF GJKMNP ABCDEF GJKMNP

. . .  . . . . . .  . . . . . .
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. . . . .

Aug.31.2005 11:26:37 12000mn/h

180mm Dot model
Analog:24 Math:24

TI00001dH-1999.9ABCDE
TI00002H9999999.9ABCDE

TI00001dH-1999.9ABCDE

TI00002H9999999.9ABCDE
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Multiple display

Display in which different screens are assigned to the top and bottom sections.

01dH-1999.9ABCDEf
Aug.31.2005 11:26:37 12000mn/h

TI00001dH-1999.9ABCD

TI00001dH-1999.9ABCD

ABC
DEFTI00002H9999999.9ABC

TI00002H9999999.9ABC

Measurement channels
Channel: 7 digits, mode: 1 digit, alarm: 1 digit, value: 7 digits, unit: 4 digits
Computation channels
Channel: 7 digits, alarm: 1 digit, value: 9 digits, unit: 3 digits

Measurement channels
Channel: 7 digits, mode: 1 digit, alarm: 1 digit, value: 7 digits, unit: 6 digits
Computation channels
Channel: 7 digits, alarm: 1 digit, value: 9 digits, unit: 6 digits

Mode: Displays “d” on channels “Delta computation” is set.

Bar graphs are assigned channels 1 to 4 from the top.
Uses the same digital display format as “2CH digital display (Tag display).”

Value and bar graph of the same channel.  
Uses the same digital display format as “1CH digital display (Tag display).”

• Product information: Number of signal inputs, options installed, number of computation 
channels, MAC address, and recorder version (firmware version)

• Setup data: Periodic printout interval, dot printing interval (dot model), and pen 
offset compensation On/Off (pen model)

 
 

  

 

SD memory card

SD memory card status 
display

For models with the SD memory 
card (/EM1 option)

Status Available
Usage 63%

The displayed contents switch every 3 seconds.
Card status, usage, free space, card capacity, volume label, and the remaining length of time 
for saving data.

12.4  Display Function Specifications
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Name Description

Lights out No display.

Batch name display Batch No.-000001

Batch number Lot number
Automatically added when batch number and lot number are enabled.

Name Description
Multiple display (Different screens assigned to the top and bottom sections)

1CH digital display

2CH digital display

3CH digital display

ID/DO display

Status display

Lights out

Tag_1CH digital display

Time/Chart speed display

Measurement channel

No display.

Displays the appropriate 
mark.

•  Alarm is not set.
–  Alarm is not occurring.
Channel number Alarm is occurring.

Alarm summary display 
of all computation channels.

              
             

       
          
     

             
       

01dH-1999.9ABCDEF

Computation channel0AH9999999.9ABCDEF

Uses the same digital display format as “2CH digital display.”

Uses the same digital display format as “4CH digital display.”

Uses the same digital display format as “6CH digital display.”

01dH-1999.9ABC 0AH9999999.9AB 

01H-1999.9 02H-1999.9 0AH9999.9

Date, time, and chart speed

The date display format can be changed on the Basic Setting mode.

Aug.31.2005 11:26:37 12000mn/h

Display for a 24-dot model. 
 
 :123456789012345678901234. . . . . . . . . . . . . . .. . . . . +/

–x

Alarm
Chart end

Measurement channelTI00001dH-1999.9ABCDE

Computation channelTI00002H9999999.9ABCDE

Uses the same digital display format as “Tag_2CH digital display.”

 

 

SD memory card

12.4  Display Function Specifications
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12.5 Specifications of Optional Functions

Alarm Output Relay (/A1, /A2, /A3, /A4, and /A5)
Item Specifications
Operation Outputs relay contact signals from the dedicated terminals on the rear panel when alarms occur.
Number of outputs 2 outputs (/A1), 4 outputs (/A2), 6 outputs (/A3), 12 outputs (/A4), 24 outputs (/A5)
Relay contact rating 250 VDC/0.1 A (for resistance load)

250 VAC (50/60 Hz)/3 A
Output format NO-C-NC
Auxiliary functions Energized/De-energized operation selectable (common to all relays)

Hold/Non-hold operation selectable (common to all relays)
AND/OR operation selectable
Reflash operation (Fixed to relay I01, I02, and I03. Relay release time is approx. 500 ms.)

Diagnosis output Relay I01 can be used for diagnosis output.
Diagnosis output: Outputs a relay signal when an error in the recording section (plotter on the 
pen model), a burnout, or an error in the A/D converter is detected. Relay operation is fixed to  
de-energized and non-hold.

RS-422A/485 Communication Interface (/C3)
Item Specifications
Connection Complies with EIA RS-422A/485
Connection type Multi-drop connection 1:32 (four-wire system), 1:31 (two-wire system)
Transmission mode Half-duplex
Synchronization Start-stop synchronization
Baud rate 1200, 2400, 4800, 9600, 19200, or 38400 bps
Start bit Fixed to 1 bit
Data length 7 bits or 8 bits
Stop bit Fixed to 1 bit
Parity Odd, even, or none (no parity)
Received buffer length 2047 bytes
Escape sequence Open and close
Protocol Dedicated protocol, Modbus slave protocol 
Communication mode ASCII for input/output for control and setting

ASCII or binary for input/output of measured data
Communication distance 1.2 km

Ethernet Communication Interface (/C7)
Item Specifications
Function

Setting/Measurement server Uses a dedicated protocol
Measured/computed data, setup data, status byte

Maintenance/Test server Connection information, network statistics, etc.
Instrument information server Model, serial number, etc.

Electrical and mechanical specifications
Conforms to IEEE 802.3.

Interface Basic specifications
Connection Ethernet (10BASE-T)
Protocol TCP, IP, UDP, ICMP, and ARP

The maximum number of simultaneous connections and the number of simultaneous use
Function 
Administrators

Maximum Number of 
Connections Users

Number of 
Simultaneous Users Port Number

Setting/Measurement server 3 1 2 34260/tcp
Maintenance/Test server 1 1 1 34261/tcp
Instrument information server - - - 34264/udp

Miscellaneous
User authentication Administrator: 1, users: 6 (limitations placed on users)
Keepalive Drops the connection if there is no response to an inspection packet. Use or not use is 

selectable.
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FAIL/Chart End Detection and Output (/F1)
Item Specifications
FAIL output Relay output on CPU error

Relay operation Energized during normal operation and de-energized on CPU error. Non-hold operation.
Chart end detection output Stops recording and outputs a relay signal when the remaining amount of chart paper is 

approx.2 cm. Also, turns ON the words CHART END on the display.
Relay operation The relay is energized when the above conditions are met. Non-hold operation.

Contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistor load)

Clamped Input Terminal (/H2)
Item Specifications
Measuring input terminal Uses clamped input terminals.

Non-Glare Door Glass (/H3)
Item Specifications
Door glass Uses a door glass with minimal reflection.

Computation Function (/M1)
Item Specifications
Number of computation channels

Pen model: 8 channels, dot model: 24 channels
Operation General arithmetic operations: Four arithmetic operations, square root, absolute, common 

logarithm,	exponential,	power,	relational	operations	(<,	≤	,	>,	≥	,	=,	≠),	
logical operations (AND, OR, NOT, XOR)

Statistical operations (TLOG): Average, max., min., sum, and max. – min. for each interval
Constants Up to 30 constants can be defined

Range: –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
Symbol: K01 to K30

Communication input data Digital data via communication can be used in computations other than statistical computation 
(TLOG)
Number of communication input data points: 8 (pen model), 24 (dot model)
Range: –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
Symbol: C01 to C24

Remote input Use remote input status (0/1) in equations
Number of inputs: 5
Symbol: D01 to D05

Computation accuracy 32-bit floating-point computation (excluding TLOG computation)
Computation range Computed values throughout the computation remains within approx. ±3.4×1038.
Equation Defined using up to 120 characters.
Execution interval Scan interval
TLOG timer Performs statistical calculation for each interval specified by the timer.

Number of timers 3 (periodic printout timer, timer 1, and timer 2).
Timer 1 and 2 modes Absolute or relative
Reset Report data can be reset at each interval.
Printout Printout at each interval is possible.

Trend recording
Recording span –9999999 to 99999999, decimal place arbitrary.
Unit Up to 6 characters
Recording methods Zone recording and partial expanded recording available.
Pen Measurement channels and computation channels can be assigned arbitrarily to pens.
Dot printing Trend recording of measurement and computation channels. The fastest dot printing interval is as 

follows:
Number of channels being trend recorded Fastest dot printing interval

6 or less 10 s
7 to 12 15 s
13 to 18 20 s
19 to 24 30 s
25 to 48 60 s
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Item Specifications
Alarms

Number of alarms Up to four alarms (level) for each measurement channels.
Alarm types High limit (H), low limit (L), delay high limit (T), delay low limit (t). The alarm symbol is shown in 

parentheses.
Alarm delay time of delay high and low limit alarms (can be set for each channel, common within a 
channel)  See section 12.2

Hysteresis Applied to high limit alarm and low limit alarm.
Hysteresis range: Approx. 0.0% to 1.0% of the recording span (0.1% steps)

Miscellaneous See section 12.2.
Display See section 12.4.

Cu10, Cu25 RTD Input (/N1)
Item Specifications
Cu10, Cu25 RTD This option allows Cu10 and Cu25 inputs to be added to the standard input types.
Input type and measurable range

Input Type Measurable Range

RTD  
(Measurement current 
 i: 2 mA)

Cu10 (GE)

–200.0 to 300.0°C 
–328.0 to 572.0°F

Cu10 (L&N)
Cu10 (WEED)
Cu10 (BAILEY)
Cu10:	α	=	0.00392	at	20°C
Cu10:	α	=	0.00393	at	20°C
Cu25*:	α	=	0.00425	at	0°C

* Measurement current i = 1 mA
Measurement and recording accuracy

Input Type Measurement Accuracy Recording Accuracy
Cu10 (GE)
Cu10 (L&N)
Cu10 (WEED)
Cu10 (BAILEY)
Cu10:	α	=	0.00392	at	20°C
Cu10:	α	=	0.00393	at	20°C

±(0.4% of rdg + 1.0°C) Measurement accuracy  
±(0.3% of recording span)

Cu25:	α	=	0.00425	at	0°C ±(0.3% of rdg + 0.8°C)

3 Legs Isolated RTD (/N2)
Item Specifications
Input terminal isolation Applies to the dot model.

The RTD input terminals are isolated between channels (on the standard dot model, input 
terminal b are common to all channels)

Expansion Inputs (/N3)
Item Specifications
Input type and measurable range

Adds the input types shown in the table below.
Input Type Measurable Range

Thermocouple

PR40-20 0.0 to 1900.0°C 32 to 3452°F
PLATINEL 0.0 to 1400.0°C 32 to 2552°F
NiNiMo 0.0 to 1310.0°C 32 to 2390°F
W/WRe26 0.0 to 2400.0°C 32 to 4352°F
Type N (AWG14) 0.0 to 1300.0°C 32 to 2372°F
Kp vs Au7Fe 0.0 to 300.0 K

RTD 
(Measuring current
 i = 1 mA)

Pt25 –200.0 to 550.0°C –328.0 to 1022.0°F
Pt50 –200.0 to 600.0°C –328.0 to 1112.0°F
Ni100 (SAMA) –200.0 to 250.0°C –328.0 to 482.0°F
Ni100 (DIN) –60.0 to 180.0°C –76.0 to 356.0°F
Ni120 –70.0 to 200.0°C –94.0 to 392.0°F
J263*B 0.0 to 300.0 K
Cu53 –50.0 to 150.0°C –58.0 to 302.0°F
Cu100:	α	=	0.00425	at	0°C –50.0 to 150.0°C –58.0 to 302.0°F

12.5  Specifications of Optional Functions
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Item Specifications
Measurement and recording accuracy: See “Standard Performance” on page 12-20.

Input Type Measurement Accuracy Recording Accuracy

Thermocouple 
(excludes RJC 
accuracy)

PR40-20

0 to 450°C 
450 to 750°C 
750 to 1100°C 
1100 to 1900°C

Not warranted 
±(0.9% of rdg + 3.2°C) 
±(0.9% of rdg + 1.3°C) 
±(0.9% of rdg + 0.4°C)

Measurement accuracy 
±(0.3% of recording span)

PLATINEL ±(0.25% of rdg + 2.3°C)
NiNiMo ±(0.25% of rdg + 0.7°C)

W/WRe26 0 to 400°C 
400 to 2400°C

±15.0°C or less 
±(0.2% of rdg + 2.0°C)

Type N (AWG14) ±(0.2% of rdg + 1.3°C)

Kp vs Au7Fe 0 to 20 K 
20 to 300 K

±4.5 K 
±2.5 K

RTD

Pt25 ±(0.15% of rdg + 0.6°C)
Pt50 ±(0.3% of rdg + 0.6°C)
Ni100 (SAMA)

±(0.15% of rdg + 0.4°C)Ni100 (DIN)
Ni120

J263*B 0 to 40 K 
40 to 300 K

±3.0 K 
±1.0 K

Cu53 ±(0.15% of rdg + 0.8°C)
Cu100 ±(0.2% of rdg + 1.0°C)

Reference junction 
compensation accuracy

When input terminal temperature balanced (60 minutes after power on)
PLATINEL, NiNiMo, W/WRe26, or Type N (AWG14): ±1.0°C
No RJC for PR40-20 and Kp vs Au7Fe (fixed to 0°C)

Remote Control 5 Points (/R1)
Item Specifications
Number of input terminals 5
Input type Isolated from the main circuitry through a photocoupler, built-in isolated power supply for the input 

terminals, and shared common
Input type and signal level

Voltage-free contact Contact	closed	at	200	Ω	or	less	and	contact	open	at	100	kΩ	or	greater
Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or less

Allowable input voltage 5 VDC
Signal type Edge, level, or trigger (250 ms or more)
Operation Perform the following control operations by applying a given signal to the remote signal input terminal.

• Start/stop recording (edge)
• Alarm ACK (trigger)
• Set the clock (adjust the clock to the nearest hour with the contact input, trigger)
Time When Signal Is Input Procedure
00 min 00 s to 01 min 59 s Truncates	the	minutes	and	seconds.Example:	10:00:50	→	10:00:00
58 min 00 s to 59 min 59 s Rounds	up	the	minutes	and	seconds.Example:	10:59:50	→	11:00:00
02 min 00 s to 57 min to 59 s No operation

• Manual printout (trigger)
• Message 1 to 5 printout (trigger)
• Switch the chart speed (level)
• Start/stop computation (/M1 option) (edge)

• Reset computation (/M1 option) (trigger)
• Priority to remote recording (/BT1 option) (edge)
• Batch comment switching (/BT1 option) (level)
• Start/stop data saving (/EM1 option) (edge)

Portable Type (/H5x)
Item Specifications
Installation Desktop type (with a carrying handle)
External dimensions 288 (W) × 329.7 (H) × 292 (D) mm (including the handle and feet)
Weight Add 1.7 kg to the weight given in General Specifications (see section 12.6, excluding the power cord)
Standard accessories* With a power cord

* Panel mounting brackets are not included.
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24 VDC/AC Power Supply Operation (/P1)
Item Specifications
Rated supply voltage 24 VDC/AC
Allowable power supply voltage range

21.6 to 26.4 VDC/AC
Withstand voltage 1000 VAC at 50/60 Hz for one minute (between the power terminal and the ground terminal)
Rated power supply frequency

50/60 Hz (for AC operation)
Allowable power supply frequency range

50 Hz ± 2% or 60 Hz ± 2% (for AC operation)
Effects of power supply voltage fluctuation

The fluctuation in the measured values is within ±1 digit and that in the recording is within ±0.1% in 
the recording span for the 21.6 to 26.4 VAC/DC range.

Effects of power supply frequency fluctuation
The fluctuation in the measured values and recording is ±(0.1% of rdg + 1 digit) at the rated 
frequency ±2 Hz.

Rated power 35 VA (for DC) or 45 VA (for AC)
Power consumption

Model 24 VDC 24 VAC Maximum
1 to 4 pen models Approx. 9 VA* Approx. 17 VA* Approx. 45 VA
6 to 24 dot models Approx. 10 VA* Approx. 18 VA* Approx. 45 VA
* When balanced

Calibration Correction (/CC1)
Item Specifications
Number of calibration points 2 to 16 (can be specified for each channel)
Correction mode Revise or absolute value (can be specified for each channel)
Correctable range DC input (DC voltage, TC, and RTD) and linear scaling (DC voltage, TC, RTD, and 1-5V)

(Not allowed on ON/OFF input (including linear scaling), delta computation, square root 
computation, and computation channels)

Correction range • (1st correction point + 1st correction value) < (2nd correction point + 2nd correction value) < ...
• Corrected value (revise value: correction point + correction value, absolute value: correction 

value) within the measurable range and scaling range (–5% to 105% or –20000 to 30000) of  
each input range

• Setting limits
 Left span (0%) < Right span (100%)
 Left scale (0%) < Right scale (100%)

Others Calibration correction and bias functions cannot be used simultaneously (common to all channels)

Header Printout (/BT1)
Item Specifications
Printout function When recording starts or stops, prints out the batch name, comment, date/time, and chart speed. 

Messages can also be printed out including measured values*.
Printed items

Recording start/recording end printouts
Batch name: Batch number (up to 26 characters) and lot number (4 or 6 digit number, or Off)
Comment (up to 64 characters x 5 lines)
Chart speed
Date/time: Year, month, date, time, minute, second (date format depends on the date printout/
display format)
Printout On/Off selection: Batch name, chart speed, and date/time 

Message printouts In the 5 message formats, measured values*, strings (up to 16 characters), and date/time can be 
arbitrarily combined and printed out (up to 69 characters total).

* Computed values can also be included on models with the /M1 option.

SD memory card (/EM1)
Item Specifications
Measured data save Saves measured data to the SD memory card. File is divided every about 30 MB. .RXE extension.
Measured data replay Universal Viewer (software) for viewing and printing.

Data saved with a dot model to an SD memory card can be replayed on chart paper using a 
recorder of the same model with equivalent or more functions.

Setting parameters save 
and load

Saves recorder setup data to an SD memory card. .PUL extension.
Loads setup data from an SD memory card into the recorder.

12.5  Specifications of Optional Functions
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12.6 General Specifications

Construction
Item Specifications
Mounting Flush panel mounting (on a vertical plane)
Mounting angle Inclined backward up to 30 degrees from a horizontal plane.
Allowable panel thickness 2 to 26 mm
Material Case: drawn steel

Front door: Aluminum die-cast
Color Case: Charcoal gray light (Munsell 10B3.6/0.3 or equivalent)

Front door: Charcoal gray light (Munsell 10B3.6/0.3 or equivalent)
Front panel Water and dust-proof (complies with DIN40050-IP54)
Dimensions 288(W) × 288(H) × 220(D) mm (D: depth from the panel mounting plane)
Weight 1-pen: approx. 7.8 kg, 2-pen: approx. 7.8 kg, 3-pen: approx. 7.9 kg, 4-pen: approx. 7.9 kg

6-dot: approx. 8.4 kg, 12-dot: approx. 8.6 kg, 18-dot: approx. 8.8 kg, 24-dot: approx. 9.0 kg

Normal Operating Conditions
Item Specifications
Ambient temperature 0 to 50°C
Ambient humidity 20 to 80%RH (at 5 to 40°C)

30 to 50%RH (at 0 to 5, 40 to 50°C)
Allowable power supply voltage range

90 to 264 VAC
Power supply frequency 50 Hz ±2%, 60 Hz ±2%
Vibration 10 to 60 Hz 0.2 m/s2 or less
Shock Not acceptable.
Magnetic field 400 A/m or less (DC and 50/60 Hz)
Noise Normal mode (50/60 Hz)

Volt: The peak value including the signal must be less than 1.2 times the rated value of the range 
(Example: 2 V for 2 V range).

TC: The peak value including the signal must be less than 1.2 times the rated value of the range.
RTD: 50 mV or less
Common mode (50/60 Hz): Less than 30 VAC rms or 60 VDC for the whole range.
Maximum noise voltage between channels (50/60 Hz): 250 VACrms or less. 6-dot model with the 3 
legs isolated RTD (/N2 option) installed: 200 VACrms or less.

Mounting position Up to 30° of backward tilt angle allowed, no tilt to the left or right
Warm-up time At least 30 minutes after power on
Altitude 2000 m or less above sea level

Power Supply
Item Specifications
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range

90 to 264 VAC
Rated power supply frequency

50 Hz, 60 Hz
Rated power Pen model: 55 VA, dot model: 55 VA
Power consumption

Model 100 VAC 240 VAC Maximum
1- to 4-pen model Approx. 17 VA* Approx. 25 VA* Approx. 55 VA
6- to 24-dot model Approx. 17 VA* Approx. 23 VA* Approx. 55 VA
* When balanced
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Isolation
Item Specifications
Insulation resistance Each	terminal	to	ground	terminal:	20	MΩ	or	more	(at	500	VDC)
Dielectric strength Power supply to ground terminal: 1500 VAC (50/60 Hz), 1 minute

Contact output terminal to ground terminal: 1500 VAC (50/60 Hz), 1 minute
Measuring input terminal to ground terminal: 1000 VAC (50/60 Hz), 1 minute
Between measuring input terminals: 1000 VAC (50/60 Hz), 1 minute (except for RTD input terminal)
Remote input terminal to ground terminal: 500 VDC, 1 minute

Grounding Be sure to set a low grounding resistance.

Transport and Storage Conditions
Item Specifications
Ambient temperature –25 to 60°C
Ambient humidity 5 to 95%RH (no condensation)
Vibration 10 to 60 Hz, 4.9 m/s2 maximum
Shock 392 m/s2 maximum (in packaged condition)

Supported Standards
Item Specifications
CSA Certified by CAN/CSA-C22.2 No. 61010-1, CSA-C22.2 No. 61010-2-030, Overvoltage Category II 

or I1, Measurement Category II2, Pollution Degree 23

UL UL 61010-1, UL Std. No. 61010-2-030 (CSA NRTL/C)
Overvoltage Category II or I1, Measurement Category II2, Pollution, Degree 23

CE, UKCA
EMC directive EN 61326-1 Class A, Table 2 (For use in industrial locations) compliant

EN 61000-3-2 compliant
EN IEC 61000-3-2 compliant
EN 61000-3-3 compliant
EN 55011 Class A Group 1 compliant

Low voltage 
directive

EN 61010-1, EN IEC 61010-2-030 compliant, Overvoltage Category II or I1, Measurement Category 
II2, Pollution Degree 23

EU RoHS directive EN IEC 63000 compliant
WEEE directive Compliant
EMC regulatory arrangement in Australia and New Zealand (RCM)

EN 55011 Class A Group 1 compliant
KC marking KS C9811, KS C9610-6-2 compliant
1 Overvoltage category describes a number which defines a transient overvoltage condition. It implies the regulation for 

impulse withstand voltage. Applies to electrical equipment which is supplied from the fixed installation like a distribution 
board.
II: Applied to standard power supply (100-240 VAC)
I: Applied to /P1 option (24 VDC/AC)

2 Applies to measuring circuits connected to low voltage installation, and electrical instruments supplied with power from 
fixed equipment such as electric switchboards.

3 “Pollution degree” describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface 
resistivity is adhering. “2” applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.

12.6  General Specifications
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Standard Performance
Item Specifications
Measurement and recording accuracy

The following specifications apply to operation of the recorder under standard operation conditions:
Temperature: 23 ± 2°C
Humidity: 55% ± 10%RH
Power supply voltage: 90 to 132 or 180 to 264 VAC
Power supply frequency: 50/60 Hz ± 1%
Warm-up time: At least 30 minutes.
Other ambient conditions such as vibration should not adversely affect the operation

Input Type Range Type Measurement (Digital Display) Recording (Trend)
Measurement Accuracy Highest Res. Recording Accuracy Resolution

DC voltage

20 mV

±(0.1% of rdg + 2 digits)

10	μV Measurement  
accuracy  
±(0.3% of recording 
span)

Pen model: 
Dead band 0.2% 
of recording span
Dot model:  
Resolution 0.1 mm

60 mV 10	μV
200 mV 100	μV
2 V 1 mV
6 V 1 mV
20 V 10 mV
50 V ±(0.1% of rdg + 3 digits) 10 mV

DC voltage 1-5 V ±(0.1% of rdg + 2 digits) 1 mV

TC 
(excludes  
RJC  
accuracy)

R  
S  
B

±(0.15% of rdg + 1)  
except R,S: 0 to 100°C, ±3.7°C 

100 to 300°C, ±1.5°C  
B: 400 to 600°C, ±2°C  

Accuracy not warranted for  
values less than 400°C 

0.1°C
 

K
±(0.15% of rdg + 0.7°C)  
except ±(0.15% of rdg + 1°C)  
for –200 to –100°C

E  
J  
T

±(0.15% of rdg + 0.5°C)  
except ±(0.15% of rdg + 0.7°C)  
for J: –200 to –100°C

N ±(0.15% of rdg + 0.7°C)
W ±(0.15% of rdg + 1°C)

L  
U

±(0.15% of rdg + 0.5°C)  
except ±(0.15% of rdg + 0.7°C)  
for L:–200 to –100°C

WRe ±(0.2% of rdg + 1°C)

RTD Pt100  
JPt100 ±(0.15% of rdg + 0.3°C)

ON/OFF input Level  
Contact

Threshold level (2.4 V)  
accuracy ± 0.1 V  
≤	1	kΩ:	ON,	≥	100	kΩ:	OFF 
(Parallel capacitance 
	0.01	μF	or	less)

– –

Measuring accuracy in case of linear scaling
Accuracy during scaling (digits) = measuring accuracy (digits) × multiplier + 2 digits (rounded up)
where the multiplier = scaling span (digits)/measuring span (digits).
Example: Assuming that
• range type: 1-5 V
• measuring span: 1.000 to 5.000 V
• scaling span: 0.000 to 2.000  Then,
Measuring accuracy 
when the input is 5 V 

= ±(0.1% × 5 V + 2 digits) 
= ±(0.005 V [5 digits] + 2 digits) 
= ±7 digits

Multiplier = {2000 digits (0.000 to 2.000)}/4000 digits (1.000 to 5.000) = 0.5
Accuracy during scaling = ±(7 × 0.5 + 2) digits = ±6 digits (rounded up)
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Item Specifications
Measuring accuracy and recording accuracy in case of square root computation

A: Voltage measurement accuracy (digits)
B: Voltage span (digits)
C: Scaling span (digits, upper limit of scaling – lower limit of scaling)
Input Range Computed Value Accuracy Equation (Digits), 

Rounded up to the decimal place
Recording Accuracy

0% or more, less than 1.5%*  ±(0.1 × C + 2) Left value + 0.3% of 
recording span1.5% or more, less than 6.25%  ±(A / B × C × 5 + 2)

6.25% or more, less than 25%  ±(A / B × C × 2 + 2)
25% or more, 100% or less  ±(A / B × C + 2)
* Includes case when:  

(input voltage – lower limit of the specified voltage range) / used range × 20000 < 256.  
If the specified range is, for example, 1–5 V, the lower limit of the specified voltage range is 1. 
Use a measurement range that is as close to the measurement span as possible.

Example: Assuming that
• range type: 6 V
• measuring span: 1.000 to 5.000 V
• scaling span: 0.000 to 2.000 Then,
A = A calculated value shown below
B = 5.000 V - 1.000 V = 4.000 V (4000 digits)
C = 2.000 – 0.000 = 2.000 (2000 digits)
<Measuring	accuracy>
(1) When the input is 1.24 V (6% input)

A = ± ( 0.1% × 1.240 V + 2 digits ) = ±( 0.00124 V(2 digits) + 2 digits ) = ±4 digits
Measuring accuracy = ± ( 4/4000 × 2000 × 5+2) = ±12 digits

(2) When the input is 5 V (100% input)
A = ± ( 0.1% × 5.000 V + 2 digits ) =±( 0.005 V(5 digits) + 2 digits ) = ±7 digits
Measuring accuracy = ± ( 7/4000 × 2000+2 )= ±5.5 = ±6 digits (rounded up)

<Recording	accuracy>
Measuring accuracy± 0.54 mm (0.3% of 180 mm)

Reference junction compensation
Internal/External selectable for each channel

Reference junction compensation accuracy
Above 0°C with input terminal temperature balanced (60 minutes after power on)
Type R, S, B, W, WRe: ±1.0°C
Type K, J, E, T, N, L, U: ±0.5°C

Maximum input voltage ±10 VDC (continuous) for ranges of 200 mV or less, TC, RTD, and DI ranges
±60 VDC (continuous) for 2 VDC or higher ranges

Input resistance Approximately	10	MΩ	or	more	for	ranges	of	200	mV	or	less	and	TC
Approximately	1	MΩ	for	2	VDC	or	higher	ranges

Input source resistance Volt, TC: 2	kΩ	or	less
RTD input: 10	Ω	or	less	per	wire	(The	resistance	of	all	three	wires	must	be	equal).

Input bias current 10 nA or less (except when burnout detection function is enabled)
Maximum common mode 
noise voltage

250VACrms (50/60Hz)

Maximum differential noise 
between channels

250VACrms (50/60Hz) or less for pen model and 6,12 dot model
200VACrms (50/60Hz) or less for 18, 24 dot model
*When /N2 (3 leg RTD) option is specified, 200VACrms (50/60Hz) or less for 6 dot, 100VACrms 
(50/60Hz) or less for 12, 18, and 24 dot model

Interference between 
channels

120dB	(Input	external	resistance	500Ω,	the	deviation	in	the	case	that	60V	is	applied	to	another	
channel)

Common mode rejection ratio 120	dB	(50/60	Hz	±	0.1%,	500	Ω	unbalanced,	between	the	minus	terminal	and	ground)
Normal mode rejection ratio 40 dB or more (50/60 Hz ± 0.1%)
Noise rejection By the integrating A/D converter: The integration time is 16.7 ms, 20 ms, or 100 ms (dot model)

Low-pass filtering (pen model): Filter time constant is 2 s, 5 s, or 10 s
Moving average (dot model): The number of samples is 2 to 16.
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Effects of Operating Conditions
Item Specifications
Ambient temperature With temperature variation of 10°C:

Measurement: ±(0.1% of rdg + 1 digit) or less
Recording: Measurement fluctuation + ±0.2% of the recording span or less
* Excluding the error of reference junction compensation

Power supply fluctuation With variation within 90 to 132 V and 180 to 264 VAC (50/60 Hz):
Measurement: ±1 digit or less
Recording: ±0.1% of the recording span or less

With variation of ±2 Hz from rated power frequency (power supply voltage 90 to 132, 180 to 264 VAC):
Measurement: ±(0.1% of rdg + 1 digit) or less
Recording: Same as the measurement fluctuation

Magnetic field AC (50/60 Hz) and DC 400 A/m fields:
Measurement: ±(0.1% of rdg 10 digit) or less
Recording: ±0.5% of the recording span or less

Input source resistance
DC voltage range With	variation	of	+1	kΩ:

Ranges of 200 mV or less: Within ±10 µV
Ranges of 2V or more: ±0.1% of rdg

TC range With	variation	of	+1	kΩ:	±10	µV	or	less
RTD range With	variation	of	10	Ω	per	wire	(resistance	of	all	three	wires	must	be	equal):

Measurement: ±(0.1% of rdg + 1 digit) or less
Recording: Measurement fluctuation + ±0.1% of the recording span or less

With	maximum	difference	of	40	mΩ	between	wires:	Approx.	0.1°C	(for	Pt100)
Mounting position With a backward tilt of 30° or less

Measurement: ±(0.1% of rdg + 1 digit) or less
Recording: Indication fluctuation + ±0.1% of the recording span or less

Vibration When a sinusoidal vibration along all three axis at a frequency between 10 to 60 Hz and an 
acceleration of 0.2 m/s2 is applied for 2 hours

Measurement: ±(0.1% of rdg + 1 digit) or less
Recording: Indication fluctuation + ±0.1% of the recording span or less

Other Specifications
Item Specifications
Clock With a calendar function
Accuracy of clock ±100 ppm, excluding a delay (of 1 second, maximum) caused each time the power is turned on.
DST The date/time for switching between standard time and DST can be specified.
Memory backup A built-in lithium battery backs up the setup parameters and runs the clock

(battery life: approximately ten years at room temperature).
Key lock function Password for releasing the key lock can be set.

Key lock items RCD key, MENU key, DISP MENU key, FEED key, and function under the FUNC key (Alarm ACK, 
computation start/stop, print, message, printout buffer clear, periodic printout reset, and pen or 
ribbon cassette exchange, data saving start/stop, data replay start/stop, SD memory card ejection)

Internal light Lights up the recording area of the chart paper. Uses a dedicated LED.
Noise Machine Noise Information Ordinance 3.GSGV, Jan 18, 1991

Maximum noise level: 60 dB (A) or less (complies with ISO7779)

12.6  General Specifications
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12.7 Dimensional Drawings

Panel Mount Type

(Dimensions before attaching 
the mounting bracket)

(Dimensions after attaching 
the mounting bracket)

Unit: mm (approx. inch)
Unless otherwise specified, tolerance is ±3% 
(however, tolerance is ±0.3 mm when below 10 mm).

 3
9.

5
(1

.5
6)

18
0.

5
(7

.1
1)

279.6
(11.01)

 180
(7.09)

 108
(4.25)

 1
80

(7
.0

9)

 1
08

(4
.2

5)

 (0.94)

27
9.

6
(1

1.
01

)
54.6 (2.15)

288 (11.34)

294.6 (11.6)

28
8 

(1
1.

34
)

29
4.

6 
(1

1.
6)

220 (8.66)
180.5 (7.11) 39.5 (1.56)

9.4 (0.37)
2 to 26

(panel thickness)

7.5 (0.3)

24

Note
When mounting the recorder to a panel, use two brackets, top and bottom or left and right.

Panel Cut Dimensions

  

360 MIN(14.17)

 281
(11.06)

+2
  0

 281
(11.06)

+2
  0

361 MIN
     (14.21)

Unit: mm (approx. inch)
Unless otherwise specified, tolerance is ±3% 
(however, tolerance is ±0.3 mm when below 10 mm).
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Portable Type (/H5x Option)

  

28
8

(11.34)

(1
1.

34
)

(10.53)

(7.11)
(3.43)

(1
1.

18
)

(1
2.

98
)

(0.5)
288

180.5

267.5

87

28
4

32
9.

7

12.7

Unit: mm (approx. inch)
Unless otherwise specified, tolerance is ±3% 
(however, tolerance is ±0.3 mm when below 10 mm).

12.7  Dimensional Drawings
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Appendix 1 Periodic Printout and Printout Using the 
TLOG Timer (/M1 Option)

Periodic Printout
This section explains the contents of the periodic printout. The periodic printout contents 
vary between the pen model and dot model. The contents also vary depending on 
whether the periodic printout is in instantaneous mode, report mode, or Off.
Instantaneous mode or report mode is specified using Print1 > Mode in Basic Setting 
mode.
The figure below illustrates the printout contents. The font used in the figure differs from 
that of the actual printout. The printout positions may also differ from those of the actual 
printout.

Pen Model
Instantaneous Mode

Time tick cancel mark
Offset compensation mark

Prints the letter “d” for channels set to
delta computation.

AlarmTime tick

Unit

Measured
value

Channel number 
or tag

Date
Time

Channel data

Computation channel

Scale

Recording color
Chart speed

Mar.31.2004!
15:50*
TAG-001    1.000V
2         -1.000V
3       H-2.1050UNIT03
4      d   2.000V
TAG-00A          1UNIT0A
C       L     1.00
D           -10.00UNIT0D
E           1.0000%
J            -1.00UNIT0J
0.000 2.000
TAG-001  V
RED
50mm/h_

• Date/Time
 The date/time when the periodic printout was printed on the chart paper.
• Time tick
 Indicates the reference pen position at the time the periodic printout was printed on 

the chart paper.
• Time tick cancel mark
 Prints an exclamation point (!) when the time tick is not printed correctly.
• Offset compensation mark
	 Prints	an	asterisk	(*)	when	offset	compensation	is	enabled.
• Channel data
 Prints the channel numbers (1 to 4 or A to J) or tags, measured/computed values, and 

unit.
 Prints the letter “d” on channels set to delta computation.
• Alarm
 Prints the alarm that is occurring. If multiple alarms are occurring, the alarm with the 

highest precedence is printed.
 Alarm printout precedence: (Higher) H, L, T, t, h, l, R, r (Lower)

Appendix
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• Scale
 Prints the leftmost and rightmost values of the recording span and the channel 

number	or	tag	for	channels	that	have	scale	printout	specified.	The	scale	is	printed	for	
one channel at each periodic printout. The channel whose scale is printed changes in 
ascending order. The scale of channels that are being zone recorded is printed within 
the recording range of the zone.

• Recording color
 Prints the recording colors of channels that have scale printout and recording color 

printout	specified.
• Chart speed
 Prints the chart speed.

Report Mode

Time tick cancel mark
Offset compensation mark/event

Sum value
Min./Max./Ave.Unit

Range change
occurrence mark

Measured value

Channel number or tag

Report start date/time
Report end date/time

Channel data

Computation channel

Scale
Recording color

Chart speed

Time tick

Mar.31.2004 15:00!
-Apr.01.2004 15:00*TPR
TAG-001*1.000V
2       -1.000V
3       -2.105500E+03UNIT03
4       2.000V
TAG-00A 1UNIT0A
C      *1.00
D   -10.00/150.00/100.00UNIT0D
E       1.0000%
J       -1.00UNIT0J
0.000 2.000
TAG-001  V
RED
50mm/h_

• Report start date/time and report end date/time
 The start date/time and end date time of the report (statistical calculation) (periodic 

printout interval).
• Time tick and time tick cancel mark
 These are the same as with the instantaneous mode.
• Offset compensation mark
 This is the same as with the instantaneous mode.
• Event
 Prints the events that occurred in the interval.
 T: Time change
 P: Power failure or power OFF/ON
 R: Data reset
• Channel data
 Prints the channel numbers (1 to 6 or A to J) or tags, report data, and unit.
 An asterisk (*) is printed for channels whose range type was changed in the interval.
 On the printout of the minimum, maximum, and average values, the channel number 

is printed even if a tag name is assigned to the channel.
• Scale, recording color, and chart speed
 These are the same as with the instantaneous mode.

Appendix 1  Periodic Printout and Printout Using the TLOG Timer (/M1 Option)
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Dot Model
Instantaneous Mode

Prints the letter “d” for channels set to
delta computation.

Alarm

Unit

Channel number 
or tag

Measured
value

Date
Time

Channel data

Computation channel

Scale

Chart speed

Time tick

Mar.31.2004
15:50
TAG-001    1.000V
02         -1.000V
03       H-2.1050UNIT03
04      d   2.000V
TAG-00A     1UNIT0A
0J       L    -1.00UNIT0J
0.000 2.000
TAG-001  V
50mm/h_

• Date/Time
 The date/time when the periodic printout was executed.
• Time tick
 Indicates the position at the time the periodic printout was executed. If the time tick 

cannot be printed correctly, it is not printed.
• Channel data, alarm, scale printout, and chart speed
 These are the same as with the instantaneous mode of the pen model.

Report Mode

Sum value
Min./Max./Ave.

Time tick

Unit

Range change occurrence mark
Measured value

Channel number or tag

Report start date/time
Report end date/time

Channel data

Computation channel

Scale
Chart speed

Event

Mar.31.2004 15:00
-Apr.01.2004 15:00*TPR
TAG-001*1.000V
02       -1.000V
03       -2.105500E+03UNIT03
04       2.000V
TAG-00A 1UNIT0A
0C     *1.00
0D   -10.00/150.00/100.00UNIT0D
0E       1.0000%
0J       -1.00UNIT0J
0.000 2.000
TAG-001  V
50mm/h_

• Report start date/time and report end date/time
 The start date/time and end date time of the report (statistical calculation) (periodic 

printout interval).
• Time tick
 This is the same as with the instantaneous mode.
• Event
 This is the same as with the report mode of the pen model.
• Channel data
 This is the same as with the report mode of the pen model. However, the channel 

numbers are 1 to 6 or A to P.
• Scale and chart speed
 These are the same as with the instantaneous mode of the pen model.

Appendix 1  Periodic Printout and Printout Using the TLOG Timer (/M1 Option)
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Printout Using the TLOG Timer (/M1 Option)
Prints the computed values of computation channels for each interval determined by the 
TLOG timer.

Pen Model
Offset compensation mark/event

Alarm
Unit

Channel number
 or tag

Measured
value

Date
Time

Channel data

Scale

Recording color
Timer

Mar.31.2004
15:50*TPR
TAG-00A          1UNIT0A
B              1.0
C       L     1.00
G             -1.0
J            -1.00UNIT0J
-100    100
TAG-00A UNIT0A
RED
TLOG1

• Date/Time
 The date/time when the printout using the TLOG timer was executed.
• Offset compensation mark, scale, and recording color
 These are the same as with the periodic printout of the pen model.
• Event
 This is the same as with the report mode of the periodic printout of the pen model.
• Channel data
 Prints the computation channel numbers (A to J) or tags, computed values, and unit.
• Alarm
 This is the same as with the instantaneous mode of the periodic printout of the pen 

model.
• Timer
 Prints the timer number being used.

Dot Model
Event

Unit

Channel number 
or tag Measured value

Date
Time

Channel data

Scale

Timer

Alarm
Mar.31.2004
15:50*TPR
TAG-00A         1UNIT0A
0C      L       1.00
0D            100.00UNIT0D
0E            1.0000%
0G              -1.0
0J             -1.00UNIT0J
-100    100
TAG-00A UNIT0A
TLOG2

• Date/Time
 The date/time when the printout using the TLOG timer was executed.
• Event
 This is the same as with the report mode of the periodic printout of the pen model.
• Channel data
 Prints the computation channel numbers (A to P) or tags, computed values, and unit.
• Alarm
 This is the same as with the instantaneous mode of the periodic printout of the pen 

model.
• Scale
 These are the same as with the periodic printout of the pen model.
• Timer
 Prints the timer number being used.

Appendix 1  Periodic Printout and Printout Using the TLOG Timer (/M1 Option)
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Special Cases
This section explains the operation of the periodic printout report (statistical calculation) 
and the TLOG computation for special cases. In the explanation below, statistical 
calculation represents computation in periodic printout report mode or TLOG 
computation.

Operation during Power Failures
If a power failure occurs in the middle of statistical calculation, the operation is as follows 
when the power recovers.
The statistical calculation resumes when the power recovers. The exact operation will 
vary depending on whether the power is restored before or after the printout time.
Time of Recovery Type Statistical Calculation Operation
After the printout 
time

TLOG 
computation

Statistical calculation data is printed immediately after power 
is restored. The measured/computed data up to the time of 
the power failure is used. At the next printout time, data after 
the power recovery is used to create and print the statistical 
calculation data.

Periodic printout Periodic printout is not performed immediately after power is 
restored. It is printed on the first printout time after recovery. 
The data used is measured/computed data from before 
and up to the power failure, and from the time of recovery 
up to the printout time. The "report start date/time" in this 
case is the periodic printout date/time closest to and prior to 
the power failure. The "report end date/time" is the current 
periodic printout date/time.

Before the printout 
time

TLOG 
computation

The data is printed at the printout time after the power 
recovers. The measured/computed data excluding the 
power failure period is used.Periodic printout

Procedure of Handling “Over” Values during Periodic Printout
When an “over” value* is input for sum or average computation, that value is not used in 
the computation.

*  An “over” value on a measurement channel refers to +Over or –Over. See section 12.4. An 
“over” value on a computation channel refers to a value that is less than or equal to  
–100000000 or greater than or equal to 100000000 excluding the decimal.

Appendix 1  Periodic Printout and Printout Using the TLOG Timer (/M1 Option)
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Appendix 2 Periodic Printout Interval

The periodic printout function prints measured values and other data numerically at the 
left side of the chart paper while performing trend recording.
The periodic printout interval varies depending on the chart speed and conditions.

Periodic Printout Example of the Dot Model

ScaleChart speed printout

Measured values/alarm status

Trend recordingDate/Time

Interval

Pe
rio

di
c 

pr
in

to
ut

Pe
rio

di
c 

pr
in

to
ut

Mar.31.04
10:00
1       0.001V
2       0.000V
3       0.000V
4       0.000V
5       0.000V
6       0.000V
7       0.001V
8       0.000V
9       0.000V
10      0.000V
11      0.000V
12      0.000V
-2.000 2.000
01CH V
20mm/h_

Mar.31.04
13:00
1       0.001V
2       0.000V
3       0.000V
4       0.000V
5       0.000V
6       0.000V
7       0.001V
8       0.000V
9       0.000V
10      0.000V
11      0.000V
12      0.000V
-2.000 2.000
02CH V
20mm/h_

Interval

Mar.31.04
16:00
1       0.001V
2       0.000V
3       0.000V
4       0.000V
5       0.000V
6       0.000V
7       0.001V
8       0.000V
9       0.000V
10      0.000V
11      0.000V
12      0.000V
-2.000 2.000
03CH V
20mm/h_

The figure above is used to explain the printout contents. The actual printout and font are 
different from those illustrated in the figure. The printout positions are also slightly different.

When the Interval Is Set to Auto
Printout is performed at the interval corresponding to the chart speed.
• Pen model

Chart Speed Periodic Printout Interval Chart Speed Periodic Printout Interval
Up to 9 mm/h Not printed 150 to 180 mm/h 30 minutes
10 to 18 mm/h 8 hours 200 to 320 mm/h 20 minutes
20 to 36 mm/h 4 hours 360 to 1500 mm/h 10 minutes
40 to 72 mm/h 2 hours 1600 mm/h or higher Not printed
75 to 135 mm/h 1 hour

• Dot model
Chart Speed Periodic Printout Interval

6-dot 12-dot 18-dot 24-dot
Up to 9 mm/h Not printed Not printed Not printed Not printed
10 to 19 mm/h 8 hours 12 hours 12 hours 24 hours
20 to 39 mm/h 4 hours 8 hours 8 hours 12 hours
40 to 50 mm/h 2 hours 4 hours 4 hours 8 hours
51 to 79 mm/h 2 hours 4 hours Not printed Not printed
80 to 100 mm/h 1 hour 2 hours Not printed Not printed
101 mm/h or higher Not printed Not printed Not printed Not printed
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When the Interval Is Set to Manual
If you select Manual, you can set the interval.
• Chart Speeds That Allows Periodic Printout

Pen Model Dot Model
Chart Speed Printout Availability Chart Speed Printout Availability

6/12-dot 18/24-dot
Up to 9 mm/h No Up to 9 mm/h No No
10 to 1500 mm/h Yes 10 to 50 mm/h Yes Yes
1600 mm/h or higher No 51 to 100 mm/h Yes No

101 mm/h or higher No No

• Interval Settings
 Select from 10, 12, 15, 20, 30 minutes, 1, 2, 3, 4, 6, 8, 12, and 24 hours.

• Printout Items
Item Number of Lines Initial Setting Notes (Ref. Section)
Date/Time 2 - Always printed.
Measured value  
and alarm status

1 line/channel Printed Print or not print selectable for each 
channel (section 6.6).

Scale 2 Printed Print or not print selectable (section 7.7).
Pen color  
(Pen model only)

1 Printed Print or not print selectable (section 7.7).

Chart speed 1 - Always printed.

• Relationship between the Printout Items and Interval
 The next periodic printout does not start until all items of the previous periodic printout 

are printed.
	 If	all	items	cannot	be	printed	in	the	specified	interval,	the	printout	interval	increases	by	

an	integer	multiple	of	the	specified	interval.

   
Actual
interval

Periodic printout

Periodic printout

Specified interval

Example: 12 dot model, chart speed: 20 mm/h, interval: 1 hour, all other settings at 
default.

• This setting requires 17 lines to be printed which is equivalent to approximately 
43 mm* of chart paper.

• The length of chart paper that is fed within the interval is 20 mm.
* The length of chart paper needed in the printout varies depending on the chart speed 

and trend recording interval.

	 Not	all	items	can	be	printed	in	the	specified	interval	of	1	hour.
 The actual interval is 3 hours.

 If you want to print at a shorter interval, change the settings as follows:
• Reduce the number of printed items.
• Increase the chart speed within the printable range.

Note
Measurement, display, periodic printout, and trend recording (dot model) are not performed by 
setting unused channels to “Skip” (see section 5.1).

Appendix 2  Periodic Printout Interval
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Index

Symbols
–Over display..................................................................... 12-8
+Over display .................................................................... 12-8

Numerics
1-5V ..................................................................................... 1-2
1-5V input ............................................................................ 5-6
1-5V low-cut function ......................................................... 7-24

A
absolute time mode ........................................................... 9-21
absolute value ................................................................... 1-26
absolute values, setting using ........................................... 6-15
accuracy of clock ............................................................. 12-22
activating the key lock ....................................................... 3-19
adjusting the dot printing position ...................................... 11-8
adjusting the hysteresis ..................................................... 11-8
adjusting the pen position .................................................. 11-6
alarm............................................................................ 1-7, 5-9
alarm ACK ............................................................... 1-12, 3-18
alarm acknowledge operation.................................. 1-12, 3-18
alarm delay function .......................................................... 7-24
alarm hysteresis ................................................ 1-8, 1-28, 7-3
alarm indication ................................................................... 1-9
alarm information ............................................................... 7-11
alarm output relay .............................................................. 2-11
alarm output relays .............................................................. 1-9
alarm output terminals ....................................................... 2-10
alarm printout..................................................................... 1-18
alarms on the delta computation channel .......................... 5-10
alarm type ...................................................... 5-10, 9-12, 12-3
alarm value .............................................................. 5-11, 9-12
AND operation (alarm output relay) ................................... 1-11
AND/OR ............................................................................... 7-3
assigned function (remote control) .................................... 7-29
assigning channels to recording pens ............................... 9-24

B
bar graph ........................................................................... 1-24
base point of the bar graph...................................... 7-15, 9-27
basic setting mode............................................................... 4-1
batch action, setting of....................................................... 6-18
batch comments ................................................................ 6-17
batch name ........................................................................ 1-22
batch number........................................................... 1-22, 6-16
batch printout, turning ON/OFF of ..................................... 6-17
bias ............................................................................ 1-4, 6-13
bias function ...................................................................... 7-24
brightness (display) ........................................................... 6-12
brightness (internal light) ................................................... 6-12
buffer memory ......................................................... 1-18, 1-19
buffer overflow mark ................................................ 1-18, 1-19
burnout detection ......................................................... 1-4, 7-5

C
calibration .......................................................................... 11-4
calibration correction ........................................................... 1-4
calibration correction function ............................................ 7-24
calibration correction, performing of .................................. 6-14
calibration instrument ........................................................ 11-4
cassette holder .................................................................. 3-10

changing the settings........................................................... 4-3
channel auto switching ...................................................... 3-12
channel printout ................................................................. 1-17
channel range .......................................................... 5-10, 6-13
channel switching interval.................................................... 8-3
character type .............................................................. 4-4, 9-3
chart cassette ...................................................................... 3-4
chart end output................................................................. 1-29
chart holder.......................................................................... 3-5
chart paper ................................................................ 3-5, 12-4
chart speed .............................................................. 1-14, 5-13
cleaning ............................................................................. 11-2
clearing alarm information ................................................. 3-15
comment line ....................................................................... 4-3
common logarithm ............................................................. 1-26
communication input data.................................................... 9-4
compensation voltage.......................................................... 7-7
computation-dedicated channels ....................................... 1-26
computation errors............................................................. 9-29
computing equation ............................................................. 9-2
computing equations ........................................................... 9-4
constants ................................................................... 9-4, 9-10
construction ..................................................................... 12-18
conventions used in this manual ............................................xi
copying & pasting a character string ........................... 4-4, 9-3
correction values ................................................................. 1-4
current input......................................................................... 1-2
cursor........................................................................... 4-3, 4-4
customized menu .............................................................. 1-32

D
data display setup screen .................................................... 8-1
data types (computation) ........................................... 1-26, 9-4
date format ........................................................................ 7-30
date/time .................................................................. 2-14, 5-14
DC voltage ........................................................................... 5-2
de-energized.............................................................. 1-11, 7-3
default values (basic setting mode) ................................... 4-12
default values (setting mode) .............................................. 4-9
delay high limit alarm ........................................................... 1-8
delay low limit alarm ............................................................ 1-8
deleting a character ..................................................... 4-4, 9-3
deleting an entire character string ............................... 4-4, 9-3
delta computation ........................................................ 1-3, 5-4
diagnosis output .......................................................... 1-9, 7-2
difference high limit alarm .................................................... 1-7
difference low limit alarm ..................................................... 1-7
dimensional drawings ...................................................... 12-23
display ............................................................................... 1-24
display and key panel .......................................................... 3-2
displayed contents ............................................................. 12-7
display examples ............................................................... 1-25
display in which different screens can be assigned ............. 8-4
display/printout language................................................... 7-22
display type.............................................................. 1-24, 12-7
display update rate .............................................................. 8-2
dot printing interval .................................................... 1-14, 6-1
DST ................................................................................... 1-33
duration (alarm delay).............................................. 6-11, 9-19
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E
edge................................................................................... 1-31
effects of operating conditions ......................................... 12-22
EMC standards ....................................................................... iii
end printout.............................................................. 1-22, 6-16
end printout 2..................................................................... 6-16
energized ................................................................... 1-11, 7-3
English, setting the language ............................................ 7-22
entering basic setting mode................................................. 4-2
entering characters .............................................................. 4-4
entering setting mode .......................................................... 4-2
entering values .................................................................... 4-3
error messages.................................................................. 10-1
ESC key............................................................................... 4-3
exponent ............................................................................ 1-26
external reference compensation ........................................ 1-5

F
FAIL/chart end output relay ............................................... 2-11
FAIL output ........................................................................ 1-29
fastest recording interval ................................................... 1-28
feeding the chart paper........................................................ 3-6
felt pen ................................................................................. 3-7
filter .................................................................... 1-5, 6-3, 7-20
format of the date .............................................................. 1-19
four arithmetic operation ............................................ 1-26, 9-5
front cover tab of the chart cassette .................................. 3-11
FUNC key operation ............................................................ 4-5

H
half life of the brightness.................................................. 11-10
handling precautions ........................................................... 2-1
header printout .................................................................. 1-22
heat sink .............................................................................. 3-3
high limit alarm .................................................................... 1-7
high limit on rate-of-change alarm ....................................... 1-7
hold ............................................................................ 1-9, 1-12
hold operation ...................................................................... 7-3
hysteresis ............................................................................ 1-8

I
initializing the recorder settings ......................................... 7-27
input computation .............................................................. 12-2
input range........................................................................... 5-1
input type ........................................................................... 12-1
inserting a character ............................................................ 9-3
inserting characters ............................................................. 4-4
installation location .............................................................. 2-2
instantaneous mode ........................................................App-1
integration time of the A/D converter ........................... 1-6, 7-4
internal clock adjustment ................................................... 1-30
internal light LED assembly ............................................... 11-3
interval (periodic printout) ................................................App-6
interval (rate-of-change alarm) .................................... 1-7, 7-3
isolation ........................................................................... 12-19

K
key lock.................................................................... 3-19, 7-18
keys ..................................................................................... 3-2
keys to be key-locked ........................................................ 7-18

L
language ............................................................................ 7-22
level ................................................................................... 1-31
linear scaling........................................................................ 5-3

List ..................................................................................... 3-14
loading the chart paper ........................................................ 3-4
logical computation .................................................... 1-26, 9-6
lot number.......................................................................... 1-22
lot number, setting of ......................................................... 6-16
low-cut ......................................................................... 5-6, 5-8
low limit alarm ...................................................................... 1-7
low limit on rate-of-change alarm ........................................ 1-7

M
main display....................................................................... 1-24
manual printout ........................................................ 1-19, 3-13
measurable range................................................................ 1-2
measuring input terminal ..................................................... 2-5
memory backup ............................................................... 12-22
menu (basic setting mode) .................................................. 4-8
menu, customization of...................................................... 1-32
menu (data display setup) ................................................... 8-2
menu (setting mode)............................................................ 4-7
message .............................................................................. 6-9
message format ................................................................. 6-20
message printout ............................................................... 1-19
message printout including measured value ..................... 1-23
message printout, including measured values in............... 6-20
model ......................................................................................vi
mounting brackets ............................................................... 2-3
mounting hole ...................................................................... 3-1
moving average ......................................................... 1-5, 7-19

N
names of parts ..................................................................... 3-1
new chart speed printout ................................................... 1-19
non-hold..................................................................... 1-9, 1-12
non-hold operation............................................................... 7-3
normal operating conditions ............................................ 12-18
number of samples of moving average ............................... 6-4

O
offset compensation mark ...............................................App-1
ON/OFF input ...................................................................... 5-5
operation menus using the FUNC key................................. 4-5
operation mode.................................................................... 4-1
operations on the panel keys............................................... 4-2
optional accessories ............................................................. viii
optional functions............................................................. 12-13
optional terminal .................................................................. 2-8
order of precedence of computation .................................... 9-4
over value .......................................................................... 9-29
over values during periodic printout.................................App-5

P
packing materials....................................................................ix
panel .................................................................................... 2-3
panel cut dimensions ....................................................... 12-23
parallel connection............................................................... 2-5
partial expanded recording .................... 1-15, 6-6, 7-21, 9-16
password for releasing the key lock .................................. 7-18
password (key lock) ........................................................... 3-19
pen caps .............................................................................. 3-7
pen holder............................................................................ 3-7
pen offset compensating data, ejection of ......................... 1-22
pen offset compensation ........................................... 1-15, 7-9
periodic inspection ............................................................. 11-1
periodic printout ...................................1-18, 6-7, 9-17, App-1
periodic printout, disabling of ............................................. 7-14
periodic printout interval ........................................7-14, App-6

Index



Index-3

Index

IM 04P02B01-01E 

11

22

33

44

55

66

77

88

99

1010

1111

1212

AppApp

IndexIndex

plotter pen............................................................................ 3-8
POC ..................................................................................... 7-9
portable type ........................................................ 12-16, 12-24
power and other computations ............................................ 9-5
power (computation) .......................................................... 1-26
power failure ....................................................................App-5
power supply ................................................................... 12-18
power switch ...................................................................... 2-14
precautions (input signal wiring) .......................................... 2-4
precautions (optional terminal wiring) .................................. 2-8
precautions (power supply wiring) ..................................... 2-12
printing a message ............................................................ 3-16
printing the computed value .............................................. 9-22
printing the recorder settings ............................................. 3-14
printout contents ................................................................ 1-16
printouts ............................................................................. 12-5
printout using the TLOG timer .........................................App-4
protective ground terminal ................................................. 2-13

R
range type............................................................................ 1-2
rear panel ............................................................................ 3-3
recorder ............................................................................... 1-1
recorder’s version ....................................................................ii
recording............................................................................ 1-13
recording color ....................................... 1-14, 7-8, 7-11, 9-23
recording (computation channels) ..................................... 1-27
recording span ..................................................................... 1-2
recording start printout....................................................... 1-19
recording zone ........................................................... 6-5, 9-15
reference junction compensation......................................... 1-4
reference pen .................................................................... 1-15
reference time.................................................................... 7-14
reflash alarm .............................................................. 1-10, 7-3
registering display types to screens .................................... 8-3
relational computation ............................................... 1-26, 9-6
relative time mode ............................................................. 9-21
relay contact input ............................................................. 2-11
relay contact output ........................................................... 2-11
relay numbers .......................................................... 5-11, 9-12
releasing the alarm output ................................................. 3-18
releasing the key lock ........................................................ 3-19
remaining chart length ....................................................... 11-1
remote control.......................................................... 1-30, 7-28
remote control input ........................................................... 2-11
remote control input terminals ........................................... 2-10
remote signal ..................................................................... 1-31
replacement period for expendable parts ........................ 11-10
replacing felt pens ............................................................... 3-7
replacing the internal light LED.......................................... 11-3
replacing the plotter pen ...................................................... 3-8
report data ............................................................... 7-14, 9-26
report mode .....................................................................App-2
resetting the computed values............................................. 9-1
resetting the report data .................................................... 3-17
resetting the TLOG computed value .................................. 9-22
revise values, setting using ............................................... 6-15
revisions ...................................................................................i
ribbon cassette .................................................................. 3-10
ribbon feeding knob ........................................................... 3-10
ribbon is loose ................................................................... 3-10
RJC ...................................................................................... 7-7
RTD ..................................................................................... 5-2
run modes............................................................................ 4-1

S
safety precautions .................................................................. iii
safety standards ..................................................................... iii
safety symbols ........................................................................ iii
scale printout ...................................................................App-2
scaling ................................................................................. 1-3
scan interval ........................................................................ 1-2
SD memory card................................................................ 1-23
secondary chart speed ...................................................... 6-10
Setting complete screen ...................................................... 4-3
setting mode ........................................................................ 4-1
settings necessary to use various functions ...................... 1-34
Setup ................................................................................. 3-14
setup guide ........................................................................ 1-34
setup items (basic setting mode) ....................................... 4-12
setup Items (setting mode) .................................................. 4-9
shunt resistor ....................................................................... 1-2
skip ...................................................................................... 5-8
sprocket teeth ...................................................................... 3-5
square root ........................................................................ 1-26
square root computation .............................................. 1-3, 5-7
square root low-cut function .............................................. 7-24
standard accessories.............................................................vii
standard performance ..................................................... 12-20
standard temperature device ............................................. 11-5
starting the computation ...................................................... 9-1
start printout............................................................. 1-22, 6-16
start printout 2.................................................................... 6-16
start recording.................................................................... 3-11
status display ..................................................................... 1-24
status of the remote control input terminal .......................... 9-5
stopper................................................................................. 3-6
stoppers ............................................................................... 3-4
stopping the computation .................................................... 9-1
stop recording .................................................................... 3-11
suffix code ..............................................................................vi
SUM scale ..................................................... 7-14, 9-14, 9-26
supported standards ........................................................ 12-19
switching the display screen .............................................. 3-12

T
tag.................................................................... 6-8, 7-11, 9-18
TC ........................................................................................ 5-2
temperature unit ................................................................ 7-42
thermocouple ....................................................................... 5-2
thermocouple input .............................................................. 2-5
time constant ....................................................................... 6-3
time printout format.................................................. 1-18, 7-26
timer ................................................................................... 9-21
time tick .................................................................1-16, App-1
time tick cancel mark .............................................1-16, App-1
TLOG computation .................................................... 1-26, 9-8
transistor input ................................................................... 2-11
trend recording ...................................... 1-14, 6-7, 9-17, 12-4
trend recording interval .............................................. 1-14, 6-1
trigger ................................................................................ 1-31
troubleshooting .................................................................. 10-4
type of measured values ................................................... 7-14
type of report data ............................................................. 9-26
types of computations........................................................ 1-26
types of inputs ..................................................................... 1-2

Index



Index-4 IM 04P02B01-01E 

U
unit ............................................................................. 5-12, 9-9
unit in computations........................................................... 1-27

V
versions and functions .............................................................ii
VFD ................................................................................... 1-24
Volt....................................................................................... 5-2

W
wiring (measuring input ) ..................................................... 2-7
wiring (optional terminal) ..................................................... 2-8
wiring (power supply)......................................................... 2-12

Z
zone recording ................................................................... 1-14

Index


	Introduction
	Recorder’s Version and Functions Described in This Manual
	Safety Precautions
	Checking the Contents of the Package
	How to Use This Manual

	Contents
	Chapter 1	Functional Explanation and Setup Guide
	1.1	Overview of the Recorder
	1.2	Measuring Input Section
	1.3	Alarms
	1.4	Recording
	1.5	Display
	1.6	Computation Function (/M1 Option)
	1.7	FAIL/Chart End Detection and Output Function (/F1 Option)
	1.8	Remote Control Function (/R1 Option)
	1.9	Other Functions
	1.10	Function Setup Guide

	Chapter 2	Before Using the Recorder
	2.1	Handling Precautions
	2.2	Installation
	2.3	Input Signal Wiring
	2.4	Optional Terminal Wiring
	2.5	Power Supply Wiring
	2.6	Turning ON/OFF the Power Switch

	Chapter 3	Names of Parts and Run Operations
	3.1	Names of Parts
	3.2	Installing or Replacing the Chart Paper
	3.3	Installing/Replacing Felt Pens or Plotter Pen (Pen Model)
	3.4	Installing/Replacing the Ribbon Cassette (Dot Model)
	3.5	Starting/Stopping the Recording
	3.6	Switching the Display Screen
	3.7	Printing Measured Values (Manual Printout)
	3.8	Printing the Recorder Settings
	3.9	Clearing the Alarm Printout Buffer
	3.10	Printing Messages
	3.11	Resetting the Report Data of the Periodic Printout
	3.12	Releasing the Alarm Output (Alarm ACK Operation)
	3.13	Activating/Releasing the Key Lock

	Chapter 4	Common Operations for Setting Functions and Setup Menu
	4.1	Run Modes
	4.2	Key Operations
	4.3	Menu Structure, Settings, and List of Default Values

	Chapter 5	Frequently Used Setup Operations (Setting Mode)
	5.1	Setting the Input Range
	5.2	Setting the Alarm
	5.3	Setting the Unit on Scaled Channels
	5.4	Changing the Chart Speed
	5.5	Setting the Date/Time

	Chapter 6	Setup Operations for Convenient Functions (Setting Mode)
	6.1	Setting the Trend Recording Interval (Dot Model)
	6.2	Setting the Filter (Pen Model)
	6.3	Setting the Moving Average (Dot Model)
	6.4	Setting Recording Zones for Each Channel (Zone Recording)
	6.5	Setting the Partial Expanded Recording
	6.6	Turning Trend Recording (Dot Model) and Periodic Printout ON/OFF for Each Channel
	6.7	Setting Tags on Channels
	6.8	Setting the Message String
	6.9	Setting the Secondary Chart Speed (Remote Control Function, /R1)
	6.10	Setting the Alarm Delay Duration
	6.11	Setting the Brightness of the Display and Internal Light
	6.12	Applying a Bias on the Measuring Input Signal
	6.13	Performing Calibration Correction (/CC1 Option)
	6.14	Setting Up Start Printout and End printout (/BT1 Option)
	6.15	Setting the Message Format (/BT1 Option)
	6.16	Setting the Date/Time When Switching between Standard Time and DST

	Chapter 7	Setup Operations for Changing/Adding Functions (Basic Setting Mode)
	7.1	Changing the Auxiliary Alarm Function
	7.2	Changing the Integration Time of the A/D Converter
	7.3	Setting the Burnout Detection Function of Thermocouples
	7.4	Setting the RJC Function on Channels Set to TC Input
	7.5	Changing the Channel Recording Color (Dot Model)
	7.6	Recording by Compensating for the Pen Offset along the Time Axis (Pen Model)
	7.7	Turning Printouts ON/OFF
		(Selecting the Channel/Tag Printout and Turning ON/OFF the Channel No., Alarm, Recording Start, New Chart Speed, Scale, and Pen Color Printouts)
	7.8	Setting the Periodic Printout Interval and the Type of Data to Be Printed
	7.9	Setting the Bar Graph Display Mode
	7.10	Setting the Key Lock Function
	7.11	Enabling the Moving Average Function (Dot Model)
	7.12	Enabling the Filter Function (Pen Model)
	7.13	Enabling the Partial Expanded Recording Function
	7.14	Changing the Display/Printout Language
	7.15	Enabling the Bias, Low-Cut, Alarm Delay, Calibration Correction (/CC1 Option) Functions
	7.16	Changing the Time Printout Format
	7.17	Initializing the Settings
	7.18	Assigning Functions to the Remote Control Input Terminals (/R1 Option)
	7.19	Changing the Printout/Display Format of the Date
	7.20	Selecting to Show/Hide the FUNC Key Menus
	7.21	Selecting to Show/Hide Setting Mode Menus
	7.22	Enabling/Disabling the Customized Menu
	7.23	Setting the Calibration Correction Function (/CC1 Option)
	7.24	Enabling Start Printout, End printout, and Message Format (/BT1 Option)
	7.25	Changing the Temperature Unit

	Chapter 8	Setup Operations for Changing the Displayed Contents
	8.1	Key Operations for Changing the Displayed Information
	8.2	Changing the Displayed Information

	Chapter 9	Operations Related to the Computation Function (/M1 Option)
	9.1	Starting/Stopping/Resetting the Computation
	9.2	Setting the Computing Equation
	9.3	Setting the Unit
	9.4	Setting the Constants Used in Equations
	9.5	Setting the Alarm
	9.6	Specifying the Timer Used in Statistical Calculations (TLOG)
	9.7	Setting Recording Zones for Each Channel (Zone Recording)
	9.8	Setting the Partial Expanded Recording
	9.9	Turning Trend Recording (Dot Model) and Periodic Printout (Including the Printout Using the TLOG Timer) ON/OFF for Each Channel
	9.10	Setting Tags on Channels
	9.11	Setting the Alarm Delay Duration
	9.12	Setting the Timer Used in TLOG Computation and Periodic Printout
	9.13	Changing the Channel Recording Color (Dot Model)
	9.14	Changing the Channel Assignments of Recording Pens (Pen Model)
	9.15	Changing the Type of Report Data Printed in Periodic Printout
	9.16	Setting the Bar Graph Display Mode
	9.17	Setting the Procedure Taken When the Computed Result Is in Error

	Chapter 10	Troubleshooting
	10.1	A List of Error Messages
	10.2	Troubleshooting Flow Charts

	Chapter 11	Maintenance
	11.1	Periodic Inspection
	11.2	Cleaning the Recorder
	11.3	Replacing the Internal Light LED
	11.4	Calibrating the Recorder
	11.5	Adjusting the Pen Position (Pen Model)
	11.6	Adjusting the Dot Printing Position (Dot Model)
	11.7	Recommended Replacement Periods for Worn Parts

	Chapter 12	Specifications
	12.1	Input Specifications
	12.2	Alarm Function Specifications
	12.3	Recording Function Specifications
	12.4	Display Function Specifications
	12.5	Specifications of Optional Functions
	12.6	General Specifications
	12.7	Dimensional Drawings

	Appendix
	Appendix 1	Periodic Printout and Printout Using the TLOG Timer (/M1 Option)
	Appendix 2	Periodic Printout Interval
	Index




